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1

General information

For more detailed information on the RheoWin 4.95.0003 installation, the supported devices, the 
supported Windows versions, the computer system requirements, etc, see the www.rheowin.com 
web-site and the following documents,

• HAAKE RheoWin User guide “Installation and 21 CFR part 11 configuration” (part no. 
006-0783),

• HAAKE RheoWin User guide “Camera installation”,

which can be downloaded from the RheoWin web-site.

Supported devices (Rheometers, Viscometers)
RheoWin 4.95.0003 currently supports the following HAAKE rheometers and viscometers: 
MARS 60, MARS 40, MARS iQ, MARS iQ Air, MARS III, MARS II, MARS I, RheoStress 6000, 
RheoStress 3000, RheoStress 600, RheoStress 300, Viscotester iQ, Viscotester iQ Air, Viscotester 550, 
Viscotester D, Viscotester E, RheoStress 1 and Rotovisco 1.

RheoWin 4.95.0003 does not support older instruments like the RheoStress 150, RheoStress 80, 
RheoStress 75, RheoScope 1, RT20, RS100, RS50, RT10, VT500, VT501,  VT6L, VT6R, VT7L, 
VT7R, VT7L-plus, VT7R-plus and the RV20+RC20/RV30 with CV20, CV100, M5 or M10. 

RheoWin 4.95.0003 does not support the following older temperature control units: TC80, TC81, 
TC500 and TC501.

Supported Windows operating systems
RheoWin 4.95.0003 has been tested to run under the following Windows operating systems:

• Windows 10 32-bit and 64-bit
• Windows 11 64 bit (a 32-bit of Windows 11 does not exist)

RheoWin 4.95.0003 will not run and/or is not supported under Windows 3.x, Windows NT3.x, 
Windows 95, Windows 98, Windows 98 SE, Windows ME, Windows NT 4.0, Windows 2000 and 
Windows XP, Windows Vista, Windows 7, Windows 8(.1).

www.rheowin.com
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Computer hardware requirements
For detailed information see the document HAAKE RheoWin User guide “Installation and 21 CFR 
part 11 configuration”.

The RheoWin installation program
The RheoWin installation program is available from two different sources:

• The RheoWin installation program can be downloaded from the www.rheowin.com web-site.
After downloading the file rhw4950003_complete.zip copy it to a (temporary) directory on the 
hard drive of the computer on which RheoWin should be installed, then extract the setup.exe 
file and some additional files from the ZIP file using any suitable unzip program.

• The RheoWin installation program can be found in the Rheowin directory on the optionally 
available the RheoWin USB flash drive.

Installation of RheoWin 4.95.0003
RheoWin 4.95.0003 can be installed parallel to an existing RheoWin 3.xx and/or RheoWin 2.xx 
installation if needed. Please note that RheoWin 4 can read RheoWin 2.xx and 3.xx data, job and page 
files (backward compatibility), but that RheoWin 2.xx can not read RheoWin 3.xx and 4.xx files, also 
RheoWin 3.xx and can not read RheoWin 4.xx files

RheoWin 4.95.0003 can be installed, as an Upgrade installation, over an existing installation of 
RheoWin version 4.20.00xx or newer, that is without deinstalling the older version first. In this case 
(most of ) the settings from the previous installation are automatically used for the new version.

 To install HAAKE RheoWin

1. Read the first chapter (this chapter) of this document before starting the installation program.

2. Read the last paragraph of the next chapter of this document, that is the What’s new information 
on RheoWin version 4.95.0003, before starting the installation program.

3. Make sure that Windows Administrator privileges are available on the PC on which RheoWin is to 
be installed.

Note  The RheoWin installation program contains a fully executable version of the Thermo Fisher 
Scientific HAAKE RheoWin software. In order to be able to install RheoWin on your computer 
you need a RheoWin 4 License Key.

IMPORTANT  RheoWin 2.xx, 3.xx and 4.xx must always be installed in different directories.

IMPORTANT  For older RheoWin versions (version 4.10.00xx and older) the Upgrade installation 
method can not be used, that means that the New installation method (see 3b below) must be used, 
in this case the settings of the previous installation will not be available in the new installation.

IMPORTANT  Windows Administrator privileges are mandatory in order to be able to install 
the RheoWin software.

www.rheowin.com
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4. In case of a New installation only, that is not when performing an Upgrade installation:
Deinstall (remove) any previous RheoWin 4 version first (if applicable). Click the Windows Start 
button, then select Settings, then select Control Panel, in the Control Panel select Add or Remove 
Programs, in the list of programs select HAAKE RheoWin and then click on the Change/Remove 
button and follow the instructions.

5. Start the setup.exe installation program from

a. the directory on the harddisk of the PC in which the downloaded rhw4950003_complete.zip 
was extracted

or

b. the Rheowin directory on the optionally available RheoWin USB flash drive.

6. The RheoWin installation program will guide you through the installation. Please make sure that 
you have a RheoWin 4 License Key (see below) readily available since the installation program will 
ask for this.

RheoWin and Windows Users 
Windows users with the default Administrator (or PowerUser) privileges will be able to run RheoWin 
without the need for any modifications to Windows settings.

For Windows users with the default Users privileges an Administrator has to make sure that those users 
have read access to the RheoWin 4 main directory (by default c:\Program Files\Thermo\RheoWin) and 
all its subdirectories, as well as read and write (!) access to the following key in the windows registry:

HKEY_USERS\.DEFAULT\Software\Thermo\RheoWin 

and the following two directories and all their subdirectories:

C:\Documents and Settings\All Users\Application Data\Thermo\RheoWin

C:\Documents and Settings\All Users\Documents\Thermo\RheoWin.

The names of these directories may be dependent of the actual Windows versions (10 and 11) and the 
language of the Windows operating system. For more detailed information on this see the HAAKE 
RheoWin User guide “Installation and 21 CFR part 11 configuration” (part no. 006-0783).

Note  In this case the settings from a previous installation will be lost (deleted) and are not 
available for a subsequent new installation.

Note  Under normal circumstances the RheoWin installation program will automatically set these 
privileges.

Note  Microsoft advices programmers to save application and user data in the above mentioned 
directories by default, but strange enough does not give Windows users with the default Users 
privileges write access to these directories.
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RheoWin 4 Licence Key
In order to be able to install this version of RheoWin on your computer you will need a RheoWin 4 
License Key. A Key-Diskette from a previous version of RheoWin (version 2.x) or a RheoWin 3 
License Key will not enable you to install RheoWin 4.

The keys for RheoWin 4 consist of a company name, serial number and the key code. When you 
receive the key per e-mail this information will be stored in a *.txt file which can be opened and viewed 
by using any text-editor (Notepad, Write, Word, etc.)

The key information must either be entered manually (as in previous versions) or loaded from the 
supplied *.txt file (this is new starting from version 4.40) during the installation process.

In order to be able to install the tools for FDA 21 CFR part 11 compliance, a separate License Key is 
needed. Separate keys are also needed to install the TTS (Time Temperature Superposition) tool, the 
Spectra calculation tool, the MWD (Molecular Weight Distribution) tool as well as some other 
optional software features.

License Keys for RheoWin 4 are available on request only ! 

Contact Thermo Fisher Scientific
If you have any questions and or suggestions regarding HAAKE RheoWin please send an e-mail to:

support.mc.de@thermofisher.com



Thermo Scientific HAAKE RheoWin 4.95.0003 Readme 5

2

What’s new

This chapter describes what is new in which RheoWin version.

Version 4.0x.00xx

Version 4.00.0000
(Released 15.07.2008)

Below is a list of things that are new and/or changed in version 4.00.0000 compared with version 
3.61.0004 of RheoWin.

Installation

New Keys
• In order to be able to install this version of RheoWin on your computer you will need a new 

RheoWin 4 License Key. A Key-Diskette for RheoWin 2.xx or a RheoWin 3 License Key will not 
enable you to install RheoWin 4.

General
• RheoWin 4.x can be installed and used parallel to RheoWin 3.x on one computer but not at the 

same time!
• In order to comply with the far more stringent requirements of Windows Vista (relativ to 

Windows XP) regarding the storage of data and the use of certain parts of the Windows registry, 
RheoWin 4.x uses different paths for the program files and for data, job, template, page, report, 
etc. files than RheoWin 3. It also uses a different registry key.
The program file path, the program data file path, the user data file path and the registry path of 
RheoWin 4 comply with the Microsoft recommendations for Windows XP and Windows Vista.

Path for program *.exe, *.dll, etc. files
• The RheoWin program is now installed in the following directory and the subdirectories of that 

directory:
C:\Program Files\Thermo\RheoWin

Path for program data files
• The RheoWin program data files are now installed in the Windows XP (language dependend)

C:\Documents and Settings\All Users\Application Data\Thermo\RheoWin

C:\Dokumente und Einstellungen\All Users\Anwendungsdaten\Thermo\RheoWin

Windows VISTA and Windows 7
C:\ProgramData\Thermo\RheoWin

directory and the subdirectories of that directory. 
Program data files are files that are automatically created and modifies by the program without 
direct user interaction. Under normal circumstances a user does not need to access to these files. 
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Below is a list with which files are stored where.
In the main RheoWin directory:

Rheowin.log (the main RheoWin log file, used for debugging only)
In the RheoWin\Elmdll directory:

elmdll.ini (ini file for the RheoWin elements, used for special options only)
In the RheoWin\Drivers directory:

drivers.flp (file in which all DeviceManager settings are stored)
drivers.ini (ini file for the Rheometer drives, used for special options only)
*. log (communication log files, used for debugging only)
*.err (communication error files, used for debugging only)
*.msc (exported MSC table)
*.mtc (exported MTC table)

In the RheoWin\Autosave directory:
autosave.rwd (autosave copy of the last job data file)
Drivers_Autosave_x.xx.xx.flp (autosave copy of the last drivers.flp file)
Drivers_Setup_x.xx.xx.flp (autosave copy of the installation drivers.flp file)

In the RheoWin\UMS directory:
UMS.mdb (the UserManagement settings database file)

Path for user data files
• The RheoWin user data files are now installed in the Windows XP  (language dependend)

C:\Documents and Settings\All Users\Shared Documents\Thermo\RheoWin

C:\Dokumente und Einstellungen\All Users\Gemeinsame 

Dokumente\Thermo\RheoWin

Windows VISTA and Windows 7  (language dependend)
C:\Users\Public\Public Documents\Thermo\RheoWin

C:\Benutzer\Öffentlich\Öffentliche Dokumente\Thermo\RheoWin

directory and the subdirectories of that directory. 
User data files are files that are directly created and modified by the user. 
Below is a list with which files are stored where.
In the RheoWin\Data directory:

*.rwd (data files)
In the RheoWin\Job directory:

*.rwj (job files)
In the RheoWin\Page directory:

*.rwp (page files)
In the RheoWin\Report directory:

*.lst (report template files)
In the RheoWin\Template directory:

*.gds (graph template files)
*.tds (table template files)
*.rwt (job template files)
*.rwl (page layout template files)

Registry path
• In the Windows registry RheoWin now uses the following main key entry:

HKEY_USERS\.DEFAULT\Software\Thermo\RheoWin

Note  In order to be able the see the directory mentioned above in the Windows Explorer, the 
option Show hidden files and folder on the View page of the Folder Options dialog in Window 
Explorer must be active. To open this dialog click on Tools in the Windows Explorers main 
menu and then select the Folder Options command.
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Font installation
• The font installation has been modified. The message box anouncing the font instalation at the 

end of the installation has been removed.

Supported rheometers
• Drivers for the RheoStress RS100, 1 Ncm version and 5 Ncm version, as well as the RS50 are not 

part of the installation anymore. For these instruments RheoWin 3.61 or earlier should be used.

UserManager

User priviliges
• There are new per User(group) definable privileges for the Elements/Job/Template explorer (in 

JobManager) and the Data/Page/Template explorer (in DataManager) for:
Opening files
Moving files and directories and renaming directories
Deleting files and directories
Changing the root directory of an explorer tree

Rheometer and auxillary drivers

Drivers for MARS
• There is no lower limit for the accepted value for the set rotational speed anymore. The lowest rpm 

values achieved with the new CR-control loop and certain samples are in the range of 10-7 rpm to 
10-9 rpm.

Drivers for MARS and Simulator --> Acquiring images
• RheoWin can now acquire and save color images from a suitable camera.

• RheoWin is now compatible with the Foculus 323TB camera from the company NET GmbH. 
This camera is now shipped with the RheoScope module. With this camera exposure times down 
to 1µs are possible. When using an image size of 512x384 pixels or smaller, a frame rate of up to 58 
fps is possible without losing on image quality.

• The method used to save data and images in files was modified. Previously the maximum file size 
was 4 GB, now the maximum file size 4.295e+09 GB (theoretically...).

Driver for pressure sensor
• The driver now not only the supports the older GMH 3110 but also the new GMH 3111pressure 

sensor from Greisinger.

DeviceManager  

Temperature offset tables

• Temperature offset tables can now be exported and imported. The tables can not be read from the 
instruments yet.

Editor for Drivers.ini
• By clicking with the right mouse key on one of the three icons on the left side of the 

DeviceManager dialog the user can launch an editor for modifying the Drivers.ini file. 

Note  We have tested this with certain USB-Webcams only. Currently we can not guarantee 
that this will work with other cameras.

CAUTION  Do not change any setting in the drivers.ini file unless you know what you are 
doing.
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General

New XML data format
• RheoWin can now save and load data in an XML file format defined by an IUPAC working group. 

For more information see the following web-page:
http://www.nothere.ukshells.co.uk/Iupac/wp%20project%20c.php?id=1

Configuration (JobManager and DataManager)

Preferences dialog
• In the Device Toolbar / JobExplorer box of the General page of the Preference dialog the user can 

select whether the new Elements / JobExplorer toolbar (see below) is automatically closed when a 
Job is started in order to give the JobController window more space on the screen.

Quantities/Units
• There is a new quantity -Fn (i.e. the negative value of the normal force) which is useful for certain 

tack and texture analysis applications.
• This quantity is calculated and saved by the Axial Ramp element only.
• There are two new quantities friction force Ff = M / R (with M ist torque, R is radius) and friction 

coefficient µf = Ff / Fn for use with tribology measuring cell.
• These quantities are calculated and saved by all the rotation elements, i.e. not by the oscillation 

and axial elements.
• The units cm/s, mm/s and mm/s have been added for the quantity velocity. This quantity is used 

in the editor of the Axial Ramp Element.
• The unit of the inverse temperature quantity 1/T should be 1/K but was K in previous versions. 

This has been corrected.

JobManager

Main menu: Editor for Element.ini
• From the Help menu the user can launch an editor for modifying the Element.ini file by selecting 

the Edit: Element.ini command.

Main menu: Logfile Viewer
• From the Help menu the user can launch a viewer for the different log files that RheoWin creates 

on demand:
Rheowin.log : The general RheoWin log-file.
Rheometer communication log-files: e.g. Mars.log, RS600.log, ...
The diagnosis-file *.dia saved by the DeviceManager.
RhwException.log, VISAPI.log, DCAPI.log special log-files for debugging.

Standard toolbar
• The icon for the Device Manager has been changed.

Device toolbar
• The Device toolbar now has a button to reset the normal force signal to zero.
• The units for the gap, temperature and normal force display/edit fields are now positioned 

similary.

New combined Elements / JobExplorer toolbar
• The separate dialogs for selecting Elements and selecting Jobs have been replaced by a completely 

new toolbar inside the main JobManager window with three pages; Elements, Job and Templates.
• The Elements page contains the elements for creating a Job by Drag&Drop, just like the Elements 

dialog in RheoWin 3.

Note  For normal operation of RheoWin none of the above files are needed.
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• Both the Jobs page and the Template page contain an explorer tree structure which only displays 
Job files (*.rwj) resp. Job template files (*.rwt) and sub-directories very much like the Windows 
Explorer.

• The files and subdirectories displayed in the tree structures are identical to those displayed in the 
Windows Explorer.

• The default root directory of the explorer tree is displayed in the edit field above the explorer tree 
and can be changed temporarily by clicking on the Select directory button behind the edit field. 
This functionality can disabled by removing the corresponding privilege in UserManager.

• Files can moved between subdirectories by Drag&Drop. 
This functionality can disabled by removing the corresponding privilege in UserManager.

• Files can be deleted by choosing Delete from the right-mouse-key popup-menu or by clicking the 
Delete button at the bottom of the Job page in the toolbar. 
This functionality can disabled by removing the corresponding privilege in UserManager.

• New folders (subdirectories) can be created by choosing New folder from the right-mouse-key 
popup-menu or by clicking the New folder button at the bottom of the Job page in the toolbar.
This functionality can disabled by removing the corresponding privilege in UserManager

New Goto-Element
• With the new Goto-Element loops can be "programmed" in a Job sequence. This is useful when 

creating Job in which a certain element sequence appears multiple times. In the Goto-Element, the 
element to jump to can be selected from a drop-down list. The elements are identified by a unique 
ID number (i.e. not by the position number in the Job). The number of repetitions can be set.

File Load-Element and Reference-Element
• Data in IUPAC XML file format can be imported using the normal File Open dialog and selecting 

a XML file (which must be in IUPAC format in order to be loaded).

Message-Element
• With the new Repeat sound option on the Sound page of the element editor the user can set the 

sound playback to be repeated until the Ok button of the screen message text window is clicked.

Set-Element
• The CR-Mode page in the element editor has been renamed to CR/CD-Mode since the adaptable 

control loop parameters now also apply to the CD control loop. 
• The CR/CD-Mode page for configuring the CR and CD adaptable control loop is now also 

available for the RheoStress 600 and the RheoStress 6000.

Note  Subdirectories not containing files of the corresponding type(s) are not shown in the tree 
structure.

Note  The default root directory can only be changed permanently on the Directory page of the 
Preferences dialog in the Configuration menu.

Note  Currently the evaluation elements can not handle data from measuring elements that are 
called more then once.

Note  For the sound to be repeated the option Display message during Job sequence must 
active also, otherwise there wouldn't be an Ok button to stop the sound playback.
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Temperature-Set-Element
• The temperature page of the element editor has been modified and enhanced. The user can now 

select that the complete job will be discontinued when the set temperature is not attained within a 
set tolerance after a set duration.

New for (almost) all Measurement Elements
• On the Break criteria page of the Rotation page of the element editor the user can now select Goto 

in the Action drop-down list. Once the Goto command is selected a Goto button is displayed 
under the Action field. By clicking on the Goto button a dialog is displayed from which the user 
can select an element of the Job to jump to when the break criteria is fulfilled.

All Oscillation Elements (not Multiwave Elements)
• The waiting time can now also be defined in seconds. The time in seconds can be shorter than the 

duration of one period. 
• In the Frequency Sweep element the waiting time in seconds can also be set as a maximum time 

when the waiting time is set as a number of periods, for example "Wait for 5 periods but not longer 
than 10 s".

• The oscillation elements have been optimized to achieve a more exact timing of the datapoints.
• The time passed while waiting for the set waiting time to be finished (at the start of the element) is 

now included in the segment time. 
• Previously this time was erroneously added to the time between two segments.
• The time value for a data point is now the time at the end of the last oscillation period that is used 

for one data point. Previously this was the time in the middle of all oscillation periods used for one 
data point.

• The format of the oscillation raw data files (*.rwr) has been modified. A *.rwr files now also 
contains all information neede to calculate the rheological values like G', G" etc. This new format 
is used by the modified *.RWR Viewer program (see below).

Osc Time Curve, Osc Frequency Sweep and Osc Amplitude Sweep Elements
• Take from previous can now be used for taking the last set or measured stress or strain value from 

the previous element as the set value for the current element.

Osc Amplitude Sweep Element
• On the Acquisition page of the Oscillation page of the element editor a fixed duration per step can 

now be set as an alternative to setting the number of repetitions. During the measurement as many 
repetitions as will fit in the duration will be measured.

Axial Ramp Element
• The default setting on the Rotation page of the element editor is now CS-Mode, the default 

stress/torque is 0.0.

Note  The adaptable CD and CR control loops are available in the following rheometer 
firmware versions (and in newer versions):
RS600   :  RS600-02_17_103-Dsp-10_06_000.h86
RS6000 :  RS6000-02_17_103-Dsp-10_06_000.h86
MARS   :  UPD_MARS_CBOX_12_04_005_Dsp_10_06_307.h86

Note  In this version this functionality is still missing from the Temperature Set Element.

Note  This functionality will not be available in the MultiStep and Creep-Recovery elements.

Note  The set frequency, i.e. the duration of one oscillation period, and the duration per step 
must be given compatible values.
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• The new quantity -Fn (i.e. the negative value of the normal force) which is useful for certain tack 
and texture analysis applications is now calculated and saved.

DataManager

Main menu: Editor for Element.ini
• From the Help menu the user can launch an editor for modifying the Element.ini file by selecting 

the Edit: ELEMENT.INI command.

Main menu: Logfile Viewer
• From the Help menu the user can launch a viewer for the different log files that RheoWin creates.

Standard toolbar
• In the standard toolbar there are two new (light green) icons Open last measurement and Add last 

measurement for quickly opening the data file (*.rwd) of the last measurement in a new page resp. 
adding the data file of the last measurement to the currently active page.

New  XML file import/export
• Data can be exported in the IUPAC XML file format with the new Save as (XML-IUPAC) 

command in the File menu.
• Data in IUPAC XML file format can be imported using the normal Open command in the File 

menu and selecting a XML file (which must be in IUPAC format in order to be loaded).

New  Data/Page/Template toolbar
• Inside the main DataManager window there is a completely new toolbar with three pages: Data, 

Pages and Templates.
• Each of the three pages contains an explorer tree structure which displays Data files (*.rwd), Page 

files (*.rwp) and Template files (*.gds, *.tds and *.rwl) respectively as well sub-directories and files 
in subdirectories, very much like the Windows Explorer. 

• The files and subdirectories displayed in the tree structures are identical to those displayed in the 
Windows Explorer.

• From the Data explorer tree a Data file can be opened in a new page inside DataManager by 
double clicking on the file or by selecting Open from the right-mouse-key popup-menu or by 
clicking on the Open button at the bottom of the page or by dragging&dropping it on empty 
space inside the DataManager or by dragging&dropping it on the title bar of the DataManager or 
highlighting the file and pressing the Enter key on the keyboard.

• From the Data explorer tree a Data file can be opened in an already existing (open) page inside 
DataManager by selecting Add from the right-mouse-key popup-menu or by dragging&dropping 
it on the title bar of an existing page.

• From the Page explorer tree a Page file can be opened inside DataManager by double clicking on 
the file or by selecting Open from the right-mouse-key popup-menu or by clicking on the Open 
button at the bottom of the page or or by dragging&dropping it on empty space inside the 
DataManager or by dragging&dropping it on the title bar of the DataManager.

• A Page file can not be added to another page.
• The Template explorer tree basically consist of three independend trees: One for graph templates, 

one for table templates and one for page templates.
• From the Template explorer tree a Template can be applied to an existing (open) page inside 

DataManager by double clicking on the file or by selecting Open from the right-mouse-key 
popup-menu.

• A graph template will be applied to the graph only, a table template to the table only and a page 
template will be applied to complete page of the currently active page inside DataManager.

Note  Subdirectories not containing files of the corresponding type(s) are not shown in the tree 
structure.
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• The default root directory of an explorer tree is displayed in the edit field above the explorer tree 
and can be changed temporarily by clicking on the Select directory button behind the edit field. 
This functionality can disabled by removing the corresponding privilege in UserManager.

• Files can moved between subdirectories by Drag&Drop.
This functionality can disabled by removing the corresponding privilege in UserManager.

• Files can be deleted by choosing Delete from the right-mouse-key popup-menu or by clicking the 
Delete button at the bottom of the Job page in the toolbar. 
This functionality can disabled by removing the corresponding privilege in UserManager.

• New folders (subdirectories) can be created by choosing New folder from the right-mouse-key 
popup-menu or by clicking the New folder button at the bottom of the Job page in the toolbar.
This functionality can disabled by removing the corresponding privilege in UserManager

Graph / Table display

Table display
• All data values are now displayed in a normal font and not in a bold font anymore.

*.RWR Viewer program
• The functionality of the *.rwr Viewer program has been significantly extended. 
• The program now also displays the rheological quantities of the sample as numbers.
• In the rheological data graph the program now shows G' and G" as function of frequency, time, 

stress, strain or temperature depending on the type of the first segment in the data file.
By clicking on a data point in the rheological data graph the program will show the corresponding 
raw data information in the other graphs and numerical fields.

• "Walking" through the data points can be done by clicking on the buttons below the numerical 
value display or by using the keyboard (left/right arrow key, home/end key, page up/down key).

• By clicking on the right Y-axis (with the time on the X-axis) the user can select from a popup menu 
which quantity to display on the right Y-axis.

• The program now shows the relative value of the 3rd and 5th harmonic of both the stress and 
strain signal for each data point.

• After clicking on any of the four graphs with the right mouse button a menu will popup which 
enables the user to print (on the default printer only), copy (to the clipboard) or save (in an *.emf 
file) the graph.

• The program now shows the AngleRatio which is the ratio of the angle amplitude in the sample 
and the angle amplitude of the rheometer. This value is a measure for the amount of compliance 
correction applied. A value close to zero means that the compliance correction is zero or very small. 
The smaller the value is the more compliance correction is applied.

• The program now shows the TorqueRatio wich is the ratio of the torque "lost" because of 
instrument inertia and the effective torque applied to the sample.

Version 4.00.0001

Below is a list of things that are new and/or changed in version 4.00.0001 compared with version 
4.00.0000 of RheoWin.

Note  The default root directory can only be changed permanently on the Directory page of the 
Preferences dialog in the Configuration menu.



 2 What’s new
Version 4.0x.00xx

Thermo Scientific HAAKE RheoWin 4.95.0003 Readme 13

Installation

Language selection
• The language selected at the beginning of the installation was not transfered to the language 

settings of RheoWin. This has been solved.

Rheometer drivers

Drivers for RS1, RO1, RS600 and RS6000
• On certain PCs on which RheoWin 3.xx worked without problems, RheoWin 4.00.0000 

produces "character overrun" and "framing error" communication errors. This has been solved.
• Under certain circumstances (in combination with internal Jobs only) there was a problem reading 

sensor factors from the instrument. This has been solved.

JobManager

Osc Frequency Element
• Under certain circumstances an "Illegal value" error message would popup when closing the 

Element-Editor. This has been solved.

ROT Step Element
• This element crashed when the T set icon in the JobEditor was used to change the temperature. 

This has been solved.

ROT MultiStep Element, ROT CreepRecovery Element
• The T set icon functionality in the JobEditor did not work for these elements. This has been 

solved.

Area Calculation Element
• The area calculation did not work when the manual set data range was larger then the actual range. 

This has been solved.

Version 4.00.0002

Below is a list of things that are new and/or changed in version 4.00.0002 compared with version 
4.00.0001 of RheoWin.

JobManager

Set-Element
• The CR/CD-Mode page for configuring the CR and CD adaptable control loop is now only 

available after installing RheoWin with a separate installation key. This means that access to the 
CR and CD adaptable control loop is not part of a standard RheoWin installation.

Version 4.00.0003

Below is a list of things that are new and/or changed in version 4.00.0003 compared with version 
4.00.0002 of RheoWin.

General

Help file format
• The help file format has been changed. This means that the help files are now compatible with 

Windows Vista without needing to install an update from MicroSoft.
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Rheometer drivers

Driver for MARS
• The optimize option for the number of repetitions per data points is now available for the MARS.

Driver for RV1
• On certain PCs on which RheoWin 3.xx worked without problems, RheoWin 4.00.000x produces 

"character overrun" and "framing error" communication errors. This has been solved.

Configuration (JobManager and DataManager)

Quantities/Units
• The friction coefficient which was introduced in version 4.00.0000) was given a wrong internal 

reference number, as a consequence the aT and bT shift-factors were not available anymore. This 
has been solved.

JobManager

Oscillation Elements
• The optimize option for the number of repetitions per data points is now available for the MARS.

Reports

New variable for reports
• A new variable VariableMeasureDeviceFullName is now available for display in a report. This 

variable contains the complete original model name of a rheometer (which can not be modified by 
a user).

Version 4.00.0004
(Released 19.11.2008)

Below is a list of things that are new and/or changed in version 4.00.0004 compared with version 
4.00.0003 of RheoWin.

Rheometer drivers

Driver for F6/N6/F8/N8 circulators
• Setting a temperature for these circulators was not possble when the unit symbol of the 

temperature was modified in RheoWin. This has been solved.

Driver for RheoStress 3000
• There is a dirver for the new RheoStress 3000 (which is only available in Japan).

JobManager

SetElement
• A special help file is now available for the adapable CR/CD-Mode. The help file is opened by 

clicking the Help button.

Note  The following MARS firmware (or newer) is needed for this to work:
UPD_MARS_CBOX_12_06_002_DSP_10_07_000.h86

Note  The following MARS firmware (or newer) is needed for this to work 
UPD_MARS_CBOX_12_06_002_DSP_10_07_000.h86
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MultiWave Oscillation Elements
• There was a problem with the timing of the MultiWave datapoints (since version 4.0). This has 

been solved.

Graph / Table display

Table display
• In RheoWin 4 selecting a column in a table by clicking on the column header was not possible 

anymore (this was possible in RheoWin 3). This functionality has been restored. 

Version 4.00.0005
(Released 12.12.2008)

Below is a list of things that are new and/or changed in version 4.00.0005 compared with version 
4.00.0004 of RheoWin.

JobManager

SetElement
• The help file for the adapable CR/CD-Mode has been improved. It now offers integrated 

calculators to calculate the control loop parameters.

SER Element
• The rheological values were not calculated correctly when the SER-tool was used in CS-Mode. 

This has been corrected.

Interpolation Element
• When using a user defined interpolation width (instead of the Default setting) the software used 

the wrong equation which in the case of noisy data may lead to slightly wrong results. This has 
been solved.

Version 4.00.0006
(Released 04.03.2009)

Below is a list of things that are new and/or changed in version 4.00.0006 compared with version 
4.00.0005 of RheoWin.

Rheometer/Circulator drivers

All devices
• Under certain circumstances the communication between RheoWin and any 

rheometers/viscometer was slowed down more or less (depending on which devices were used) 
when RheoWin was communicating with multiple devices at the same. This was noticeable when 
using a DC30 or DC50 circulator with any rheometer/viscometer for example. 
This has been solved.

Driver for DC30 and DC50 circulators
• The communication routines for these two instrument have been optimized. 

Drivers for MARS, RS6000, RS3000, RS600, RS300, RS1 and RV1
• Under certain circumstances the lift would not reach the set measurement position or the set 

standby position but stop at a slightly larger or smaller gap. This mainly happened when running 
measurements at higher temperatures. This has been solved.
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DeviceManager  

COM ports for DC30 and DC50
• The user can now select COM1 to COM16 (instead of COM1 to COM4) for the communication 

with a PC.

Solid clamp measuring geometry
• The user can now enter a value for the damping factor (for CR-Mode).

JobManager

Oscillation temperature ramp and temperature step elements
• The settings for the limiting maximum torque (checkbox and value) for CD-mode were not 

properly saved when editing these elements in the JobEditor. This has been solved.

Version 4.00.0007
(Released 23.06.2009)

Below is a list of things that are new and/or changed in version 4.00.0007 compared with version 
4.00.0006 of RheoWin.

DeviceManager  

Renaming devices
• In RheoWin 4.00.0006 renaming devices in the RheoWin DeviceManager was not possible 

because of a bug. This has been solved.

Version 4.1x.00xx

Version 4.10.0000
(Released 25.08.2009)

Below is a list of things that are new and/or changed in version 4.10.0000 compared with version 
4.00.0007 of RheoWin.

Installation

Windows 7 compatibility
• The installation program has been modified to be compatible with Windows 7.

Template for spectra calculation
• The path for the default graph template for the spectra graph was set to an incorrect value by the 

installation program. This has been solved.

New option interfacial rheometry
• In order to be able to use the new quantities and measuring geometries for interfacial rheometry 

the new Interfacial Rheometry option (order no. 098-5057) must be installed.
• This option is automatically installed when using the installation key 098-5019 for all instruments 

(this key is for Thermo internal use only).
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Measuring geometry selection
• By setting the option Manually select the measuring geometries (in the next three windows) as the 

default option during the installation, the user is now guided to manually selecting which 
measuring geometries should be installed. This selection is done in three subsequent dialog, one 
for "standard" parallel plate and cone and plate geometries, one for "standard" cylinder geometries, 
and for "special" geometries like vanes, double cones, ER-geometries etc.

New measuring geometries
• The new measuring geometries with longer shafts which were developed for the MARS III but 

who will replace the shorter geometries for all RheoStress and MARS instruments are now part of 
the installation.

General

Program user interface style
• The program user interface, i.e. the shape and colour of 'controls' (button etc.), has been 

modernized.

Program startup
• When RheoWin is executed by a Windows user who does not have the rights to write in certain 

directories (see the readme.doc file), RheoWin will now present the user a clear and 
understandable error message.

Automatic program lock (for 21 CFR part 11 module)
• On the Security page of the Preferences dialog the RheoWin system administrator can now define 

the duration of an inactivity (no mouse clicks, no use of the keyboard) interval in which RheoWin 
was not used. When this time interval is exceeded the control of RheoWin is blocked until the user 
enters her/his login information again.

Language
• In RheoWin the word 'sensor' was used for referring to a measuring geometry, this has been 

changed. The word 'measuring geometry' is now used throughout the software instead.

UserManager

Priviliges
• There are new per User(group) definable privileges for the Elements/Job/Template explorer (in 

JobManager) and the Data/Page/Template explorer (in DataManager) for: Renaming files

Rheometer/Circulators drivers

MARS II, MARS III
• Some improvement have been made in the TCP/IP communication.
• Several modifications were made to solve some time-out and instability problems.

MARS III
• A new driver for the MARS III rheometer is now part of the installation.

MTMC driver
• A new driver for the MARS III Temperature Module Controller (MTMC) is now part of the 

installation. This controller is an integral part of the MARS III.

Rheostress 300, 600, 3000, 6000, MARS II, MARS III
• MultiWave oscillation elements would not run directly after a normal oscillation element. This has 

been solved.

Note  This functionality is only available when RheoWin is installed with the 21 CFR Part 11 
option
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• Stopping a MultiWave measurement did not work. This has been solved.

Dynamax driver
• A new driver for the Dynamax circulator is now part of the installation.

Simulator driver
• The simulator now also supplies a random normal force "signal”.

DeviceManager

Thermocontroller devices
• In order to make things clearer the Port, to which thermocontrollers that are integrated in a 

rheometer (which is the case for the RotoVisco 1 and RheoStress 1) are connected, is now called 
Internal (and not Remote anymore). The Remote connection is now only used for external 
thermocontrollers that are connected directly to a rheometer (like the UTC).

Brookfield measuring geometries
• The Brookfield L1 to L4 and R1 to R7 measuring geometries can now be selected for use with all 

RS, RT and MARS rheometers. With these geometries one can only measure the viscosity of 
newtonian fluids.

Measuring geometry types for interfacial rheometry
• In the dialog Properties of ... of the measuring there are two new options available for the type of 

measuring geometry; Interfacial ring and Interfacial bicone.
• One new measuring geometry with the name Du Noüy ring is installed when RheoWin is installed 

with the Interfacial Rheometry option.

• The A- and M-factors of an Interfacial ring measuring geometry are automatically calculated when 
the diameter values are entered.

Measuring geometries device list
• In the box below the device list the inertia, compliance and expansion coefficient are now also 

shown for the selected measuring geometry.

Auxiliary devices
• The drivers for the Greisinger GMH 3110 and GMH 3111 manometers and the Ahlborn 

ALMEMO 2590-9 (and compatible units) hygrometer are now automatically installed and 
available in the auxiliary devices list in the DeviceManager.

MSC calibration
• The MSC calibration routine has been optimized.
• The current absolute angle value is now displayed below the graph during the calibration.
• By modifying the line

;MSCSpeed=0.01047

in the drivers.ini file the angular velocity with which the MSC calibration is performed can be 
modified. This is an experimental function! The value in the above command is the angular speed 
in rad/s.

Exporting MSC, MTC and TOT files
• The user is now asked to enter a filename when exporting these files.

Note  The values for the shear-rate and shear-stress that are calculated by RheoWin using the 
supplied A- and M-factors should not be used.

Note  The user must enter the correct inner and outer diameter of the Du Noüy ring geometry 
and the fluid container combination before this geometry can be used.
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MARS II and MARS III firmware updater
• Some modifications have been made in order to be able to distinguish the MARS II and MARS 

III.
• For the MARS III a bootstrapsloader was integrated. This function is for qualified service personal 

only!

Configuration (JobManager and DataManager)

Elements configuration dialog
• In this dialog the user can select which element icons are displayed on the Elements page of the 

Elements / JobExplorer toolbar. 
• The settings are saved for each RheoWin user individually.

Preferences dialog
• On the Directories page of this dialog the user can now define a base directory for the Job, Data, 

Page and Templates sub-directories
• On the General page of this dialog the user can now set a font size for the text in the Information 

window. The selected font size is valid for the Information window in both the JobManager and 
the DataManager.

• The default colour of the splitter has been changed to a light blue for better visibility.

Quantities/Units
• There is a new quantity vR, the circumfential velocity at radius R, for use with the tribology 

measuring cell and other friction related measurements.
• This quantity is calculated and saved by all the rotation elements and by the axial elements (i.e. not 

by oscillation elements).
• There is a new quantity We, the Weissenberg number, which is defined as the quotient of the shear 

stress and the first normal stress difference. This quantity is calculated and saved by all rotation 
elements.

• There is a new "quantity" Trigger, which can have the value 0 or 1 depending on whether the 
trigger output signal is off or on.

• There are two new quantities Δh(t) = | h_trigger - h(t) | and Δ%h(t) =  Δh(t) / h_trigger where 
h_trigger is the gap at the “trigger point” and h(t) the standard rheometer gap. In RheoWin 
h_trigger is the "current gap" at the moment the first Axial-Ramp Element in a Job is started. This 
quantity is calculated and saved by the axial ramp element only.

• There are new quantities G'-i, G"-i, G*-i, J'-i, h-i, t-i, etc. with the proper units for interfacial 
rheometry.

• A new quantity group "Interfacial" has been added, this group contains all the special quantities 
for interfacial rheometry.

Symbol/Colour master layout dialog
• In this new dialog the user can select the symbol and colour for every single quantity for upto 32 

data files. These symbol and colour settings are used as the default settings for any graph in 
RheoWin when the option Use master layout on the Layout page of the Data page of the Graph 
layout dialog is active.

• By double clicking on a column header above the table (in the new dialog) the symbolproperties 
(shape, style, size, colour, etc.) for all quantities in one data file can be defined in the Layout dialog.

• By double clicking on a quantity in front of a row (in the new dialog) the symbol properties for 
that quantity in all files can be defined in the Layout dialog.

• By double clicking on any symbol in the table the properties of that one symbol in on data file can 
be defined in the Layout dialog.

• The settings made in the dialog can be stored in a (*.layout file) and loaded from such a file.
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• Two *.layout file are part of the RheoWin installation:
In the file Master colour pro file, the files are distinguished by colour and the quantities by symbol. 
In the file Master colour pro quantity, the files are distinguished by symbol and the quantities by 
colour. 
This is the default setting after the installation.

• When a page which was created with a previous version of RheoWin is loaded (in DataManager), 
RheoWin will always use the layout setting as defined in that page and not use the colours and 
symbols defined in the master layout.

JobManager

Help menu in the Main Menu: Logfile-Viewer
• The Logfile-Viewer now also displays the log file from the e-mail program used in the 

Message-Element.
• The Logfile-Viewer now also displays the *.err files written by the device drivers.

Device toolbar
• In the Device Toolbar the user can now also directly set the temperature when a circulator or 

temperature control unit is connect to the rheometer or PC and when that unit is selected as the 
default Thermocontroller on the New job default page of the preferences dialog in the 
configuration menu. 

• Please note that there maybe a delay in opening and activating the Device Toolbar when 
JobManager starts up because some Thermocontrollers (mainly older circulators) have a slow 
communication interface.

• The functionality of the "LEDs" in the toolbar has been optimized: 
After clicking the Go to gap or the Find and set zero point button, an orange "LED" will blinking 
aside from that button until the action is completed, at that point the "LED" will become green. 
The green "LED" will disappear as soon as another button is clicked.

• The timing of the data-acquisition of the toolbar has been optimized so that it does not disturb the 
data-acquisition of a Job anymore.

Elements/Jobs/Templates Explorer
• On the Elements page of this toolbar the individual element icons can now be made hidden (i.e. 

not visible and not accessible) by right-clicking on an element icon and selecting Hide this element 
from the popup-menu.

• Hidden Element icons can be made visible (and accessible) again using the Elements configuration 
dialog. 

• The Elements configuration dialog is be opened by right-clicking on any element icon and 
selecting Elements configuration from the popup-menu. The Elements configuration dialog is also 
accessible from the Configuration menu.

• On the Jobs and Templates pages of this toolbar the job and template file names as well as 
directory names can now be edited after a "slow double click" or by selecting Rename from the 
popup-menu (right-click), just like in the Windows Explorer.
In the RheoWin UserManager each user can be denied to rename files by setting the appropriate 
user privilege.

• On the Jobs and Templates pages of this toolbar the file and directory names can be sorted 
forwards and backwards according the alphabet as well according to the date/time of creation of 
the file by selecting the appropriate option from the Arrange sub-menu on the popup-menu 
(right-click). The selected sort order is saved and used until it is modified again.

Job-Controller
• The large green Continue arrow with which the user can force the Job-Controller to discontinue 

the current element and jump to the next element can now be disabled by setting the appropriate 
user privilege in the RheoWin UserManager.
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• Under certain circumstances there were some problems with the display of the current temperature 
in the JobController window. This has been solved. 

• The linear expansion coefficient of a measuring geometry is now always send to the instrument at 
the beginning of a Job.

Manual control / Monitor
• The manual control window would crash when it was opened in the maximized state. This has 

been solved.

StartElement
• Messages about errors encountered when initializing the instrument are now more informative. 

Set Element
• The axial page in the Set-Element is now also available for all RheoStress 6000 and RheoStress 600 

with normal force option.
• The PID parameters of the RheoAdaptive control are now displayed in the JobEditor and in the 

Information window in the JobController and in DataManager.

Goto-Element
• The new Change temperature option can be used to automatically run one more or measuring 

elements at a number of different temperatures in a comfortable way.

No data saving in certain measurement elements
• In the measuring elements listed below there now is an option not to save the data that was 

acquired by that element. 
ROT time curve, ROT ramp, ROT temperature ramp, 
OSC time curve, OSC temperature ramp, 
Axial time curve, Axial ramp.

This is useful when a feature of a measurement element (like a break-criteria) is needed for meeting 
pre-test requirement without generating data points that are not needed.

ROT and OSC Temperature Step Elements
• The Set-Temperature value was not correctly saved under certain circumstances. This has been 

solved.

Rotation Step Element
• The minimum Step duration time for the Step mode option Fixed duration for each step is now 

0.1 seconds (instead of 1 second). By using a Step duration time of 0.35 s and an Integration time 
of  0.15s, the Rotation Step Element can now be used as a non-continuous "Ramp" which gives 
much better data at low shear rates than the continuous (real) Ramp Element will give.
The total time for this non-continuous Ramp must be calculated manually by multiplying the 
time per data point (0.5 seconds in this example) by the number of data points. We will offer a 
better solution for this in the near future.

All Rotation Elements
• The Weissenberg number We, which is defined as the quotient of the shear stress and the first 

normal stress difference, is now calculated and saved by all rotation elements.
• The new quantity vR, the circumferential velocity at radius R, is now measured and saved by all 

rotation elements.

All Oscillation Elements
• The functionality of the STOP and NEXT buttons (in the JobController) has been improved.
• The "Take from previous" option for the Auto tension force value (Axial page in Element editors) 

did not work properly. This has been solved.

Axial Ramp Element
• The end position of the ramp can now be defined as a percental value of the initial position of the 

ramp.
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• The element now measures and saves the two new quantities Δh(t) and Δ%h(t). These quantities 
can be used for texture analysis measurements.

Axial Ramp Element
• On the Parameters page of the Axial page the dependence between the edit fields for the Gap, 

Duration and Dh/t was not correct. This has been solved.

Axial Ramp Element & Axial Time Element
• The two quantities friction force Ff = M / R (with M is torque, R is radius) and friction coefficient 
f = Ff / Fn are now also measured and saved by the axial elements.

• The new quantity vR, the circumferential velocity at radius R, is now measured and saved by the 
axial elements.

• The axial element now allows the acquisition of images from any compatible camera.

Axial Time Element
• The quantities friction force Ff (CS-Mode) and circumferential velocity vR (CR-Mode) can now 

be entered as a set value on the Rotation page of the editor of this element.

Curve-Discussion Element
• For a calculated mean value there is a new QC criterium. The operator symbol for this new 

criterium is ><. When this operator is selected an edit field for a percentual value Y appears right of 
the operator selection box. 
This criteria determines whether the calculated mean value differs more then Y % from the largest 
or smallest values in the data range. This criteria can be used to check the amount of noise in a 
measured signal.

Crossover Evaluation Element
• The crossover element crashed when used in a Job when the measured data did not contain a 

crossover point. This has been solved.

Yield-Stress Evalution Element
• The calculation routines have been optimized.

Creep/Recovery Evaluation Element
• The subscript zero has been removed from the symbols for the calculated results.

Thixotropy and Area Evaluation Element
• A mathematical bug in the calculation of the result has been removed.

DataManager

Opening files from the Windows Explorer
• Double clicking on a *.rwd data file or a*.rwp page file will now also open this file in a new page in 

DataManager when DataManager is already running and already contains pages. 
• A *.rwd data file can be added to an existing page by dragging and dropping the file onto the 

titlebar of that page.

File menu
• With the new Save as without images command in the Save submenu a file which originally 

contained images (from the RheoScope for example) can now be saved without the images.
• In the dialog which appears when clicking the new Change file order command the order of the 

currently loaded files (in a page) can be re-arranged using two arrow buttons.
The file order is reflected in the graph legend and in the information window in a page.
The functionality to re-arrange the file order (see above) is also available in the Remove file dialog.

Note  Dragging a file on the inside of the page (i.e. on the graph or table) will not add the file to 
the page.
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Standard toolbar
• The file order re-arange dialog is also opened by clicking on the new Change file order icon in the 

standard toolbar.

Data/Page/Template Explorer
• File name as well as directory names can now be edited after a "slow double click" or by selecting 

Rename from the popup-menu (right-click), just ilke in the Windows Explorer.
In the RheoWin UserManager each user can be denied to rename files by setting the appropriate 
User Privilige.

• File and directory names can be now sorted forwards and backwards according the alphabet as well 
according to the date/time of creation of the file by selecting the appropriate option from the 
Arrange sub-menu on the popup-menu (right-click). 
The selected sort order is saved and used until it modified again.

• XML files (*.xml) are now listed in the explorer tree on the Date page.

MWD calculation
• A mathematical bug which could lead to problems has been solved.

Graph / Table display

Data select for evaluation using the mouse
• The range of data on which an evaluation will performed can now be selected by marking the first 

and last data point of the desired range in the graph using the mouse.
• In order to be able to use this new function it must enabled first, by either clicking on the new 

Data select icon on the left-hand side of the status bar of the graph window or by using the new 
command Range select > Active in the graph context popup-dialog (right mouse click on graph).

• When this function is enabled the user can select a range by pulling-up a rectangle on the graph 
(press right mouse button and keep it pressed while moving the mouse). 
When the mouse button is released two red circles are drawn in the graph to mark the first and last 
data point of the selected range.

• The range can also be selected by clicking on a datapoint and keep the (right) mouse button down, 
then waiting for a fraction of a second for a red circle to be drawn around the datapoint and then 
moving the mouse along the curve to any other data point while keeping the mouse button down 
(and dragging a second red circle along the curve). When the mouse button is released two red 
circles are drawn in the graph to mark the first and last data point of the selected range.

• As long as the two red circles are displayed in the graph they can be "grabbed" (with the mouse) 
and moved along the curve to change the selected range.

• By clicking on any other curve in the same graph, that curve will be selected using the same 
x-range (the two red circles will mark the corresponding data points).

• By clicking on any other curve in the legend of a graph, that curve will be selected using the same 
x-range (the two red circles will mark the corresponding data points).

• The range selected by the mouse is of course reflected in the Data select dialog, but not (yet?) vice 
versa.

• The range selected by the mouse is of course reflected in the dialogs of the evaluation elements (but 
modifications made in the selected range in the elements are not transferred back to the graph).

• The selected range can be removed by clicking the Delete range icon on the left-hand side of the 
status bar of the graph window.

• As long as this function is enabled, zooming in the graph using the mouse is disabled.
• The selected range is saved and restored when the graph is redrawn after opening and closing the 

graph dialog, after rescaling, after adding/removing files, etc.
• After selecting a data range the user can open a small Calculated values tool window by either right 

clicking on one of the two range markers and selecting Calculate from the pop-up menu or by 
clicking on the C button in the status bar of the graph.
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• While the Calculated values window is open the user can modify the selected range by moving the 
range markers with the mouse, the calculated values will then be re-calculated and updated.

• The Calculated values window currently shows the following values: x-range, y-range, the mean y 
value with its standard deviation, the lin-lin slope, the log-lin slope and the log-log slope.

• Selected calculated values can be transferred to clipboard and then pasted on to the graph.

Graph layout dialog

Graph legend
• The order in which file names are displayed in the graph legend can now be defined by 

re-arranging the file order, see above.
• The text which is displayed (for a data file) in the graph legend can now be configured, see below. 
• On the Legend + text page of the Graph layout dialog the text which is displayed (for a data file) in 

the graph legend can now be freely configured. The legend text can be a combination of text fields 
like Filename, Substance name, Sample no, Comment etc. as well a User-defined text.
The user-defined text is stored in the data file and must be entered in the Identification/Notes 
dialog which can be accessed from the file menu or the standard toolbar.

• In the Masterlayout box on the Layout page of the Data page of the Graph layout dialog the user 
can (de-) activate the new Use master layout option.
When this option is active RheoWin will use the colours defined in the "Symbol/Colour master 
layout" dialog in the Configuration menu and the controls to change symbols will are disabled. In 
order to manually change any colour and/or symbol this option must be deactivated.

Proportional/Fixed text size
• Changing the text size option from proportional to fixed and vice versa now works correctly on an 

active page.

Axis context menu
• By right clicking on an axis or the axis labels of an axis and then selecting Unit ... from the popup 

menu the user can now select another unit for the quantity displayed on the axis.
• When the right-mouse-key context-menu for an axis was used to change the number format of 

that axis the scaling for the axis was set Autoscale. This has been solved.

Graph layout dialog
• On the Legend + text page of the Graph layout dialog the text which is displayed (for a data file) in 

the graph legend can now be freely configured. For the legend text the Date and/or Time of the 
measurement can now be selected also.

Graph display
• Some low level routines of the graph display functionality have been optimized and debugged.

Version 4.10.0001
(Released 30.09.2009)

Below is a list of things that are new and/or changed in version 4.10.0001 compared with version 
4.10.0000 of RheoWin.

Installation

MARS III installation
• The RheoAdaptive Control option (order no. 098-5056) is now automatically installed as part of 

the MARS III installation.

Note  This order no. is not shown on the installation welcome screen. (Only order no.'s for 
which the key was manually entered are displayed in that screen.)
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Rheometer/Circulators drivers

MARS II, MARS III
• Under certain circumstances (for example when the temperature is not yet constant) the lift would 

never reach the Standby position (defined in a Lift-Element). This problem has been solved by 
giving the Standby position a default tolerance of 10 micrometer. The tolerance value can be 
modified by activating the following line in the drivers.ini file:

[MARS2]

;LiftPosTolerance=0.025

The line is activated by removing the leading ";". In the example above the tolerance is set to 25 
micrometer.

JobManager

Lift-Element
• Clicking on the green goto next element button in the JobController while the lift was moving to 

Standby position would end the Job completely. This has been solved.

Curve-Discussion Element
• The QC value for the new >< operator was not displayed when this element was used in a Job. 

This has been solved.

DataManager

Modifying the identification
• Modifying the Identification properties of a data file (sample name, legend text, etc.) was not 

possible when the data file was initially loaded as part of a page (*.rwp, page file). This has been 
solved.

Version 4.10.0002
(Released 09.10.2009)

Below is a list of things that are new and/or changed in version 4.10.0002 compared with version 
4.10.0001 of RheoWin.

Rheometer/Circulators drivers

MARS III
• In the manual control window the normal force value was intermittently not displayed under 

certain circumstances. This has been solved.

DeviceManager

MTMC
• On the right hand side of the MTMC diagnosis window the status of the temperature control 

(active/not active) is now displayed.
• On the right hand side of the MTMC diagnosis window the status of the flow control valves is 

now displayed. By opening the diagnosis window while a job (which includes temperature control) 
is running, the status of the valves can be monitored on-line and in  real-time.

• With the slider controls below the flow control valves the status of the valves can be changed 
manually. Manually controlling the valves with the slider controls will stop the control of the last 
set temperature.

Version 4.10.0003
(Released 03.11.2009)



Below is a list of things that are new and/or changed in version 4.10.0003 compared with version 
4.10.0002 of RheoWin.

JobManager

Job-Editor
• It was possible to start a Job in which no measuring geometry was defined (selected). Under certain 

circumstances this would result in the software sending a wrong temperature value to the 
instrument. This has been solved. Starting a Job in which no measuring geometry is defined will 
now result in an error message, and no commands will be send to the instrument.

Oscillation Time Element
• The timing of the trigger function has been optimized.

Version 4.10.0004
(Released 10.11.2009)

Below is a list of things that are new and/or changed in version 4.10.0004 compared with version 
4.10.0003 of RheoWin.

Rheometer/Circulators drivers

RS600
• The RS600 driver which was part of the 4.10.0003 update had a problem regarding oscillation 

measurements. This has been solved.

Version 4.10.0005
(Released 18.11.2009)

Below is a list of things that are new and/or changed in version 4.10.0005 compared with version 
4.10.0004 of RheoWin.

Installation

Masterlayout files
• On deinstallation the Masterlayout settings are now saved. This means that during the installation 

of the next new version, the Masterlayout settings will be restored automatically when the "restore 
setting from previous version" is selected during the installation.

DeviceManager

Measuring geometries
• The sample volume values for the following VT550 measuring geometries have been modified: 

MV1, MV2, MV3, MV-DIN, MV-E, SV-DIN, SV-E, HV1, HV2
These sample volume values were slightly wrong.

• The sample volume values for the following pressure cell measuring geometries have been 
modified: PZ35, PZ36, PZ37, PZ38, PZ38 b, PZ39 These sample volume values were slightly 
wrong.

Note  In order to save the Masterlayout files of version 4.10.0004 or earlier you will have to 
make a copy of these files manually. The *.layout files are by default stored in the following 
directory: 
C:\Documents and Settings\All Users\Application Data\Thermo\RheoWin
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• Since the sample volume values for the D75/300 Hasteloy pressure cell are slightly different the 
following new measuring geometry entries have been added to the list PZ36 Ha, PZ38 Ha, PZ39 
Ha.

Version 4.10.0006
(Released 30.11.2009)

Below is a list of things that are new and/or changed in version 4.10.0006 compared with version 
4.10.0005 of RheoWin.

DeviceManager

MTMC
• The message Please select cooling media appeared when trying to set a temperature. This message 

should only appear when using the TM-EL-P, TM-EL-P + TM-EL-H or TM-EL-C and when no 
Cooling media was yet selected on the Hardware page of the Properties of MTMC dialog. 

• This message should not appear when the TM-PE-P or TM-PE-P + TM-EL-H are used since in 
this case the cooling media must always be a liquid (e.g. water). This has been solved.

JobManager and DataManager

Printing
• When using the Print command from the File menu in DataManager or the Print element in 

JobManager, long data tables sometimes were not printed completely (some lines at the end of the 
table were missing). This has been solved.

Version 4.10.0007
(Released 11.01.2010)

Below is a list of things that are new and/or changed in version 4.10.0007 compared with version 
4.10.0006 of RheoWin.

Installation

ART service program
• The ART service program can now optionally be installed when a general RheoWinkey is used for 

the installation.

Rheometer/Circulators drivers

SC, AC and PC circulator
• A new driver for the completely new range of Thermo Scientific circulators, consisting of the 

Standard (SC), Advanced (AC) and Premium (PC) models is now part of the installation.

Note  The ART software is for use by authorized and trained service engineers only.

Note  The communication between a PC (i.e. RheoWin) and these new circulators relies on a 
virtual COM port driver which causes these circulators (which have an USB interface) to 
appear as devices with a serial COM port. This driver (FTDI USB driver) is available on the 
RheoWin CD and must be installed separately. Installation manuals are available on the 
RheoWin CD also.
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Version 4.2x.00xx

Version 4.20.0000
(Released 02.07.2010)

Below is a list of things that are new and/or changed in version 4.20.0000 compared with version 
4.10.0013 of RheoWin.

Installation

Symbol/color Master layout file
• The three default Symbol/color master layout files Master.layout, Master color pro quantity.layout 

and Master color pro file.layout are now saved during the deinstallation and restored during the 
installation when the option to use the settings from the previous version is used.

• Per default the Master color pro quantity.layout file is now used in JobManager and the Master 
color pro file.layout file is used in DataManager. When the option to use the settings from the 
previous version is used during the installation, these defaults are overwritten with the settings 
from the previous version.

Measuring geometries for Peltier cylinder (TM-PE-C)
• The measuring geometries for the Peltier cylinder (TM-PE-C) are now part of the installation.

General

Splash screen
• Some of the images in the RheoWin start-up "splash-screen" have been updated.

Language
• The language.xls file has been completely updated regarding the french and the portugese 

language.
• A bug in the language.dll (i.e. the part of RheoWin which loads the language specifictext from the 

language.xls file) was found and solved. Since this functionality is used throughout RheoWin this 
bug fix may solve some "unexplicable" software problems.

Number format: Decimal symbol
• RheoWin now uses the Windows settings (see the Windows Control Panel) for the decimal 

symbol consequently throughout the software in all edit fields and for all displayed numbers in 
graphs, tables, lists, etc. (apart from some export files, see below).

• Depending on the Windows regional settings the decimal symbol may be a point (dot) or a 
comma.

• For special export files like the *.MSC table files, *.MTC table file, *.TOT table files, *.RWR 
oscillation raw data files and *.ini files a point (dot) is always used as the decimal symbol for 
compatibility reasons.

DeviceManager & Rheometer/Circulators drivers 

Main dialog
• The images on the buttons on the right hand side of the device list have been updated.

MTC button
• In order to prevent problem arising from incorrect determined MTC tables, the MTC calibration 

functionality is now hidden for normal users. Only qualified service engineers should use this 
function.
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MSC dialog for MARS III
• The text explaining the three "quality" options for the MSC calibration has been modified.

The three options are now named: 
High precision, duration ca. 20 min.
Standard, duration ca. 10 min
Fast, duration ca 5 min.

All devices
• When the option Communication log is activated on the Options page of the device property 

editor in DeviceManager, the user will now be asked whether this option should be switched off or 
not every time the communication with the instrument is started. This is to prevent that the 
communication logging is activated all the time.

• When a device was switched off while the communication between RheoWin and the device was 
still running, it sometimes took a long time to actually stop the "broken communication". The 
duration for this has been shortened.

All rheometer and viscometer drivers
• All drivers have been further optimized regarding fault tolerance and communication speed.
• Under certain circumstances (for example when the temperature is not yet constant) the lift would 

never reach the Standby position (defined in a Lift-Element). This problem has been solved by 
giving the Standby position a default tolerance of 10 micrometer.
The tolerance value can be modified by activating the following line in the drivers.ini file

[rheometer_name]

;LiftPosTolerance=0.025

Where "rheometer_name" stands for rheometer driver *.dll name, like MARS2, MARS3, RS6000, 
RS1, etc.
The line is activated by removing the leading ";". In the example above the tolerance is set to 25 
micrometer.

MARS II and MARS III drivers
• After clicking on the new Set IPADR button on the General page of the Properties of MARS 

dialog the user can now modify the IP adress of the instrument. Currently this functionality is only 
available when RheoWin is already able to communicate with the instrument. The MAC address 
dialog which appears when this is not the case is not functional yet.

• In most cases only the numbers after the last dot in the IP adress can be changed without making 
the instrument inaccessible from the current PC! That means that in the default IP address 
192.168.2.140 only the number 140 can be changed easily. All other changes will need changes in 
the network setting of the PC also.

• The warning messages in the dialog in which the IP adress can be modified and in the 
confirmation message boxes should be taken seriously.

• The above mentioned functionality for modifying the IP adress is also available in the MARS II 
driver, but in order for this work the bootloader firmware of the MARS needs to be update first. 
Doing that is not trivial. Documentation for this is available on request.

• The communication between the MARS and the PC has been improved regarding continuity.
• The Scan function (to find a MARS in a Network) has been improved.

Drivers for RT20, RS75, RS80, RS150, RS1, RO1, RS300, RS600, RS3000, RS6000, MARS II and MARS 
III

• Under certain circumstances the CD-AS mode (AutoStrain) did not work properly and did not 
reach the set strain value. This has been solved.

Note  This function should only be used by persons who know what they are doing.
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Measuring geometries
• The damping value for the solid clamps is now set to 90 per default. With this setting a new 

CD-mode control loop in the MARS III which is optimized for the solid clamps is activated.

MTMC and UTMC drivers
• The size of the temperature offset tables is now limited to 10 offset values due to certain limitations 

in the firmware.

MTMC driver
• The display of the control status in the Diagnosis window has been corrected.
• The message "no cooling media selected" did not always appear when it was appropriate. This has 

been solved.

CTC (oven)
• The driver name, the type name and the device name of this device have been changed from 

tc-oven.dll, OTC and TC-Oven to the correct names ctc.dll, CTC and CTC respectively. This 
means that Jobs in which this device is used must be modified.

• The driver now works correctly with the MARS III.

SC, AC and PC circulator
• A new driver for the completely new range of Thermo Scientific circulators, consisting of the 

Standard (SC), Advanced (AC) and Premium (PC) models is now part of the installation.

External thermometer
• With a new driver (MultiTemp.dll) the Ahlborn ALMEMO 2590 universal meauring instrument 

(and compatible units) can now be used as a four channel thermometer.
• This driver is automatically installed and can be selected as Thermometer (Ahlborn ALMEMO 

2590) in the list of Auxiliary devices on the Additional data page of the rheometer device editors in 
DeviceManager.

• The four measured temperature values are available as the quantities TxMT01, TxMT02, 
TxMT03 and TxMT04 for display in all graphs and tables.

Configuration (JobManager and DataManager)

Preferences dialog
• The user can now set a default temperature value. This value will be used for any element which is 

added to a Job in the JobEditor.
• The user can also activated the Take from previous option for the temperature. When this option 

is active this option will be activated in any element added to a Job.
• Some texts on the Security options page (21 CFR part 11 installation only) have been modified for 

easier understanding.
• On the General page in the Range select box the user can now select whether the Range select per 

mouse function is active per default (instead of the Zoom function).
Both the Range select per mouse and the Zoom function work by select a rectangular area in a 
graph, so only one of them can be active at the same time.
On the General page in the Range select box the user can also select a colour for the two Range 
select markers.

Note  MARS III firmware DSP 50.06.000 or higher is need for this.

Note  The communication between a PC (i.e. RheoWin) and these new circulators relies on a 
virtual COM port driver which causes these circulators (which have an USB interface) to 
appear as devices with a serial COM port.
This driver (FTDI USB driver) is available on the RheoWin CD and must be installed 
separately. Installation manuals are available on the RheoWin CD also.
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Symbol/Colour master layout dialog
• The user can now select separate Master Layout files for the JobManager and the DataManager in 

the Configuration menu of each program.

JobManager

Element icons
• All element icons have been modernized. All measurement icons have a blue background, all 

evaluation elements a green background and all general elements a light-grey background.
• The Goto, Set and Exec element icons have been slightly modified.

JobEditor
• The text behind the icons in the element list is now displayed in a tabulated list which also uses 

colour. 
• The user can switch back to the old style element list display or disable the use of colour by 

deactivating the corresponding options in the context popup-menu (to open that menu click with 
the right mouse key on any element icon).

• The user can also change the font size of the element list from the context popup-menu.
• The above mentioned setting are stored and used for all Jobs displayed in the JobEditor.

Manual control / Monitor
• On the Numeric page of the manual control window the gap, normal force and temperature values 

would sometimes change position. This has been solved.

Automatic periodic saving of dating
• During a measurement (Job) the acquired data is always saved in a temporary file every 2 minutes, 

apart from in jobs in with images are acquired also. This functionality can now be switched off in 
the File Save dialog.

Lift element
• In the (slightly modified) editor of the lift element a user definable sample trimming position can 

now be defined. When this option is activated the lift will stop at the defined distance before the 
measurement position while the rheometer drive motor is locking the shaft so that the sample can 
be trimmed without rotating the measuring geometry. A message will be displayed prompting the 
user to click Ok after finishing the sample trimming.

• The lift element now displays the Triming position (when activated) in the Job-Editor list.
• The lift element now displays Standby position (when activated) in the Job-Editor list.
• The Standby position now has a default tolerance band of 10 micrometer, see above.

Set element
• The zero point for the relative gap Δh and Δ%h can now be set. This is useful for texture analysis 

type of measurements.
• Setting a certain absolute angle has been made more accurate.

All measurement elements
• All elements have been further optimized regarding fault tolerance.
• The icons on the set-parameter and data-acquisition-parameter pages have been removed.
• Some changes in internal data calculations have been made to prevent strange unmotivated 

crashes.

Rotation ramp element
• On the Parameter page of the Rotation page in the element editor the user can now choose 

between Continous and Stepwise for the ramp type.
• In the case of a Continous ramp the shear-rate (CR-Mode) or shear-stress (CS-Mode) is ramped 

up continously as smoothly as technically possible.
• In the case of the new Stepwise ramp the shear-rate (CR-Mode) or shear-stress (CS-Mode) is 

ramped up in discrete small steps.
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• In the case of a Stepwise ramp the data collected during the first half (but maximally 1 s) of the 
step duration is discarded.

• On the Acquisition page of the Rotation page in the element editor the user can now enter a 
Integration time. This is the time during which raw data is collected. The mean value of this raw 
data is used to calculate the actual data points.

Oscillation time element
• The new FastOsc (Fast Oscillation) option is now accessible in the Osc Time Element dialog when 

the firmware of the instrument (MARS III only) supports this option. 
• Please note: MARS III Firmware version 50.06.000 or newer is needed for this.
• When FastOsc in CS-Mode the torque can be defined using a table of torque = f(time) values. This 

table can be calculated using a selection of functions and by comparing the shape of the function 
with the result of a preliminary measurement which was performed at constant torque value.

• The table can also be created manually (with an external editor) and loaded into the Osc time 
element.

Report element
• When selecting a report template from the element editor the file open dialog will now open the 

default report template directory unless the currently selected template was loaded from a different 
directory. In that case the file open dialog will open that directory.

Curve-Fit element
• Some potential division by zero cases have been removed.

*.RWR Viewer program
• The *.rwr viewer program now contains two range bar indicators for the torque and angle.
• The *.rwr viewer program can now read *.rwr files from FastOsc measurements.
• The command Save continous sine wave data from the File menu can be used to combine and save 

the individual sinewaves (1 period each) of all rheological measurement points of a FastcOsc 
measurement into one file containing a continuous sinewave signal.

Graph / Table display

New table function
• The table has been completely replaced by a modern up-to-date version.
• Tables can now be exported in Excel format directly (from the table context menu). Excel files are 

saved with the *.xml extension and in the "Microsoft Office (Excel) XML format". This format is 
compatible with Excel XP (or Excel 2002), Excel 2003 and Excel 2007.

DataManager

Loading data files
• The loading time for data *.rwd and page *.rwp files has been improved.

Add text dialog
• The edit field for the text in the Add Text dialog has been increased in height from two to four 

lines of text.

Data select for evaluation using the mouse
• The two (rather small) red circles who marked the selected range in the previous version have been 

replaced by much larger markers which make it easier to move these markers by clicking on them 
and dragging them to the desired position.

Note  This (currently) only gives the correct result when the highest possible data 
acquisition-rate of 2 ms per data point is used in FastOsc.
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Data select for evaluation using the data select dialog
• Selecting the data range (data-file, quantity, X-axis range) for any evaluation routine has been been 

made more comfortable.
• The data from the first loaded file and the first quantity found on the first Y-axis and the first 

quantity found on the X-axis of the currently active graph (page) are now automatically set a the 
selected data range.

• The file selected in the result tree on the left hand side of a evalution dialog is now automatically 
selected in the Data Select dialog also.

• In the Data Select dialog below the segment list, there are a now an All segments and a No 
segments button.

Version 4.20.0001
(Released 26.07.2010)

Below is a list of things that are new and/or changed in version 4.20.0001 compared with version 
4.20.0000 of RheoWin.

DeviceManager & Rheometer/Circulators drivers 

RS300, RS600, RS3000 and RS6000
• Certain additionally measured temperature signals from the UTMC were not saved when the 

UTMC was connected directly to the rheometer (remote interface). This has been solved.

Universal Temperature Controller (UTC)
• The remote communication with MARS and RSxxxx rheometers has been optimized. 

Ahlborn ALMEMO thermometer
• On certain localized Windows versions (e.g. Japanese) the driver (MultiTemp.dll) for the Ahlborn 

ALMEMO 2590 universal measuring device did not work properly. This has been solved. 

JobManager

All Rot elements
• Certain internal calculations needed to convert raw data to rheological could lead to crashes under 

very special circumstances. This has been solved.

Rot-Time, Rot-Multistep and SER element
• The automatic integration time in these elements did not work as intended. The integration time 

duration was not calculated correctly. This has been solved.
• When the integration time is set to automatic (in CR-Mode only!) the integration time is 

calculated according to the following equation:
"Integration time" = 0.002 sec / Omega 

Here Omega is the angular velocity in rad/s. The resulting (automatic) integration time is limited 
to 100 s.

Osc-Time element 
• When switching forth and back between the different modes the edit field for the max. torque was 

not always enabled/disabled correctly. This has been solved.

DataManager

TTS module
• The TTS module in version 4.20.000 does not give correct results! This is caused by a small 

omission (in this module) regarding the transition to using the Windows settings for the decimal 
symbol. This has been solved.

• The dialog of this module has been modernized. Some text items have been changed.
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• The new DataManager pages for the Shift factors, Shifted data and Master curve that are created 
by the module to display the TTS results now have the corresponding titles in the title bar of the 
page windows (instead of titles like Page 2, Page 3 etc.).

Spectrum module
• The Spectrum module in version 4.20.000 does not give correct results! This is caused by a small 

omission (in this module) regarding the transition to using the Windows settings for the decimal 
symbol. This has been solved.

• The dialog of this module has been modernized. Some text items have been changed.
• The new DataManager page for the Spectrum that is created by the module to display the 

Spectrum results now has a corresponding title in the title bar of the page window.

MWD module
• The new DataManager page for the MWD that is created by the module to display the MWD 

results now has a corresponding title in the title bar of the page window.

Graph / Table display

New table function
• Under certain circumstances rows of data would not be displayed in the table during a 

measurement (Job). This has been solved.
• When a value was deleted from a table using the Del key on the keyboard the corresponding graph 

was not automatically updated.This has been solved.
• During a measurement (Job) the size of the table was not automatically adapted to the size of the 

window when the window size was modified. This has been solved.
• When exporting to Excel the data index was not exported correctly (it started at 2 instead of 1). 

This has been solved.
• Under Windows Vista and Windows 7 an exported ASCII or Excel file was not saved in the correct 

directory. This has been solved.

Version 4.20.0002
(Released 28.07.2010)

Below is a list of things that are new and/or changed in version 4.20.0002 compared with version 
4.20.0001 of RheoWin.

DeviceManager 

Inertia determination
• The inertia determination function did not work in version 4.20.0001. This has been solved.

JobManager and DataManager

Loading files under japanese Windows
• When loading files under a japanese version of Windows, RheoWin 4.20.0000 "copied" the data 

from the first file and used that for all subsequent loaded files when the path name contained 
japanese characters. This has been solved.

Version 4.20.0003
(Released 24.08.2010)

Below is a list of things that are new and/or changed in version 4.20.0003 compared with version 
4.20.0002 of RheoWin.
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DeviceManager & Rheometer/Circulators drivers

RS1, RO1, RS300, RS600, RS3000, RS6000, MARS II and MARS III
• The file name format of the *.msc file which is automatically saved at the end of the MSC 

calibration measurement was not uniform. This has been changed.
• The file name now always contains the (short) name of the instrument plus the date and time.

Phoenix and Dynamax circulators
• The drivers for these circulators crashed when used in remote mode. This has been solved.

Auxiliary devices
• When an Auxiliary device was selected on the Additional data page of the Properties of ... dialog of 

a rheometer and when that auxiliary device was not operational RheoWin would show wrong 
values for certain extra data channels like Hood-temperature etc. This has been solved.

Image acquisition
• When an older version of the Matrox-Imaging-Library was installed on the PC (MIL version <= 5) 

RheoWin would crash, this has been solved.

Exporting *.msc files
• The number format of an exported measuring geometry MSC file was not correct. This has been 

solved.

Graph / Table display

Changing the quantity for a table columns
• Under certain circumstances changing the quantity for a certain column in a table did not give the 

expected result: The quantity of another column as the selected colum was changed. This has been 
solved.

Version 4.20.0004
(Released 19.10.2010)

Below is a list of things that are new and/or changed in version 4.20.0004 compared with version 
4.20.0003 of RheoWin.

JobManager

Timing problem with data acquisition
• In RheoWin 4.20.0002 and 4.20.0003 when a very high dasta acquisition rate was used, data 

points would not get the correct time value. This has been solved.

Saving as ASCII
• In RheoWin 4.20.000x saving as ASCII from a Job did not work. This has been solved.

Version 4.20.0005
(Released 18.11.2010)

Below is a list of things that are new and/or changed in version 4.20.0005 compared with version 
4.20.0004 of RheoWin.

DeviceManager & Rheometer/Circulators drivers

MARS III
• For the RheoScope module a lens with a magnification of 2.5x can now be selected.
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JobManager

Data Export Element
• Under certain circumstances using the Data Export element would lead to a software crash. This 

has been solved.

Curve-Fit Element
• Two new curve-fit equations have been added to the list of mathematical models. Slope log(y)=f(x) 

and Slope log(y)=f(log(x)). These curve fit equations can be used to calculate the log slope and 
log-log slope of (parts) of a curve. The slope is calculated by means of a linear curve fit according to 
y = a + b*x through linearized data. As a result only b, that is the Slope value, is returned.

DataManager

Saving as Excel from a table
• Saving as Excel was very slow. So slow that users got the expression that RheoWin was not working 

anymore when data was saved in an Excel file. This has been solved.

Calculation popup dialog
• Under certain circumstances (with negative values on the x-axis and after changing the selected 

range to include negativ x-values) the log(y)=f(x) slope and log(y)=f(log(x)) slope were not 
calculated correctly. This has been solved.

Version 4.3x.00xx

Version 4.30.0000
(Released 9.12.2010)

Below is a list of things that are new and/or changed in version 4.30.0000 compared with version 
4.20.0005 of RheoWin.

Installation

Language file
• The Polish language column in the language file has been updated completely.

Drivers and element for the Rheonaut module
• A new driver for the Rheonaut module is now part of the installation.
• A new driver for a FTIR spectrometer is now part of the installation.
• A new element for controlling the Rheonaut module and a FTIR spectrometer is now part of the 

installation.

Driver for the Viscotester D and Viscotester E
• Two new drivers for the Viscotester D and Viscotester E are now part of the installation.

DeviceManager 

Missing device drivers
• When an instrument is listed in the devicemanger but the corresponding driver *.dll is not 

installed, a clear message is now displayed in the box below the device list. The message is in red 
colour and shows exactly which driver is missing in which directory.

Driver for MARS III
• In the editor of the MARS III driver a 2nd MTC table (for the new low-torque mode) can now be 

downloaded from the instrument.
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Driver for the Viscotester D and Viscotester E
• Two new drivers for the Viscotester D and Viscotester E are now part of the installation.

Driver for the Rheonaut module
• The new driver for the Rheonaut module is listed as thermocontroller in the RheoWin 

DeviceManager.
• Using this driver RheoWin can control the temperature of the Rheonaut module and control the 

axial position of the complete module relative to the rheometer drive motor axis.

Driver for FTIR spectrometer
• A new driver for a FTIR Spectrometer is listed as an auxilliary device in the RheoWin 

DeviceManager. Using this driver RheoWin can communicate with the FTIR spectrometer 
software. The driver is currently compatible with the Bruker Opus software. In the near future it 
will also be compatible with the Thermo (Nicolet) spectrometer software.

Driver for SC, AC and PC circulators
• A communication problems between these circulator and RheoWin was solved.

• The internal temperature ramp function of the AC and PC circulators does not work when 
initiated using software commands. Because of that temperature ramps are now controlled by 
RheoWin, just like with the SC circulator.

JobManager

Element icons
• Some of the General-Element icons have been modernized.

Elements configuration dialog
• The display of the element icons in this dialog was not correct. This has been solved.

Job controller
• Error messages which come from devices (rheometer, viscometer, temperature controller, 

circulator, AUX-devices) are no longer displayed in a messagebox (which stopped the job sequence 
until it was closed) but in a new Events page in the Job controller window. This page is only shown 
when there are messages to be displayed.
The page is automatically put in the foreground (this functionality can be deactivated).

• The events that occurred during a measurement are saved in the *.rwd data file.

Identification Element
• When in the identification element an item was marked as Disabled and Mandatory at the same 

time AND that item is blank at run-time a Job containing this element would not continue at this 
point. This has been solved, the Job can now be cancelled using the Stop button in the 
Job-Controller.

Goto Element
• In all previous RheoWin version the maximum number of elements in on Job was limited to 499. 

This limit has been removed. The maximum number data segments per data file was limited to 
1024. That limit was removed also. As a consequence the number of elements and resulting data 
segments is now virtually unlimited.

Note  For the communication to work without problems the circulator firmware version 1.103 
or newer is needed

Note  Due to a certain structural overhead in the element definitions a Job with a very high 
number of elements needs a relative high amount of memory.
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Lift-Element
• The Trimming position option did not work properly when there was a Temperature set element 

in the job sequence before the lift element. This has been solved.
• The Trimming position option did not work properly when the Thermo gap option was active. 

This has been solved.

Set-Element and Temperatur-Set Element
• At the start of these elements any lift-control (i.e. normal force control or position control) is now 

explicitely stopped in order to prevent problems with lift-control functions set in previous 
elements.

New FTIRSpectrum Element
• A new element for setting the parameters of the FTIR spectrometer software and for setting the 

radial position of the Rheonaut module is now available.

All non-MultiWave Osc Elements
• On the Parameters page of the editors of these elements the new Low torque option can now be 

activated. When this option is active the torque resolution at very low torques (< 100 nNm) is 
improved even further (the maximum torque is currently limited to 3 Ncm when this option is 
active). This option is available for the MARS III only.

Rot Time, Rot Stat. Flow Curve and Osc Time Elements
• These elements can now communicate with the Bruker Opus FTIR software in order to 

simultaneously measure rheological data and FTIR spectra.

Osc Temperature Ramp Element
• The FastOsc option (MARS III only) is now also available in the Osc temperature ramp element.
• Under certain circumstances this element would not continue due to very rare data format 

problems. This has been solved.

Osc Time Element
• Due to a problem with the data transfer from a Rheometer to RheoWin this element could crash 

under certain circumstances. This has been solved for all rheometers.

All MultiWave Elements
• The display of the torque and angle "sine-wave" (raw-data) was not correct. This has been solved.
• The multi-wave raw-data is now saved in the same format (*.rwr) as the normal oscillation data.

MultiWave Temperature Ramp Element
• Due to a problem with the data transfer from a Rheometer to RheoWin this element could crash 

under certain circumstances. This has been solved for all rheometers which offer the MultiWave 
functionality.

Curve-Fit Element
• Some potential causes for crashes (division bei zero) have been eliminated.

Note  For the Low torque mode to work MARS III firmware version 50.09.00x or newer are 
needed.

Note  The full effect of the Low torque improvements is only achieved with instruments which 
were delivered with firmware versions 50.09.00x or newer from the factory.

Note  currently *.rwr files containing multiwave data can not be loaded in the *.RWR Viewer, 
we are working on a solution.
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DataManager

Import of CaBER ASCII data
• When a *.cbr CaBER ASCII data file contains normal force data, this data is now imported also.
• A corresponding graph template is now part of the installation.

*.RWR Viewer

Sine wave data export
• Using the new command Export current datapoint sine wave data and Export all datapoints sine 

wave data in the File menu, the sine wave data of one selected rheological data point or the sine 
wave data of all rheological data point can be exported to a separate ASCII file for each rheological 
data point.

Version 4.30.0001
(Released 15.02.2011)

Below is a list of things that are new and/or changed in version 4.30.0001 compared with version 
4.30.0000 of RheoWin.

DeviceManager 

Driver for MARS III
• The timing for the trigger signal in FastOsc mode was improved and is more accurate now.
• The data acquisition routines have been improved. When using very high data aquisition rates the 

data display in RheoWin lagged under certain circumstances. This has been solved.
• In FastOsc mode and Rot mode (but not yet in normal Osc mode!) the trigger function can now 

provide a level signal or a pulsed signal.
• The Trigger mode can be set on the Options page of the Properties of MARS III dialog in the 

RheoWin Devicemanager.

Driver for the Viscotester D
• Some bugs in the driver for the Viscotester D have been removed.

Driver for the Rheonaut module
• The Rheonaut module driver now also works in Remote mode.

In the device editor the Temperature Alarm settings have been disabled until further notice.
• The axial positioning control has been optimized.
• In the Diagnosis dialog there now is a button for finding the zero point of the axial positioning.

MSC for measuring geometries
• When exporting the MSC table of a measuring geometry to a *.msc file, the selected path was 

ignored. This has been solved.
• Optimizing the MSC table of measuring geometry by running the MSC routine a 2nd time using 

the Test of calibration option did not have any effect on the MSC table. This has been solved (for 
the instruments that support this function).

JobManager

Graph display settings
• When a job was loaded which was created using an older RheoWin version which did not yet 

support the Master-Layout option, a manually defined graph definition was overwritten. This has 
been modified, the graph definition is now retained.
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Version 4.30.0002
(Released 01.03.2011)

Below is a list of things that are new and/or changed in version 4.30.0002 compared with version 
4.30.0001 of RheoWin.

DeviceManager 

Driver for MARS III
• The handling of certain error messages coming from the instrument was not correct. This has been 

solved.
• Under certain circumstances (for example after a lift-element) time values generated by an 

oscillation element were wrong. This has been solved.

Driver for MTMC (MARS III internal temperature controller)
• The handling of certain error messages coming from the instrument (error 34 amongst others) was 

not correct. This has been solved.

Driver for SC AC and PC circulators
• The temperature offset value defined for these circulators were not used when sending a 

set-temperature value to the circulator. This has been solved.
• Please note: As is the case with all other circulators that can be controlled by RheoWin the offset 

value is added to set-value, this means that on the circulator display the user will see the 
"modified" set value and the not the set value itself.
An example: When the set temperature value in RheoWin is 20.0 °C and the offset value at that 
temperature 0.1 °C, the user will see 20.1 °C as the set value on the circulator display.

JobManager

Axial ramp element
• When the start value of an axial ramp was set as "current gap" (i.e. not  as a predefined gap value) 

and the ramp speed was defined as the set parameter (instead of the ramp duration), the set speed 
was ignored and the ramp duration was used instead. This has been solved.

Version 4.30.0004
(Released 14.03.2011)

Below is a list of things that are new and/or changed in version 4.30.0004 compared with version 
4.30.0002 of RheoWin.

DeviceManager

Driver for RS150
• The inertia determination in RheoWin 4.30.000x did not work. This has been solved.

Driver for RS300, RS600, RS3000
• The drivers for these instruments now recognize whether the lift is in a position where only 

manual movement is allowed (for security reasons).
• Please note: The user will only notice this when the latest firmware is used.

JobManager

End element
• The error handling at the end of a job has been improved.
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DataManager

Use layout from file
• The implementation of the Layout out of file when loading option on the General page of the 

Preferences dialog (in the Configuration menu) has been optimized. When data which is saved by 
a Job using the Last segment only option (of the Segments page of the Save data file element 
dialog) is loaded in DataManager, the last layout defined before that segment will now be used 
(instead of the last layout defined in the job).

Reports

Report printout
• Under certain circumstances the graph in a report was printed using a very low resolution. This has 

been solved.

Version 4.30.0005
(Released 28.03.2011)

Below is a list of things that are new and/or changed in version 4.30.0005 compared with version 
4.30.0004 of RheoWin.

Installation

New option FTIR spectroscopy (Rheonaut)
• In order to be able to use the Rheonaut module and a FTIR spectrometer in combination with a 

MARS II oder MARS III the new FTIR Spectroscopy tool option (order no. 098-5061) must be 
installed.

• This option is automatically installed when using the installation key 098-5019 for all instruments 
(this key is for Thermo internal use only).

DeviceManager

Driver for MARS III and Simulator
• Under certain circumstances the type of a selected auxiliary device was not detected correctly. This 

has been solved.

Version 4.30.0007
(Released 18.04.2011)

Below is a list of things that are new and/or changed in version 4.30.0007 compared with version 
4.30.0005 of RheoWin.

DeviceManager

Driver for Rheonaut
• The status information in the manual control dialog and the diagnosis dialog has been extended.

Driver for IR Spectrometer
• RheoWin can now also communicate with the Thermo Scientific Nicolet Omnic software which 

comes with Thermo Scientific Nicolet FTIR spectrometers.
• The spectrometer software is automatically started as soon as the MARS driver communicates with 

the MARS instrument. This means that when the RheoWin device toolbar is active when 
RheoWin starts up, the spectrometer software will be started also. When the device toolbar is not 
active the spectrometer software will be started when a Job is started, the manual control window is 
opened or when the diagnosis window is opened.
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JobManager

Device Toolbar
• When a communication problem between the device toolbar and the rheometer occurs the device 

toolbar will be now be closed automatically. This prevents problems with the subsequent start of a 
Job or the manual control window.

Manual control window
• The radial positioning of the Rheonaut module can be controlled manually from the manual 

control window by clicking on the FTIR icon in the lower right corner of that window.

FTIR spectrum element
• The part of the element dialog which allows the user to set the radial position of the Rheonaut 

module has been improved. The radial position can be defined relative to the rim of the measuring 
geometry selected for the Job or relative to the center of the of the measuring geometry.

• Alternatively the user can now select that a manual control window for setting the radial position 
of the Rheonaut module will be shown during Job run.

Version 4.30.0008
(Released 20.04.2011)

Below is a list of things that are new and/or changed in version 4.30.0008 compared with version 
4.30.0007 of RheoWin.

DeviceManager 

Drivers for RT20, RS75, RS80 and RS150
• A time-out in the communication with Remote connected devices (e.g. circulators) was not 

handled correctly. This has been solved.

JobManager

Device Toolbar
• In version 4.30.0007 the Device Toolbar closed automatically directly after it was opened when 

the correct default temperature control unit was selected . This has been solved.

Version 4.30.0009
(Released 02.05.2011)

Below is a list of things that are new and/or changed in version 4.30.0009 compared with version 
4.30.0008 of RheoWin.

Note  RheoWin will never close the spectrometer software.

Note  In order for RheoWin to be able to control the Rheonaut module the Rheonaut module 
controller must be set to Remote control (this is done on the front panel of the controller).

Note  In order for RheoWin to be able to control the Rheonaut module the Rheonaut module 
controller must be set to Remote control (this is done on the front panel of the controller).
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DeviceManager

Driver for Rheonaut module
• Some bugs regarding the radial positioning of the Rheonaut module have been solved.

JobManager

FTIR spectrum element
• Some cosmetical changes have been made in the element dialog.

Version 4.30.0010
(Released 12.05.2011)

Below is a list of things that are new and/or changed in version 4.30.0010 compared with version 
4.30.0009 of RheoWin.

DeviceManager 

Driver for FTIR spectrometer
• The automatically generated names for the spectra data files were not correct on a PC with an 

english version of the Windows operating system. This has been solved.

Driver for RS300, RS600, RS3000, RS6000
• The T_Pt100 temperature signal was not measured correctly. This has been solved.

JobManager

Yield-Stress Evaluation element
• By adding the line 

[SPECIAL]
YieldStressCheckEndSlope=on

to the elements.ini file, the automatic algorithm will work better with data which has a sharp bend 
near the end of the curve. Normally this feature is not needed

Version 4.30.0011
(Released 30.06.2011)

Below is a list of things that are new and/or changed in version 4.30.0011 compared with version 
4.30.0010 of RheoWin.

Installation

Driver for the Viscotester D and Viscotester E
• The installation program did not use the correct key numbers for the Viscotester D and Viscotester 

E. This has been solved.

DeviceManager 

Driver for RS6000
• Some modifications were made in the lift control. These modifications only have effect when using 

firmware version 03.01.000 or newer.
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Driver for cameras (MARS II, MARS III and simulator only)
• RheoWin is now compatible with the following Foculus cameras from the company NET GmbH 

(http://www.net-gmbh.com):
Foculus 323TB (monochrome camera)
Foculus 323TC (colour camera)
Foculus 432TB (monochrome camera, upto 1280x960 pixel resolution only, i.e. the max.
camera resolution of 1388x1044 is NOT supported)

• The format of the saved TIFF images has been (slightly) modified and should now be compatible 
with all graphic software.

Version 4.30.0012
(Released 08.08.2011)

Below is a list of things that are new and/or changed in version 4.30.0012 compared with version 
4.30.0011 of RheoWin.

Installation & DeviceManager

Driver for the SC and AC circulators
• Due to the fact that the new PC xxx circulators are not compatible with the driver for the SC and 

AC circulators, the PC circulator is not listed anymore.

Language file
• In the Japanese language column the text for the element names was not correct. This has been 

corrected.

JobManager

Lift element
• ThermoGap can now also be activated for the Standby position. When ThermoGap is activated 

for the Standby position moving to that position maybe slower and the position will be set without 
any tolerance.

FTIR spectrum element
• The radial position of the Rheonaut module was not always stored correctly in the data files. This 

has been solved.

Axial ramp element
• When an axial ramp element in which the lift speed is used as the set variable was copied, the lift 

speed value was not copied. This has been solved.

Version 4.30.0013
(Released 19.08.2011)

Below is a list of things that are new and/or changed in version 4.30.0013 compared with version 
4.30.0012 of RheoWin.

DeviceManager

Driver for MARS III, MARS II, RS6000, RS3000, RS600, RS300, RS1, RO1
• In certain situations the current gap value of the rheometer was not transfered correctly from the 

driver to the measurement elements. This could lead to spurious effects in the set shear rate value 
and deformation values. This has been solved.

Note  RheoWin currently does not support the PCxxx circulators.
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Driver for Rheonaut module
• Running temperature ramps did not work with the Rheonaut module. This has been solved.

Version 4.30.0014
(Released 21.09.2011)

Below is a list of things that are new and/or changed in version 4.30.0014 compared with version 
4.30.0013 of RheoWin.

DeviceManager 

Driver for RS6000, RS3000, RS600, RS300, RS1, RO1, RV1
• In version 4.30.0013 the value of the geometry gap was not displayed correctly in the information 

window. This error was only in the displayed value in the information window, i.e. the measured 
data as well as the gap value in the data are ok! This has been solved.

• In certain situations using the log distribution in the ROT Ramp element would lead to spurious 
communication problems. This has been solved.

Version 4.30.0015
(Released 10.11.2011)

Below is a list of things that are new and/or changed in version 4.30.0015 compared with version 
4.30.0014 of RheoWin.

DeviceManager

Driver for SCxxx and AC xxx circulators
• The driver for the SCxxx and ACxxx circulators is now compatible with both the old style 

firmware (version numbers 1.10x) and the new style firmware (version number 095441.2B or 
newer).

Driver for MTMC (MARS III integrated temperature controller)
• RheoWin reported an error when trying to download the MTMC temperature offset values when 

a TM-LI-C or TM-LI-P was connected to the MARS (MTMC). This has been solved. RheoWin 
now reports that for these two modules temperature offset value are not available. Explanation: All 
TM-xx-x temperature offset values are write (set) offset values, since the TM-LI-C and TM-LI-P 
are passive modules, the actual temperature control is performed by a circulator, so there are no 
write (set) offset values for the TM-LI-x.

Reports
• A small change was made in the information transfer between RheoWin and the List&Label report 

tool.

Version 4.30.0016
(Released 29.03.2012)

Below is a list of things that are new and/or changed in version 4.30.0016 compared with version 
4.30.0015 of RheoWin.

Note  Circulator firmware version 095441.2A is NOT compatible with RheoWin. When this 
firmware is detected by RheoWin a message will inform the user to update the firmware. 
Updating the circulator firmware should be done by qualified personal only.
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DeviceManager 

Driver for MARS III
• The lowest frequency which can be used for the FastOsc mode is now 1e-5 Hz.
• The MARS III firmware has been modified in such a way that the lift can now always be operated 

from RheoWin or the instrument front panel by clicking a lift control button or a single button on 
the instrument front panel. This means that the lift message Manual movement only will not 
popup anymore when the lift is in a "safety range". This increase in control comfort has been 
realized by reducing the lift speed under certain special circumstances, for example in the case of a 
MARS III with a mounted CTC while using a TM-xx-x module.

• This new firmware also solves some other very special lift issues.

JobManager

Lift element
• The maximum value for the Standby position is now 120 mm.

Axial ramp element
• When defining the Current gap as the start value for a ramp, the resulting End gap can get a 

negative value during run-time. Since the Rheometer firmware does not accept negative gap values 
this would lead to unexpected behaviour. This has been solved, when the final gap value will be 
negative an error message will now popup during Job run to inform the operator.

Curve-Fit Element
• The data segment selection as part of Job definition has been optimized.

Version 4.30.0020
(Released 24.05.2012)

Below is a list of things that are new and/or changed in version 4.30.0020 compared with version 
4.30.0016 of RheoWin.

JobManager

ThermoGap
• It was possbile to activate the ThermoGap function during a Job run by opening the Manual 

Control window in a 2nd Job-Editor. Since this can have an undesired impact on the running Job, 
this possibility has been disabled.

DeviceManager 

Measuring geometries
• The default values of the torque correction values are now all set to 0.0
• The PZ DG 38 Ti geometry (double gap for pressure cell) has been added.

Driver for MARS III
• When the option Prompt message when finished on the Parameters page of the Axial page of the 

Lift Element was activated the message was NOT displayed during the Job run and the Job would 
not continue at this point. This has been solved.

Note  The following MARS III firmware versions are needed for this to take effect.
µP1 (RC-Box microcontroller) 50.13.000
µP2 (RC-Box DSP) 50.12.000
µP3 (M-BoxTC microcontroller) 50.13.000
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Driver for F/N 6/8 circulators
• Under certain circumstances the temperature values read from a F/N 6/8 circulator were not 

correct. This has been solved.

Reports

Display of Thixotropy element results
• In RheoWin version 4.30.0016 and 4.30.0015 the results of the Thixotropy analysis routine were 

not correctly displayed in a report. This has been solved.

Version 4.30.0021
(Released 26.06.2012)

• Below is a list of things that are new and/or changed in version 4.30.0021 compared with version 
4.30.0020 of RheoWin.

JobManager

Lift-Element
• Moving to Trim Position did not work properly with RV1, RS1 and RO1. This has been solved.

DataManager

Graph layout dialog
• There was a problem on the Segments page of the Data page of the Graph layout dialog. The 

segment selection was mixed up after switching to another page and back. This has been solved.

Version 4.30.0022
(Released 24.08.2012)

Below is a list of things that are new and/or changed in version 4.30.0022 compared with version 
4.30.0021 of RheoWin.

DeviceManager

Driver for Rheonaut
• Some smaller modifications and bug-fixes were made in the Rheonaut driver.

JobManager

ROT and OSC temperature ramp elements
• These elements can now communicate with the FTIR software in order to simultaneously measure 

rheological data and FTIR spectra.

Data Export element
• Exported ASCII files now do not contain empty lines at the end of the file anymore.

DataManager

Graph function
• The positioning of text on a graph has been improved. 

Version 4.30.0023
(Released 11.10.2012)
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Below is a list of things that are new and/or changed in version 4.30.0023 compared with version 
4.30.0022 of RheoWin.

DeviceManager 

Driver for MARS III
• New functionality for the new separate trigger box has been implemented.

Driver for MTMC
• Under certain circumstances the set temperature value was not correctly send to the MTMC. This 

has been solved.

Driver for RS6000
• The MSC calibration routine is now identical to that of the MARS III. That means that the MSC 

calibration can now be performed using one of 3 quality levels. The results of a Test of Calibration 
run are now used to optimize the MSC calibration. A a result the low torque performance of the 
RS6000 can be improved.

Driver for Rheonaut module
• The temperature limits of the Rheonaut modules have been changed to 0 °C - 120 °C for the 

Peltier version and 20 °C - 400 °C for the electrical version.

JobManager

Identifikation element
• This element now "remembers" the text entries for the Substance Name and Sample No. These 

entries can be selected from the edit fields drop down lists.

Set element
• New functionality for the new separate trigger box has been implemented.

Version 4.30.0024
(Released 12.11.2012)

Below is a list of things that are new and/or changed in version 4.30.0024 compared with version 
4.30.0023 of RheoWin.

DeviceManager

Driver for RS600
• A compatibility issue with the MSC table in an older firmware version was solved.

JobManager

End of job
• Under certain special circumstances a job could "hang" at the end of the job after saving the data. 

This has been solved.

Monitor window
• After a time-out error message the monitor window could not be closed. This has been solved.

Curve fit element
• There was a problem with the Arrhenius_TTS_Lin curve-fit model. This has been solved.

Version 4.30.0025
(Released 30.11.2012)
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Below is a list of things that are new and/or changed in version 4.30.0025 compared with version 
4.30.0024 of RheoWin.

JobManager

Monitor window
• The bug fixing in version 4.30.0024 introduced a new problem. This has been solved.

Version 4.4x.00xx

Version 4.40.0003 
(Released 25.01.2013)

Below is a list of things that are new and/or changed in version 4.40.0003 compared with version 
4.30.0025 of RheoWin.

Installation

Upgrade installation or new installation
• The RheoWin installation program can now be run as an upgrade installation, that is without 

de-installing the previously installed version first, or as new installation. In the last case a 
previously installed version must be de-installed first.

Upgrade installation
• When the settings of the previous installation are to be used for the new installation, the 

installation should be run as an upgrade installation, that is without de-installing the previous 
version first.

New installation
• When the settings of the previous installation should not be used for the new installation, the 

installation should be run as a new installation, in this case a previous version must be de-installed 
first. When there is no previous version installed, the installation is of course automatically a new 
installation.

Entering installation key information
• Using copy and paste the complete key-code can you now be entered into the key dialog in one 

action by selecting the first edit field and pasting the key-code into that field. The 4 blocks of the 
key-code are then automatically entered into the corresponding edit field.

• The complete key information (name, serial number and code) can now also be entered by loading 
the *.txt key file using the Load Key button in the key dialog.

Note  The 'upgrade installation' method can only be used for an existing RheoWin 4.20.00xx 
or RheoWin 4.30.00xx installation.

Note  For older RheoWin versions (version 4.10.00xx and older) the 'Upgrade installation' 
method can not be used, that means that the 'New installation' method (see below) must be 
used, in this case the settings of the previous installation will not be available in the new 
installation.

Note  When deinstalling the previous version the settings of that version are deleted too and 
can not be retrieved.
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Installation program
• A new version of the Installshield program is now used for the installation.

General

New development tool
• A new version of the development tool (compiler) is now used for creating RheoWin. This will 

allow us to use modern Windows user interface controls, dialogs etc.in future versions. The new 
compiler solves some minor cosmetic problems in the previous versions that occured when 
running RheoWin under Windows Vista, Windows 7 or Windows 8.

DeviceManager

All devices
• In a new date/time data channel with the name t_clock the date and time for each data point is 

now saved. Currently this channel can only displayed in a table, that is not in a graph.

VTx measuring geometries
• The measuring geometries for the VTx are now split up into four Type categories named:

Spindle L, R (Disc, cylinder),                                 [Geometries: L1 to L4 and R1 to R7]
Spindle T (Bar, Helipath),                                       [Geometries: PA to PF]
Spindle TL, TR (Cylinder, Small Sample Adapter)     [Geometries: TL5 to TL7 and TR8 to TR11]
Spindle LCP (Cylinder, Low Viscosity Adapter)       [Geometries: LCP]
This in order to be able to display the matching geometry information only.

Plate and plate geometries
• The following plate and plate geometries have been added to the list of geometries: P8 Ti L, P10 

Ti L, P25 Ti L, P40 TI L, P50 Ti L.

CCxxDIN Ti geometries
• The values for the axial gap were not correct, this has been corrected. The correct values are: 

CC10 DIN Ti     2.113 mm
CC16 DIN Ti     3.318 mm
CC25 DIN Ti     5.300 mm

CC27DG Ti geometry
• The value for the sample volume was not correct, this has been corrected.

JobManager 

Device Toolbar
• The device toolbar now contains a small new control which opens the New Job default page of the 

Preferences dialog directly.

Note  The geometry types are not updated when the upgrade installation method is used

Note  The user can manually select the correct new Type for each geometry on the General 
page of the Properties of the geometry dialog in the RheoWin DeviceManager.

Note  These value are not updated when the upgrade installation method is used. The user can 
manually enter the correct Distance values on the Geometry page of the Properties of the 
geometry dialog in the RheoWin DeviceManager.

Note  This value is not updated when the upgrade installation method is used.
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Elements, Jobs and Templates explorer
• The Elements, Jobs and Template explorer is now based on the windows Panel Group Control 

instead of on the Page control for a more modern look.
• In previous RheoWin versions the complete file structure starting from the default Jobs and 

Templates directories was scanned for RheoWin Jobs and Template files at the startup of the 
program. When these default directories contained many files and/or were located on network 
directory, this scanning could take a rather long time. This has been solved, now only those 
directories of the file structure are scanned which are currently opened in the Job and Templates 
file explorer.

Load File Element
• After activating the line 

;LoadToFirstEvalHandleOnly = On
(remove the ; in front of the line)
in the [ELMLOAD] section of the element.ini file, the Load File Element can now be used to load 
multiple files (one after the other) in a looped Job which uses the GoTo-Element. An example Job 
is part of the RheoWin installation.

Lift Element
• When the Go to measurement postition option in the Measurement position group box is selected, 

the operator can now select the new Use current gap option (in the Lift Element dialog). When 
this option is selected for a lift element which is placed "in the middle" of a Job sequence, the lift 
will stay at the, at that time, current postion. This can be used to activate the Thermo Gap option 
at a certain point in a Job.

ROT Step Element (Stationary Flow Curve element)
• On the Options page of the element editor there is a new option Step duration + integration time 

in rev. When this option is activated the values for Step duration and Integration time on the 
Acquisition page of the Rotation page can be entered as a number of revolutions.
The value for the Step duration must be larger as the value for the Integration time, the two values 
can be set to 1.1 and 1.0 respectively for example.
The minimum step duration time and the minimum integration time are set to 10 s and 5 s per 
default. As a consequence for angular velocities above 6.0 rpm (6.0 rpm is 6revolution in 60 s, that 
is one revolution in 10 s) the step duration will always be 10 s and the integration time 5 s as long 
as these two minimum values are not modified.

• On the Options page of the element editor there is a new option Save raw data. This option is only 
available when the option Oscillation raw data on the Options page of the Properties of "....." 
dialog for the selected rheometer is activated. When the Save raw data option is activated an ASCII 
file with the extension *.rwr and the same name as the *.rwd data file will be saved. The *.rwr 
contains the time, angle, angular velocity and torque values measured during the duration of this 
element as well the rheological data for each data point.
The *.rwr file can be viewed with *.RWR Viewer.

• The option Show N1 has been moved to the Options page of the element editor.

Note  For normal use of the Load File Element this option must not be activated.

Note  Allowing a too short step duration will result in spurious measurement data.

Note  This new option is only available for CR mode, with the Fixed duration for each step 
option as well as the Integration time option selected (on the Acquisition page).
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OSC Frequency Sweep Element
• For the number of Freq/Decade (frequencies pro decade) the user can now can select the additional 

(higher) values 14, 19, 39, 49 and 99.

Creep Analyis Element
• In the new Numerical group box on the Layout page of the element editor the user can now select 

which numerical values will be included in the result information text.
• There are four new result values available: The maximum strain and compliance values as well as 

the non-recoverable strain and compliance values, both as absolute and as percentual values.
• The result values are now displayed using the currently selected units.

Graph / Table display

Display of t_clock channel in tables
• For the new t_clock date/time data channel the format in which the date/time is displayed in a 

table can be selected from the Format drop-down list on the Columns page of the Layout dialog.
• For the display of the data/time data several formats which include both the date and the time (like 

dd:mm:yyyy hh:mm:ss) as well as some formats which include the time only (hh:mm:ss) are 
available.

Display of t and t_seg channel in tables
• For the display of the measurement time channels t and t_seg several formats like hh:mm:ss can 

now be selected from the Format drop-down list on the Columns page of the Layout dialog.

Resizing a table column width
• After resizing the width of a column, the table would always scroll down to the end of the table 

instead of not scrolling at all. This has been solved.

DataManager

Data, Pages and Templates file explorer
• The Data, Pages and Template explorer is now based on the windows Panel Group Control instead 

of on the Page control for a more modern look.
• In previous RheoWin versions the complete file structure starting from the default Data, Pages and 

Templates directories was scanned for RheoWin data, pages and template files at the startup of the 
program. When these default directories contained many files and/or were located on network 
directory, this scanning could take a rather long time. This has been solved, now only those 
directories of the file structure are scanned which are currently opened in the Data, Pages and 
Templates file explorer.

*.RWR Viewer
• The *.rwr viewer can now load a *.rwr file saved by the ROT Step Element and display the data in 

a graph. 
• The graph can be zoomed by drawing up a (green) rectangle, starting with the upper left corner (!) 

of the rectangle, with the mouse (and while keeping the left mouse keypressed). After releasing the 
left mouse button the graph will zoom to the selected range.

• The graph scale can be restored by drawing up a (green) rectangle, starting with the lower right 
corner (!) of the rectangle, with the mouse (and while keeping the left mouse key pressed). After 
releasing the left mouse button the graph scaling will be restored.

• The graph can be panned (scrolled) by clicking (with the right mouse key) in the graph and 
moving the mouse while keeping the right mouse key pressed. This function is especially useful 
after having zoomed the graph first.
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RangeCalculator
• With the completely new RangeCalculator the user can comfortably display and check the 

theoretical measurement range of any (technically possible) combination of rheometer or 
viscometer plus measuring geometry.

• The measurement range can be displayed as a graph of the viscosity as a function of the shear-rate, 
as a graph of the shear-stress as a function of the shear-rate and as numerical values.

• By entering a value for the Viscosity in the Reference sample group box the (theoretically) useable 
range for this viscosity is displayed both graphically (a red line in the graphs) and numerically (red 
values).

• By clicking the Save as *.rwd button the calculated range values can be exported as a RheoWin 
*.rwd data file. The *.rwd file contains the data points used to create the two graphs mentioned 
above.

• By right clicking on any of the graphs, the graph can be printed (on the default printer), copied (to 
the windows clipboard) or saved (as an .emf image file).

• By right clicking on the the numerical information text, the text can be printed (on the default 
printer), copied (to the windows clipboard) or saved (as an .rtf text file).

• The RangeCalculator can be started in four different ways:
    1) From the JobEditor by clicking the icon in the upper left corner of the editor 
        window. In this case the rheometer and measuring geometry selected for the current 
        job are automatically used for the range calculation.
    2) From the DeviceManager by clicking the Range calculator button. In this case either 
        the selected rheometer or the selected measuring geometry in combination with the
        default rheometer is used for the range calculation.
    3) From the Programs menu in both JobManager and DataManager. In this case the 
        default rheometer and measuring geometry are used for the range calculation.
    4) Using the Windows Explorer and starting the program RHWRangeCalc.exe. In this 
        case the default rheometer and measuring geometry are used for the range 
        calculation.

Version 4.41.0000
(Released 02.08.2013)

Below is a list of things that are new and/or changed in version 4.41.0000 compared with version 
4.40.0003 of RheoWin.

Installation

Version 4.40.0003 bugs
• The installation program of version 4.40.0003 contained a few smaller bugs, which showed up 

under certain circumstances only. This has been solved.

Note  The calculated and displayed range is the theoretical measurement range which is defined 
by the torque and angular speed range of the rheometer and the geometry factors of the 
measuring geometry. The practically useable measurement range will, in many cases, be smaller 
due to all kind of limiting factors like gap setting accuracy, sample filling issues, sample 
properties.

Note  Currently the measurement range is only available for rotation mode, i.e. not for 
oscillation mode.
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DeviceManager

MARS II and MARS III
• Under certain circumstances during a Job-run (measurement) the Temperature Set Element would 

stop working an bring the Job to a halt when the Device Toolbar was active during the Job-run. 
This has been solved.

MARS III
• Under certain special circumstances the network scan function (for finding a MARS III connected 

to the PC), would bring up an unreadable error message (when no MARS III could be found). 
This has been solved.

MTMC (MARS III build-in temperature control unit)
• In the Offsets box on the Temperature page of the Properties of 'MTMC (MARSIII)' dialog the 

user can now select between the default Automatic and three User defined temperature offset 
tables.

• Please note: The following MARS III or UTMC firmware version or newer are needed for this to 
work.
MTMC (MARS III) : MBOXTC 50.13.121
UTMC : (FW is under construction)

• When the Automatic option is selected, the MTMC firmware will automatically use the correct 
temperature offset table for the TM-xx-x which is connected to the MARS III.
The table values, which are stored in the MTMC (MARS III) firmware for each TM-xx-x, will be 
displayed in the table after clicking the Load from instrument button. (This is identical to the 
functionality in previous RheoWin versions.)

• When one of the three User defined temperature offset tables is selected, the MTMC firmware will 
use that temperature offset table for any TM-xx-x which is connected to the MARS III. The three 
User defined temperature offset tables are stored in the MTMC (MARS III) firmware. The table 
values (of the currently selected User defined table) will be displayed in the table after clicking the 
Load from instrument button.

• The User defined temperature offset tables are designed to be used for TM-xx-x setups that are 
NOT automatically recognized by the firmware. One example of such a setup is the TMPxx 
adapter in combination with the TM-PE-C (Peltier Cylinder). For this setup the (standard) 
temperature offset table of the TM-PE-C (for concentric cylinder geometries) is not adequate.

• In order to be able to effectively use the User defined temperature offset tables a new (second) 
instance of the MTMC should be created in the list of devices in the RheoWin DeviceManager. 
After renaming this new instance to MTMC (TM-PE-C + TMPxx), for example, this new 
MTMC instance can be selected for and saved as part of a Job file. When this Job is then used, the 
User defined temperature offset table selected for the MTMC instance used for this Job, will 
automatically be used.

MARS III, MARS II, RS6000, RS3000, RS600, RS300, RS1 drivers
• The CD-AutoStrain control for the Frequency-Sweep element has been optimized (modified). 

Under certain circumstances the data of non-stationary sine-waves was used for calculating the 
rheological datapoint. This has been solved. Please note that as a result of this, the time needed to 
measure one data point maybe longer than with previous RheoWin versions, as a result the time 
needed to complete a Frequency-Sweep element may be longer than before, this may especially be 
the case when the Frequency-Sweep runs from a lower to a higher frequency.

Rheonaut, FTIR data-acquisition
• The control of the FTIR data-acquisition has been optimized. 
• By activating the new Send information option on the Options page of the Properties of 'FTIR 

Spectrometer' dialog (in the RheoWin DeviceManager) messages from the Omnic software are 
now displayed in the JobController status box.
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• When the Stop button in the Job-Controller is clicked a StopCollect command is now send to the 
Omnic software in order to allow for a controlled stop of the Job.

Driver for RS6000
• The driver for the RS6000 is now compatible with the updated version of the RS6000 (which is 

internally, see the diagnosis window, called RS6001).

Interfacial rheometry
• The inertia and compliance values for the DuNoüy ring geometry have been added.
• The calculated value for M-factor of the DuNouy was not correct. This has been solved.

Greisinger manometer drivers
• In previous RheoWin 4.40.00xx versions the driver for the Greisinger manometer did not work. 

This has been solved.

JobManager

Closing JobManager
• When the normal methods to close the JobManager do not work, the JobManager can now be 

closed by clicking with the right mouse key in the empty area of the standard toolbar (below the 
menu bar) while holding down the Ctrl + the Alt keys on the keyboard at the same time.

• Please note that under normal operation this new emergency stop method is not needed!

Closing/stopping a running Job
• A running Job can now be stopped by closing the Job-Editor window from which the Job was 

started. After clicking on the [ x ] button in the upper right window of the Job-Editor, a 
message-box with the text Job running! Close anyway will appear. When selecting Yes in the 
message-box and after saving the data, the running Job will be stopped and the Job windows 
closed.
When the Stop button in the Job-Controller does not react on a normal click on the button, a Job 
can now be stopped by clicking holding down the Ctrl + the Alt keys on the keyboard and clicking 
the Stop button at the same time.

• Please note that under normal operation these new emergency stop methods are not needed!

Identification / Notes Element
• On the Substance page of the element editor the stored entries for the Name and Sample no can 

now be deleted by right clicking (with the mouse keys) anywhere in the dialog (but not on any 
dialog text or edit field) and selecting the appropriate item from the popup menu.

Save Element
• In version 4.40.0003 the generation of an automatic file name (for a data file) according to certain 

rules did not work properly. This has been solved.

Camera Element
• The controls for the RheoScope module are now only displayed when the RheoScope module is 

actually connected to the MARS. When this is not the case, i.e. when a camera is used without the 
RheoScope module, these controls are not displayed.

All measurement Elements
• The RangeCalculator can now also be opened by right clicking (with the mouse keys) anywhere in 

an element editor dialog (but not on any dialog text or edit field) and selecting the Information 
item from the popup menu.
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ROT Time Element
• In the new In case of gap change box on the Options page of the element editor, the user can can 

now select between the new options Keep angular velocity constant and Keep shear rate constant.
When using a parallel plate measuring geometry, and with the option Keep shear rate constant 
active, the angular velocity will automatically be adapted, when the gap changes, in order to keep 
the shear constant. The default setting is Keep angular velocity constant, since this method was 
used in all previous RheoWin versions.

OSC Frequency Sweep element
• The CD-AutoStrain control for the Frequency-Sweep element has been optimized (modified). See 

above for more details.

MultiStep Element
• In the MultiStep Element upto 60 different steps can now be defined.

• Multiple steps can now be selected for Copy, Paste and Delete by using the left mouse key in 
combination with the Ctrl and Shift keys on the keyboard.

• With the new Copy and Paste buttons one or multiple steps can now be copied and pasted in to 
the list of steps at any position.

• With the Delete button multiple steps can now be deleted at the same time.
• With the new Copy last 2 steps and insert 9x button the last two steps are copied 

and inserted 9 times at the end of the list. This function is meant to be used for quickly creating a 
job for the so-called MSCR (Multiple Stress Creep Recovery) experiment which consists of 40 or 
60 steps in total.

• When clicking on the Duration and # data point step table headers a new dialog will open in 
which the duration and the number of data points for all even and all odd steps, or for all steps can 
be changed at the same time.

Axial Ramp Element
• When the value zero was entered in the h/t edit field on the Parameter page of the Axial page of 

the element editor, the editor would crash. This has been solved.

JobManager and DataManager

Viewing the new.doc and readme.doc documents
• The new.doc (that is this document) and the readme.doc documents can now be opened directly 

from within RheoWin using the Readme command in the Help menu.

Creep-Analyis Element
• The settings of the items in the Numerical group box on the Layout page of the element editor 

(which were introduced in version 4.40.0003) can now be saved by clicking the new Save button. 
The saved default settings are used in both the JobManager and the DataManager for every new 
Creep-Analysis calculation.

Cross-Over Element
• In the new Numerical group box on the Layout page of the element editor the user can now select 

which numerical values (G', G", f, etc.) will be included in the result information text.
• There are four new result values available: The complex viscosity (eta*) and the complex modulus 

(G*) as well as both viscosity values (eta' and eta").

Note  This is available for the MARS II and MARS III only.

Note  The following MARS II or MARS III firmware versions or newer are needed for this to 
work.
MARS II : CBOX 13.01.004 DSP 10.10.008
MARS III : RCBOX1 50.14.017 DSP 50.13.002
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• The result values are displayed using the currently selected units.
• The settings of the items in the Numerical group box can be saved by clicking the new Save 

button. The saved default settings are used in both the JobManager and the DataManager for 
every new Cross-Over calculation.

Curve-Fit Element
• In the new Numerical group box on the Layout page of the element editor the user can now 

configure the result information text:
The user can select whether the model name, the equation, the physical units of the calculated 
model parameters, the value of chi2, the value of the regression coefficient r and the physical units 
of the X- and Y- axis quantities should be displayed as part of the result text or not.

• For the display of the physical units of the calculated model parameters, the currently selected 
units are used (i.e. the same unit as used for the axis scaling).

• The settings of the items in the Numerical group box can be saved by clicking the new Save 
button. The saved default settings are used in both the JobManager and the DataManager for 
every new Curve-Fit calculation.

Curve Discussion Element
• Under certain circumstances this element would show error messages. This has been solved by a 

temporary bug fix.

Graph / Table display

Axis scaling
• Under certain circumstances the axis scaling routines would not work properly, under very special 

circumstances this could lead to RheoWin crashing. This has been solved.

Display of axis titles
• Under certain circumstances the position of the axis titles was not correct (i.e. not centered). This 

has been solved.
• Under certain circumstances vertical axis titles were unreadable when running under Windows 7. 

This has been solved.

Moving the legend
• When the legend was moved on the graph (using the mouse), the box indicating the size of the 

legend during the moving jumped to a slightly different position after releasing the mouse button. 
This has been solved.

Size of a table
• Under certain circumstances a table would not fill out its assigned space. This has been solved.

Display of t_clock channel in tables
• The time value in the t_clock channel was wrong by exactly two hours. This has been solved.

Version 4.41.0006
(Released 18.12.2013)

Below is a list of things that are new and/or changed in version 4.41.0006 compared with version 
4.41.0000 of RheoWin.

Installation

Installation key dialog
• Under certain circumstances the cursor would move by itself. This has been solved.
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DeviceManager

Simulator
• The reset time function in the simulator driver did not work correctly. This has been solved.

Measuring geometries

• In the editor for the measuring geometries some edit fields were too short. This has been solved.

MSC calibration
• There was a problem when saving the MSC values at the end of the MSC calibration. This has 

been solved.

Inertia, MSC and MTC calibration
• The animated status display graphic did not work correctly. This has been solved. 

JobManager

Screensaver
• During any Job in which FTIR spectra are collected the Windows Screensaver is now disabled.
• The Windows Screensaver can be manually disabled by clicking on the RheoWin JobManager's 

main-window status-bar with the right mouse key.

Manual control
• The manual control dialog has been optimized to prevent it from crashing/stop working.

JobController
• Under certain circumstances the error message "falsche Beschreiberklasse" would pop-up. This has 

been solved.

Export Element
• In the Element Editor the pathes for the Excel and PDF report templates were not set to the 

default RheoWin pathes. This has been solved.
• In the File select dialog that is opened when selecting a new template, the path to the currently 

selected template is set as the initial path.

All measuring Elements with a second raw data graph
• There was a scaling problem in the second graph (for the raw data). This has been solved.

Curve Fit Element
• Under certain circumstances a curve fit would crash. This has been solved by increasing the 

calculation accuracy.
• The Polynom and Tscheussner models have been optimized.

Curve Discussion Element
• Under certain circumstances a maxiumum would not be calculated correctly. This has been solved 

been increasing the calculation accuracy.

JobManager/DataManager

Saving camera images
• Under certain circumstances there were problems when saving LWF, TIFF or AVI files. This has 

been solved.

Graph / Table display

Table -> graph interaction during a measurement
• When a value in the table is entered/changed during a measurement (Job run or Manual control), 

the graphic display of the data will now be updated automatically accordingly.
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Layout / Save dialogs
• Layout and save dialogs are now always opened on top of all other dialog.
• Layout and save dialogs do not appear in the windows taskbar anymore.

Marker lines
• Under certain circumstances error messages would pop-up when marker lines were drawn. This 

has been solved.

Version 4.41.0019
(Released 16.04.2014)

Below is a list of things that are new and/or changed in version 4.41.0019 compared with version 
4.41.0006 of RheoWin.

Installation

Viscotester iQ
• The installation program now allows the installation of RheoWin for the new Viscotester iQ 

rheometer.

DeviceManager

Drivers for Viscotester iQ
• There are two new drivers for the new Viscotester iQ:

The VTiQ.dll driver for controlling the Viscotester iQ itself and
the VTiQT.dll driver for controlling the Viscotester iQ integrated electronics for the optional 
TM-PE-C (Peltier Cylinder) temperature control module.

Driver for RS3000
• The driver for the RS3000 is now compatible with the updated version of the RS3000 (which is 

internally, see the diagnosis window, called RS3001).

MSC calibration RS3000
• There was a problem when saving the MSC values at the end of the MSC calibration. This has 

been solved.

JobManager

JobController
• When a Job is canceled during the initialisation phase (before any data was acquired), the File Save 

dialog will not popup any more.

All measurement elements and the temperature set element
• The temperature set values are now checked against the allowed min/max temperature values at the 

start of Job (and not only during the editing of a Job). When the allowed min/max temperatures 
are exceeded a message will popup and the Job will be canceled.

ROT Ramp Element Editor
• When the edit field for the ramp duration was empty (during editing) the editor would crash. This 

has been solved.

All OSC Elements
• The logic for saving images in relation to the rheological data points of OSC elements has been 

changed.
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Graph / Table display

Layout dialog
• Under certain circumstances the Graph and the Table layout dialogs would cause crashes. This has 

been solved.

Saving a graph as a bitmap
• Under certain circumstances saving a graph as a bitmap file did not work. This has been solved.

Version 4.5x.00xx

Version 4.50.0003
(Released 24.07.2014)

Below is a list of things that are new and/or changed in version 4.50.0003 compared with version 
4.41.0019 of RheoWin.

Installation & RheoWin Startup window

Viscotester iQ
• The image of the Viscotester 550 in the installation routine dialogs and in the RheoWin startup 

window (splashscreen) has been replaced by that of the new Viscotester iQ.

DeviceManager

Driver for RheoScope 1
• There was a problem with the microscope's radial position and focus values. This has been solved.

Drivers for Viscotester iQ
• The driver for the Viscotester iQ is now compatible with the upcoming Viscotester iQ oscillation 

mode.

Driver for FOculus cameras
• RheoWin is now also compatible with the new FGControl software and drivers for the 

(RheoScope) FOculus 323TB and 323TC cameras.
• With the new FGControl software and drivers the FOculus cameras can now be used with 

RheoWin under the Windows 7 32-bit and 64-bit operating system.
• Please note: See the separate "HAAKE RheoWin - Camera driver installation" instructions on 

how to properly install the FGControl software and drivers for Windows 32-bit and 64-bit 
operating systems.

Driver for Sony camera
• In order for the Sony XCD-X710 camera to work with RheoWin a small update needs to be 

performed after installing RheoWin. The driver for the Sony camera is only compatible with 
Windows XP 32-bit.

• Please note: See the separate "HAAKE RheoWin - Camera driver installation" instructions on 
how to apply this update.

Many rheometer and temperature control device drivers
• The Apply button on the Temperature pages of the "Properties of ..." device dialog is now active 

when changes were made on these pages.
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JobManager

Device toolbar
• The device tool bar caused problems with the image acquisition (e.g. RheoScope module) when it 

was active during a Job (measurement). This has been solved.

Manual control / Monitor

• The button for the camera control in the Manual Control / Monitor window is now only active 
when the initialization process of the instrument is completely finished.

All measurement elements
• There is a new quantity or data channel t_meas in which the time measured starting from the start 

of the first measurement element is saved.
• There is a new quantity or data channel User defined in which the value of a special user defined 

quantity can be stored. This quantity can be given any symbol (or name) and any unit.

Show data window Element
• The Show data window element now has an new editor dialog in which the following settings can 

be made:
- Show large (green arrow) next button in JobController
When this option is activated a large button with a green arrow and the text Next on it is displayed 
in the JobController. After Clicking the next button the Job will continue with the next element.
- Deactivate time reset in device at job start
When this option is activated the time measured by the device (rheometer) will NOT be reset at 
the start of the Job. This option should only be activated when running several Jobs in parallel with 
one device. In that case the option must be activated for all Jobs apart from the Job that is started 
first.
- Deactivate communication with device at start of this element
When this option is activated the communication between RheoWin and the device (rheometer) is 
deactivated at the start of the element. This allows another Job to communicate with the device 
while this Job is pausing.
- Show edit field for User defined variable in JobController
When this option is activated an edit field for entering the value of the User defined variabele is 
displayed in the JobController.
- Reactivate communication with device at end of this element
When this option is activated the communication between RheoWin and the device (rheometer) is 
reactivated at the end of the element, that is after clicking the small or large (green arrow) Next 
button.

ROT Step Element (Stationary Flow Curve element)
• On the Options page of the element editor there is a new option Step duration + integration time 

as inverse of shear-rate. When this option is activated the values for the Step duration and the 
Integration time on the Acquisition page of the Rotation page are defined as a multiple value of the 
inverse value of the shear rate.
For example: At a shear of 0.1 1/s the step duration will be 10 s when the multiplication factor is 
set to 1.0 and 30 s when the multiplication factor is set to 3.

• Since the integration time is part of the step duration, the value for the Step duration must be 
larger than the value for the Integration time.

• When the resulting step duration and integration time values are smaller than the values defined or 
the minimum step duration time and the minimum integration time, these minimum values are 
used. 
For example: At a shear rate of 10 1/s the inverse value (which is 0.1 s) is smaller than the 
minimum step duration, therefore the step duration will be set to 1 s. 

• The default values for the minimum step duration time and the minimum integration time are set 
to 1 s and 0.5 s, which are also the smallest allowed values.
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Curve Discussion Element
• In the new Numerical box on the Layout page of the element editor the user can now select 

whether the value of the standard deviation (Std. dev. or SD) and/or the relative standard deviation 
(Rel. std. dev. or RSD) is to be displayed as part of the result of the calculation of the mean value.

• On the Curve discussion page of the element editor the user can now select the multiplication 
factor for the displayed value of the (relative) standard deviation.

• The calculated value of the (relative) standard deviation is displayed in the information box of a 
data page.

Interpolation Element
• Under certain very special circumstances the Interpolation Element would crash. This has been 

solved.

Graph / Table display

Entering/changing a value in a table
• When entering a value in a table and hitting the Enter key, the new or modfied value is now 

immediately displayed/updated in the corresponding graph. This is valid for both the JobManager 
(that is during a job run) and the DataManager.

RangeCalculator
• There was a problem showing the range for a Viscotester iQ measuring geometry that was 

automatically detected by the instrument and RheoWin. This has been solved.

Version 4.50.0010
(Released 27.10.2014)

Below is a list of things that are new and/or changed in version 4.50.0010 compared with version 
4.50.00003 of RheoWin.

Installation

MARS I
• The installation program now allows the installation of RheoWin for the new MARS I rheometer.
• The new Temperature calibration tool, accessible from the JobManager Programs menu, is now 

part of the installation. A special installation key is needed to install this tool.

DeviceManager

All drivers
• When running RheoWin in certain network configurations the message "Socket error while 

receiving", which had nothing to do with RheoWin or the communication with any device, could 
popup. This has been solved.

Note  Allowing for a too short step duration will result in spurious measurement data.

Note  This new option is only available for the CR mode, with the Fixed duration for each step 
option as well as the Integration time option selected (on the Acquisition page).
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Enabling/disabling LAN adapter for Connect Assist
• In order to prevent RheoWin from listening to LAN broadcast messages from the wrong 

rheometer, LAN adapters can now be enabled/disable in the Select Lan Adapter dialog. This dialog 
is accessible by right clicking on the large rheometer button in the DeviceManager and selecting 
the Select LAN adapter for Connect Assist command from the popup-menu.

Driver for MARS 1
• There is a new driver for the new MARS I.
• The MARS firmware updater now also supports the MARS I.

Drivers for Viscotester iQ
• The inertia determination has been disabled for the Viscotester iQ. When an inertia value is 

needed it is read from the geometry tag using Connect Assist.
• The Viscotester iQ firmware updater now also allows updating the Viscotester iQ user interface 

(i.e. languages and graphics, etc.). See the Viscotester iQ instruction manual for more information
• The new 48 mm concentric cylinder temperature module (TM-LI-C48) and the matching 

measuring geometries are now supported.

Drivers for Viscotester 550
• Under certain circumstances there was a problem with the gap value and the result M-factor for 

parallel plate geometries. This has been solved.

Drivers for communication with FTIR spectrometer
• When running in simulation mode the driver will now also generate file names with time stamps.

Driver for Foculus FO323TC and FO323TB cameras
• There was a problem with saving the images as part of the RheoWin *.rwd file for the FO323TC 

colour camera. This has been solved.
• The camera selection options (any) and (smart selection), on the Additional data page of the 

Properties of ... dialog (in DeviceManager) of the rheometer with which the camera can be used, 
currently do not work (this will be fixed in the next version of RheoWin).

JobManager

Information/Protocoll window
• The version number of the firmware for the 2nd microcontroller in the Viscotester iQ is now 

displayed also.

Stopping a Job
• On the General page of the Configuration - > Preferences dialog there is a new option Confirm 

stop job. When this option is activated the operator will be shown a yes/no dialog asking whether 
the job should be really stopped.

Camera Element
• Under certain circumstances loading and using saved camera setting did not work.This has been 

solved.

Set Element
• The checkboxes for resetting the normal force and for activating the nano-torque offset are now 

disabled/hidden for the Viscotester iQ.

Temperature Set Element
• The set normal force value was not displayed in the JobEditor and DataManager anymore. This 

has been solved.

Rotation Ramp Element
• Using the break criteria with a Viscostester iQ did not work properly. This has been solved.



2 What’s new
Version 4.5x.00xx

64 HAAKE RheoWin 4.95.0003 Readme Thermo Scientific

Rotation Stepped Ramp Element (Stationary Flow Curve Element)
• The timing of the data acquisition for fixed duration steps, when acquiring FTIR spectra 

simultaneously, has been corrected.

All Oscillation Elements
• The time-stamp (t_clock data channel) for FTIR spectra data has been corrected/optimized. The 

time stamp of a FTIR spectra data file and its corresponding value in the the t_clock data channel 
are now close to identical.

Automatic temperature calibration tool
• The new Temperature calibration tool, is now accessible from the JobManager Programs menu. 

With this new tool the temperature calibration of any temperature modules can be performed 
completely automatical. See the separate manual for a description of this tool.

Version 4.50.0011
(Released 03.11.2014)

Below is a list of things that are new and/or changed in version 4.50.0011 compared with version 
4.50.0010 of RheoWin.

DeviceManager

Driver for Viscotester iQ
• The driver is now compatible with the new gap setting routine, as introduced in firmware version 

1.03.000, for parallel plate and cone and plate geometries.
• The driver now supplies correct integration time values when the option Rotation > Acquisition > 

Use automatic integration time was selected in the editor of the Rotation time element.

Driver for Almemo devices (thermometer)
• The driver for the Ahlborn ALMEMO 2590 universal measuring instrument (and compatible 

units) now also works when the Almemo device is connect to the computer using the special 
Almemo USB cable and USB driver software.

Version 4.50.0012
(Released 13.11.2014)

Below is a list of things that are new and/or changed in version 4.50.0012 compared with version 
4.50.0011 of RheoWin.

General

Operating systems
• RheoWin version 4.50.0011 did not run under Windows XP, this has been solved.

DeviceManager

Geometries for Viscotester iQ
• In RheoWin version 4.50.0011 there was a problem with Connect Assist, the automatic geometry 

recognition, this has been solved.
• The name for the geometries CC27 DG/Ti and CC41 DG/Ti each contained a space character 

too many, which causes problems with Connect Assist. This has been solved.
• The cone and plate geometries C35 2°/Ti, C60 2°/Ti, C35 3°/Ti, C60 3°/Ti, C35 4°/Ti, C60 

4°/Ti have been added.
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Viscotester iQ firmware updater
• When the Viscotester iQ firmware update can not be launched from the DeviceManagers 

Properties of Viscotester iQ dialog, a message will now be displayed which tell the operator to run 
the VTiQUpdate.exe from the c:\Program Files\Thermo\RheoWin\Drivers directory.

MARS firmware updater
• In RheoWin version 4.50.0011 the MARS firmware updater did not work. This has been solved. 

Graph / Table display

Axis scaling
• The scaling of the X-Axis has been improved.

Version 4.50.0013
(Released 19.12.2014)

Below is a list of things that are new and/or changed in version 4.50.0013 compared with 
version 4.50.0012 of RheoWin.

DeviceManager

Temperature signal for Viscotester iQ
• When no TM-xx-x module or Pt100 sensor is connected to the Viscotester iQ the temperature 

value in RheoWin would show an arbitrary (very high) value. This has been solved.

MARS and camera (for RheoScope)
• Various bugs with the image acquisition during oscillation measurements have been solved.
• For the image type JPG and PNG can now be selected.
• The automatic exposure time function has been made quicker.

JobManager

JobExplorer list
• When using the Save as ... command to save a Job in a directroy with a larger number of files it 

could take a very long time to complete the action. This has been solved.
• When a folder icon is selected, there is a new command Edit all in the JobExplorer context popup 

menu. Selecting this command will open a dialog in which the Rheometer and/or Measuring 
geometry and/or Temperature controller for all Job files can be changes at the same time. This 
should be used with care!

All Oscillation Elements with a Viscotester iQ
• In the oscillation elements the CS and CD mode were named FastCS and FastCD in previous 

versions. This has been changed into CS and CD.

DataManager

Saving images
• Camera images can now additionally be saved in JPG, PNG and GIF format.

Version 4.50.0017
(Released 19.02.2015)

Below is a list of things that are new and/or changed in version 4.50.0017 compared with version 
4.50.0013 of RheoWin.
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DeviceManager

Viscotester iQ
• The service/calibration date is now only checked for firmware versions 01.04.020 and higher 

because it caused problems with earlier firmware versions.
• The temperature value displayed in the Device toolbar was not correct during oscillation 

measurements. This has been solved.

Image acquisition
• Under certain circumstances there were problems with the image acquisition routines when testing 

the camera before setting the camera properties in the DeviceManager. This has been solved.

JobManager

Snapshot
• There was a problem when running a Snapshot test. This has been solved.

Show data and wait Element
• In the Show data and wait element the communication with a temperature control unit is now 

deactivated also when the communication with the device is deactivated.

All OSC Elements
• Under certain circumstances the editors of these elements could crash. This has been solved.

Curvefit Element
• Under certain circumstances the parameter values displayed in the information window were not 

correct when the physical unit of the parameters were displayed together with the parameters. This 
has been solved.

• In the Numerical group box on the Layout page of the element editor there are three new entries Y 
value at X = with which the Y value of the curve-fit model can be calculated for three X values. The 
result is displayed in the information window.

Crossover Element
• The time t, the segment time t_seg and the temperature T are now available as QC criteria.

DataManager

Saving images
• Camera images can now additionally be saved as a video file in the WMV format by right clicking 

on the image area and selecting the Save as video command.

Version 4.6x.00xx

Version 4.60.0000
(Released 23.07.2015)

Below is a list of things that are new and/or changed in version 4.60.0000 compared with version 
4.50.0017 of RheoWin.

Installation

MARS 40 and MARS 60
• The installation program now allows the installation of RheoWin for the new MARS 40 and the 

new MARS 60 rheometer.
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Media files
• A set of new Media files (images, small videos, application notes, short instructions, etc.) is now 

part of the installation. These media files are used in the new Job example files and can of course be 
used in any other job as well.

• Among the media files are videos and images which show how to apply the sample, how to 
trim the sample, how to mount/dismount a measuring geometry etc.

• The media files are installed in the following default directory (that is parallel to the Jobs, Data, 
Page, Template and Report directories): 

C:\Users\Public\Documents\Thermo\RheoWin\Media.

Example and template files
• There is no possibility anymore to select which example and template files are to be installed.
• All example Job, Data and Page files as well all templates files are now always installed 

automatically.
• The set of example Job, Data and Page files has been completely renewed and extended.
• The Job example files are installed in the Job\# Examples directory and lower level sub-directories.
• The Data example files are installed in the Data\# Examples directory and lower level 

sub-directories.
• The Page example files are installed in the Page\# Examples directory and lower level 

sub-directories.

Spectra and MWD calculation tools
• Due to licence issues the Spectra and MWD calculation tools are NOT installed anymore when 

RheoWin is installed using the 098-5019 All instruments installatio key.
• In order to be able to install the new versions of the Spectra and MWD calculation tools new 

installation keys with new order numbers are needed. 
• The new Spectra calculation tool installation key order number is 098-5066.
• The new MWD calculation tool  installation key order number is 098-5067.

General
• The general look of both JobManager and DataManager has been modernized.

DeviceManager

MARS 40 and MARS 60 rheometers
• There are two new drivers for the new MARS 40 and MARS 60.
• The value of the air-pressure for the air-bearing is stored as part of the measured data.

VTiQ and all MARS rheometers
• There was a communication time-out problem when running multiple Jobs, with instruments 

using TCP/IP communication, at the same time. This has been solved.

Rheonaut module
• The Rheonaut module can now be used with the TM-EL-H electrically heated hood for an 

improved sample temperature control.

Note  It is strongly recommended to have a close look at the new example files.

Note  After modifying an example Job is should NOT be saved in the Job\# Examples directory 
or any lower level sub-directory of that directory, to prevent the modified Job from being 
deleted at the next update.
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• In order for this to work the following MARS firmware versions are needed: 
MARS 40 and MARS 60

µP1 (Box microcontroller)    version 50.17.000
µP2 (Box DSP)         version 50.17.000
µP3 (Stand microcontroller)  version 60.01.000

MARS I and MARS III
µP1 (Box microcontroller)     version 50.17.000
µP2 (Box DSP)          version 50.17.000
µP3 (Stand microcontroller)   version 50.21.000

SC-AC-PC circulators
• The temperature-offset table in the driver for these circulators can now be accessed by the 

TempOffset calibration program.

Almemo Multitemp
• The driver of this auxilliarily device now retrieves and saves the device serial number.

Connect Assist rotors (for MARS 40 and 60)
• The MSC calibration routine can (of course) also be used for Connect Assist rotors (when use with 

a MARS 40 or MARS 60). 
• The resulting MSC (torque-mapping) values for these rotors are stored in RheoWin (device.flp).

MSC calibration
• Under certain circumstances the MSC calibration did not work properly. This has been solved.

JobManager

Main menu toolbar icons
• The main toolbar icons have been modernized.

Job Elements list
• All Job Element icons have been modernized.
• The General and Measurement Job Elements are now divided up into subgroups.

Jobs and Templates file explorer
• The file explorer icons have been modernized.

Updating and adding example and template files
• Thermo Fisher Scientific will supply updates for the example and template file on a regular basis.
• These updates will be distributed in the form of ZIP files that can be downloaded from the 

RheoWin page on the www.rheowin.com website.
• The contents of such a ZIP file can be applied to an existing RheoWin installation using the new 

Update example and template files dialog accessible from the Help > Internet/Update > Update > 
Update example and template files menu.

• By using the Replace command the operator can install a new version of the complete set of Job, 
Data, and Page example files as well as all Media and Template files. By doing so all current files in 
the Jobs\# Examples, Data\# Examples and Page\# Example directories and lower level 
sub-directories will be deleted and replaced by new files and directories.

• By using the Add command the operator can add a single new example file or a few new example 
files including media files to the current set of example files. This command is meant to be used for 
supplying customers with specific examples on request.

Job-Editor
• The icons in the Job-Editor dialog have been modernized.

Note  This command will (of course) not delete file in other directories.
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• When the 21 CFR part 11 tools are installed, signature status information is now displayed in the 
new Job-Editor status bar.

• Both the Application information area and the Devices area can be collapsed/expanded regarding 
their height to have more space for the actual Job Element sequence.

• There is a new Application information area in the Job-Editor dialog with three button and a text 
field.

• The text field is designated to display a short (one-line) text describing the Job
• A click on the information i-button will show a window with is designated to display a long 

(multi-line) text describing the Job in more detail. The text description can be accompanied by an 
image or a video. (For more information on this see below in the Message Element paragraph.)

• A click on the PDF document button will open a PDF file that is linked to the Job. This 
functionality can be used to link a SOP document or an application note etc. directly to the Job for 
quick and easy access.

• A click on the Edit button will open a dialog in which the short and the long text can be edited, 
and file names for an image, video and PDF file name can be selected.

• When no long text is defined, the information button is not displayed. 
• When no document file name is specified, the PDF document button is not displayed.
• In the new example Job files that are part of the installation many examples for the use of the new 

Application information functionality can be found.

Message Element
• In the Message Element editor an image and video file can now be selected for display in the 

Message window during a Job run.
• During Job run either the image or the video can be displayed, that is not both at the same time.
• The image or video will be scaled to a maximum width of 400 pixels and a maximum height of 

300 pixels.
• It is recommend to only use images or videos that already have the maximum width and/or height.
• It is recommended to store the images and videos in the default Media directory, but any other 

directory can be used as well.
• It is important to understand that the image and/or video is not stored in the Job file, only the path 

to the image and/or video file is stored in the Job file.
• When the Message Element is only used to comment the Job Element sequence in the Job-Editor, 

the text behind the element icon is displayed in a grey colour.

Lift Element
• In the Message Element editor image and video files for each of the lift actions can now be selected 

for display in the Message window during a Job run. (For more information on this see above in 
the Message Element paragraph.)

• The Lift Element dialog can be collapsed/expanded regarding its width. When the dialog is 
collapsed the message edit areas are not visible. 

• Moving the lift to Standby position (after finding the zero point) is now an optional, integral part 
of the Zero point lift action.

• For the MARS 40 and MARS 60 there is a new option Eject rotor (if possible) in the Lift apart 
action. When this option is selected the rotor will automatically ejected from the drive motor shaft 
before the instrument head (lift) moves upward. For all concentric cylinder geometries this always 
possible. For cone and plate and parallel plate geometries this is only possible when the sample is 
not too low viscous. For most special, non standard, geometries this is not possible. The rheometer 
firmware automatically decides whether ejecting the rotor is possible or not.

OSC Temperature Ramp and OSC Temperature Step Elements
• In the editors of these elements there is a new page Extern on which the Trigger function can be 

activated. The Trigger functionality is the same as that in the OSC Time Curve Element.
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Curvefit Element
• Under certain circumstances there was a problem with the Herschel-Bulkley model. This has been 

solved.

DataManager

Main menu toolbar icons
• The main toolbar icons have been modernized.

Evaluation menu toolbar icons
• The evaluation toolbar icons have been modernized and enlarged.

Data, Pages and Templates file explorer
• The file explorer icons have been modernized.

Saving images
• DataManager would crash when saving an image, that was stored in the Lurawave format, as a 

Bitmap file. This has been solved.

Spectra calculation tool
• The Spectra calculation tool has been completely reprogrammed and now produces more accurate 

results.

MWD calculation tool
• The MWD calculation tool has been completely reprogrammed and now produces more accurate 

results.

Graph / Table display

Table
• The DataManager would crash when a file with a very long file name was loaded and the mouse 

pointer was moved over the table header. This has been solved.
• When a table was exported to an Excel file the degree sign in the header of a data column 

containing the phase angle. This has been solved.

Graph
• It was not posible change the filled/unfilled property of all curves of one data file at the same time. 

This has been solved.

RangeCalculator
• Some smaller bugs in the Range Calculator program have been solved.

Version 4.60.0001
(Released 31.07.2015)

Below is a list of things that are new and/or changed in version 4.60.0001 compared with version 
4.60.0000 of RheoWin.

DeviceManager

Connect Assist geometries for VTiQ, MARS 40 and MARS 60 rheometers
• The Torque correction page in the Properties of a geometry dialog can now also be used in the case 

of Connect Assist geometries.

Note  The new MWD calculation tool needs a spectrum, calculated by the new Spectra 
calculation tool, as input data. This means that the MWD calculation tool can not be used 
without the Spectra calculation tool.
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JobManager

Job-Editor
• In the measurement element editors the range value limits (for the shear rate, shear stress, etc.) are 

immediately updated when a Connect Assist geometry was detected.

DataManager

MWD calculation tools
• On the Substance page of the MWD dialog the edit field and table column for GN0 have been 

removed because the value for GN0 is calculated (and not needed as input).

Version 4.61.0000
(Released 27.11.2015)

Below is a list of things that are new and/or changed in version 4.61.0000 compared with version 
4.60.0001 of RheoWin.

Installation

Installation of example and template files
• Some of the example job files contained wrong pathes to media files. This has been solved.
• On some PC's the installation of the example and template files does not work and is quitted with 

an error message and a dialog box. In case this happens close the dialog box by clicking the Close 
button. The installation will then continue but the example and template files will not be installed. 
In this case the example files should be installed manually using the Help > Internet / Update > 
Update > Update example and template files command. See the What's new information of 
version 4.60.0000 for more information on this.

• The zip file (RheoWin_Example_Files.zip ) which contains all example and template files is now 
installed in the Thermo > RheoWin folder in the Windows Public documents folder.

ART service program

• The ART service program is now always installed but can only be used without needing to enter a 
password when the installation was performed using the General Key (098-5019). The ART 
service program is for use by qualified service engineers only!

DeviceManager

MARS 40 and MARS 60
• When running the inertia determination routine for the instrument alone (that is not for a 

geometry) the new inertia value was not saved correctly. This has been solved.
• With the newest firmware the lift control buttons and the eject button on the control panel (on 

the front of the instrument itself ) are now disabled during a measurement. These buttons were not 
enabled again at the end the of the inertia and MSC determination routines. This has been solved. 
An erroneous update message would appear when a Connect Assist Adapter was attached to the 
instruments drive motor shaft. This has been solved, the message is not displayed anymore.

MTMC and UTMC
• The maximum number of temperature offset values in a temperature offset table is now limited to 

9 since the firmware can not handle more.

Note  We are of course working on a solution for this problem.
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FTIR spectrometer
• In the drivers.ini file, the temporary directory in which the FTIR spectra data is saved can now be 

modified by adding an entry like:
[IRSPECTRO]

SpectraTempPath=C:\SpectraTemp\

• In the drivers.ini file, the use of DDE commands for use with the Omnic software can activated by 
adding the following entry:

[IRSPECTRO]

Raman=1

This is used for the commands CollectSample and CollectBackground.

SER tool with Connect Assist
• The SER tool with Connect Assist was not correctly handled and not entered in the list of 

geometries after it was recognized by the instrument. This has been solved.

Jobrun.exe

Launch Job from Windows destop or Windows explorer
• When running a Job from the Windows desktop or from the Windows explorer an error message 

would appear at the very end of the Job. This has been solved.

JobManager

RheoWizard
• The RheoWizard would produce a non-functional Job when selecting Chocolate from the List of 

subtances.This has been solved.

Lift control icons
• The Lift control icons in the Device toolbar and in the Manual control window are now different 

fo rheometers in which the table moves up/down compared with those rheometer where the 
measuring head moves up/down. 

New Fill Assist element 
• There is a new Fill Assist element which allows the use of the Fill Assist tool in a RheoWin job in 

combination with the Viscotester iQ. For more information on the Fill Assist tool see the HAAKE 
Viscotester iQ reference manual version 1.6 or higher.

Version 4.61.0003
(Released 04.02.2016)

Below is a list of things that are new and/or changed in version 4.61.0003 compared with version 
4.61.0000 of RheoWin.

DeviceManager

MARS I, MARS III, MARS 40 and MARS 60
• The lowest allowed value for the oscillation frequency is now 10-6 Hz.

Viscotester iQ
• The Diagnosis Save function will now write more information in the diagnosis file.

FTIR spectrometer
• Some smaller bugs were removed.

Note  The above path is just an example. The last character of the path string must be a "\".
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JobManager

Jobrun
• Under certain circumstances the Goto-Element would crash when the (Data) Autosave function 

was called. This has been solved.

Version 4.62.0000
(Released 12.04.2016)

Below is a list of things that are new and/or changed in version 4.62.0000 compared with version 
4.61.0003 of RheoWin.

Installation

Viscotester iQ Air
• The installation program now allows the installation of RheoWin for the new Viscotester iQ Air 

rheometer.

DeviceManager

Viscotester iQ Air rheometer

• There is a new driver VTiQAir.dll for the new Viscotester iQ Air. For the optional TM-xx-x 
temperature control modules the VTiQ Air uses the same driver as the 'normal' VTiQ, i.e. the 
VTiQT.dll driver.

MARS I, III, 40 and 60
• The inertia determination routine now uses CD Oscillation mode at two different (large) 

amplitudes to measure the moment of inertia.
• The available options in the Options box on the Options page of the Properties of 'MARS xx' 

editor are now sorted/ordered differently.
• There are two new options for the Oscillation mode in the Options box on the Options page of the 

Properties of 'MARS xx' editor:
Active compliance correction CD-OSC
Active inertia correction CS-OSC

These new options are activated by default.

Measuring Geometries
• The handling of the Solid clamp geometry was not correct for both the version with the classical 

conical coupling and the new Connect Assist version. This has been solved.

Note  When these corrections are activated the measurement results may (slightly) differ from 
those previously measured without these corrections. For situations where that is not desired 
these corrections can be deactivated.

Note  When the new firmware is not installed or the options are deactivated, the firmware will 
use the passive compliance correction and passive inertia correction which were standard until 
now.

Note  New MARS firmware versions are needed for these options to work. 
The µP1 microcontroller firmware version must be 50.19.001 or higher.
The µP2 DSP firmware version must be 50.17.165 or higher.
(check the www.rheowin.com/firmware.htm web-page for the availability of such firmware 
versions).
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Viscotester D and E drivers
• The Temperature offset tables were not used correctly. This has been solved.

JobManager

JobEditor
• The software handling of Connect Assist geometries (MARS 40, MARS 60 and VTiQ) has been 

modified. Instead of displaying one or more message windows a green or red status light is now 
displayed between the geometry name and the Connect Assist button in the JobEditor dialog.

• The Connect Assist functionality (MARS 40, MARS 60 and VTiQ) can now be completely 
disabled by selecting the option Use geometry defined in Job (disable Connect Assist) in the 
Connect Assist settings dialog.

Rotation Ramp elements
• Under certain circumstances the Take from previous options for the shear rate or shear stress set 

value did not work properly. This has been solved.

Version 4.62.0003
(Released 10.05.2016)

Below is a list of things that are new and/or changed in version 4.62.0003 compared with version 
4.62.0000 of RheoWin.

DeviceManager

Viscotester iQ (Air) rheometer
• The diagnosis window for these instruments has been modified.
• The automatic integration time (ROT Elements) functionality has been improved.

UTC drivers
• Since the UTC control box only works with a baudrate of 4800, the baudrates 9600 and 19200 

have been removed from the baudrate selection box.

JobManager

Device Toolbar
• The device toolbar is now automatically disabled when the automatic temperature calibration tool 

is running.

JobEditor
• The software handling of Connect Assist geometries (MARS 40, MARS 60 and VTiQ) has been 

further improved.
• Under certain circumstances an error message Hades Error 36 would popup at the start of a Job. 

This has been solved.

Axial Time element
• The axial strain value was not calculated correctly. This has been solved.
• The gap change values h and %h are now measured and stored, just as in the Axial Ramp 

element.

Note  The Connect Assist settings dialog is accessed by right clicking on the Measuring 
geometry drop-down list or on the Connect Assist button.

Note  For this to work with the VTiQ, firmware version V1 must 1.10.000 or higher.
For the VTiQ this is implemented from the start.
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Version 4.63.0000
(Released 20.07.2016)

Below is a list of things that are new and/or changed in version 4.63.0000 compared with version 
4.62.0003 of RheoWin.

DeviceManager

MARS 40 and 60 drivers
• The actual lift speed did not correspond to the lift speed values selected in the Lift Element. 
• This has been solved, the actual lift speed now corresponds to the selected value.
• Because the existing selectable lift speed values were relatively low, four new lift speed values (5, 10, 

20 and 50 mm/s) have been added.

Lift Element
• The lift speed control has been modified. The operator can now define a gap value above which 

the lift will move at it's maximum speed (this is a device dependent value) and below which the lift 
will either move with the selected speed value (Use Speed option) or the lift will apply a set normal 
force (Use Autotension option) to the sample.

• The gap at which the lift speed is changed is defined by the new When gap <= xxx.x mm value in 
the Lift Element editor.

Rot Temperature Ramp Element
• Data measured by a Job running internally in a VTiQ (Air) was not displayed correctly.This has 

been solved.

Rot Ramp Element
• Under (rare) circumstances the Rot Ramp element would hang or crash at the beginning or the 

end of the ramp. This has been solved.

Axial Time Element
• Under very special circumstances the element editor would crash because of a division by zero. 

This has been solved.

Yield-Stress Evaluation Element
• Under (very rare) circumstances the Yield-Stress value calculated during a Job run could be 

different (i.e. not correct) from the value calculated in DataManager. This has been solved.

Temperature Calibration Tool
• The (optional) temperature calibration tool program has been updated. Some smaller bugs have 

been fixed.

Version 4.63.0001
(Released 22.07.2016)

Note  New MARS firmware versions are needed for these options to work.
The P1 microcontroller firmware version must be 50.21.000 or higher.
The P2 DSP firmware version must be 50.19.000 or higher.
The P3 firmware version must be 61.02.000 or higher.
(check the www.rheowin.com/firmware.htm web-page for the availability of such firmware 
versions) JobManager

Note  The above is valid for all Rheometer models.
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Below is a list of things that are new and/or changed in version 4.63.0001 compared with version 
4.63.0000 of RheoWin.

JobManager

Curve discussion element
• The QC-result was not displayed correctly for the Mean value calculation. This has been solved.

Version 4.63.0002
(Released 18.08.2016)

Below is a list of things that are new and/or changed in version 4.63.0002 compared with version 
4.63.0001 of RheoWin.

DeviceManager

Imaging DLL for Camera/RheoScope
• In version 4.63.000x the camera did not work because the Imaging.dll that was automatically 

installed does not work with (the older) FGControl version 2.3.3.1 which was used until know.
• Starting from this version RheoWin (i.e. the Imaging.dll) works with FGControl version 2.6.0.2 

by default. This new FGControl version is available on the RheoWin CD and can also be 
downloaded from www.rheowin.com/rheowin46.htm. See the HAAKE RheoWin User Guide 
Camera installation version 2.3 on how to install the FGControl software.

• Users who do not want to use the new FGControl version 2.6.0.2, can manually install a version of 
the Imaging.dll which is compatible with FGControl 2.3.3.1. This imaging.dll (see the 
Imaging.dll for FGControl 2.3.3.1 directory in the zip file) is part of the 
rhw4630000_complete.zip file which can be downloaded from the RheoWin web-site. This file is 
also available on the RheoWin CD in RheoWin\Imaging.dll for FGControl 2.3.3.1 directory.

Version 4.63.0003
(Released 09.11.2016)

Below is a list of things that are new and/or changed in version 4.63.0003 compared with version 
4.63.0002 of RheoWin.

DeviceManager

MARS I and MARS III drivers
• The actual lift speed did not correspond to the lift speed values selected in the Lift Element.This 

has been solved, the actual lift speed now corresponds to the selected value. Because the existing 
selectable lift speed values were relatively low, four new lift speed values (5, 10, 20 and 50 mm/s) 
have been added.

Note  New MARS I / MARS III firmware versions are needed for this to work.
The µP1 Box microcontroller firmware version must be 50.23.000 or higher.
The µP2 Box DSP firmware version must be 50.18.000 or higher.
The µP3 Stand firmware version must be 50.25.000 or higher.
(check the www.rheowin.com/firmware.htm web-page for the availability of such firmware 
versions).
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JobManager

Axial Ramp Element (MARS I, III, 40, 60)
• The communication between the Axial-Ramp Element in RheoWin and the Axial-Ramp control 

in the firmware has been modified in order to optimize the Axial Ramp performance.

Version 4.63.0004
(Released 24.01.2017)

Below is a list of things that are new and/or changed in version 4.63.0004 compared with version 
4.63.0003 of RheoWin.

DeviceManager

Imaging DLL (RheoScope Module)
• The scale gauge that is displayed on top of an image acquired with the RheoScope module was 

slightly wrong. This has been corrected.

Version 4.7x.00xx

Version 4.70.0000
(Released 11.05.2017)

Below is a list of things that are new and/or changed in version 4.70.0000 compared with version 
4.63.0004 of RheoWin.

Note  New MARS I / MARS III firmware versions are needed for this to work.
The µP1 Box microcontroller firmware version must be 50.23.000 or higher.
The µP2 Box DSP firmware version must be 50.18.000 or higher.
The µP3 Stand firmware version must be 50.25.000 or higher.
(Check the www.rheowin.com/firmware.htm web-page for the availability of such firmware 
versions.)

Note  New MARS 40 / MARS 60 firmware versions are needed for this to work.
The µP1 Box microcontroller firmware version must be 50.23.000 or higher.
The µP2 Box DSP firmware version must be 50.19.000 or higher.
The µP3 Stand firmware version must be 61.03.000 or higher.
(Check the www.rheowin.com/firmware.htm web-page for the availability of such firmware 
versions.)

Note  This correction only applies to images acquired with RheoWin 4.63.0004 or newer, that 
is NOT to images acquired as part of measurements made with earlier RheoWin versions.

Note  Due to the limited screen resolution of computer monitors the accuracy of the scale 
gauge is limited to values in the range of 1 µm.
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Installation

Font installation
• The Gebr. HAAKE GmbH (Font filename: ThermoRheo.ttf ) is not installed anymore. RheoWin 

now uses the default Windows system font. In Windows 7 and for most Western European 
languages, this is the Segoe UI font. In other Windows versions and/or for other languages the 
Windows system font may be different. As a consequence the greek symbols used for physical 
quantities look slightly different now compared with all previous RheoWin versions.

ConnectAssist geometries for MARS 40 and MARS 60
• Starting from this version all standard ConnectAssist geometries that are availalbe for the MARS 

40 and MARS 60 are installed and available in the list of geometries when installing RheoWin 
with a MARS 40, MARS 60 or general key. (In previous versions only the standard ConnectAssist 
geometries that are available for the VTiQ were installed and available.)

Supported rheometers, temperature control devices and circulators
• Drivers for the RS150, RS80, RS75, RheoScope 1 and RT20 rheometers are not part of the 

installation anymore. For these instruments RheoWin 4.63.0004 or earlier should be used.
• Drivers for the VT6L, VT6R, VT7L, VT7R as well as the VT7L-plus and VT7-R-plus 

viscometers are not part of the installation anymore. 
• For these instruments RheoWin 4.63.0004 or earlier should be used.
• Drivers for the TC80, TC81, TC500 and TC501 temperature controllers are not part of the 

installation anymore. For these instruments RheoWin 4.63.0004 or earlier should be used.
• Drivers for the F3C, F6/N6/F8/N8, DC30, DC50 and Phoenix circulator models are not part of 

the installation anymore. For these instruments RheoWin 4.63.0004 or earlier should be used.

General

Compatibility with previous RheoWin versions
• RheoWin 4.69.00xx can read all *.rwj, *.rwd, *.rwp etc. files created with any previous RheoWin 

version, but (as with all previous versions) files saved with this version can not be read with any 
previous version.

Languages
• The following languages have been updated and completed: Traditional Chinese, Simplified 

Chinese, Japanese, Polish, French and German.

New Unicode
• RheoWin is now a 100% Unicode program.
• All text in RheoWin is now in Unicode format, this means that text in any language can be mixed 

with text in any other language. A practical example is the use of greek characters for physicals 
quantities in combination with non-western-european languages (for example Chinese, Japanese, 
Korean, Polish, Russian, etc.)

• The text in the language.xls file is now in Unicode format.

Program "Splash screen" and Help > Info about screen
• The RheoWin start-up "Splash-screen" and the Help > Info about screen are completely new 

designed according to the latest Thermo Fisher Scientific brand guidelines.

Quantities / Units
• In previous RheoWin versions the quantities N1 and 1 were named normal force difference and 

normal force coefficient respectively. That was not correct. These quantities are now correctly 
named normal stress difference and normal stress coefficient respectively.

Restart message
• The message "Program not terminated correctly. It is recommended to restart your computer" is 

not displayed anymore at the next start after an unexpected closing of either JobManager or 
DataManager.
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Values of A- and M-factor
• The values of the A- and M-Factor are now displayed in the same format throughout the software.

Rheometer and auxillary drivers

Spectrometer (OMNIC)
• Under certain circumstances OMNIC would produce an error message stating that a spectrum file 

could not be saved. This would halt a RheoWin job (until the message box was closed). This has 
been solved.

DeviceManager

Inertia determination
• Under certain circumstances (for example for all vane geometries) the inertia value was not 

determined correctly. This has been solved.

JobManager

Element/Job/Template explorer
• The display of the Measurement elements in the Job Elements list was slightly "scrambled" when 

RheoWin was installed using a VTiQ installation key. This has been solved.

Job Controller
• When a Job is cancelled before any data is measured the Save data dialog is not displayed anymore 

and no *.rwd file is saved.
• In a Job in which a *.rwd file is loaded and in which no new data is measured, the data of the 

loaded *.rwd file is now displayed on the first (default) page of the table.

Job Editor
• When the option No data file is selected in the Filename > Save data file dialog, a *.rwdfile that is 

loaded in a Evaluation-only-Job (a Job in which no measurement is made) will not be saved at the 
end of the job anymore, even if changes were made in the *.rwd file.

• The properties of a Connect Assist adapter can now be modified (without removing the adapter 
entry from the list of geometries in the DeviceManager first) by right clicking on the Measuring 
geometry selection field in the Devices area of the JobEditor and then selecting Edit Connect 
Assist adapter properties from the popup menu.

• In the Connect Assist adapter properties dialog the operator can now select a geometry from a list 
of predefined geometries which matches the adapter type.

Message Element
• The message element can now display the result(s) of any evaluation element in combination with 

any other (user defined text) during a Job run.

Note  For this to work a modified version of the OMNIC_CI.dll is needed. This dll file must 
copied into the c:\Program files(x86)\omnic folder. In the file omnicsettings.ini in the c:\My 
Documents\omnic folder the following line must be added to the [Files] section: 
DisableSaveErrorMessage=1.

Note  The modified version of the OMNIC_CI.dll can be downloaded using the following 
link: www.rheowin.com/files/Omnic_CI_DLL_patch.zip. This file is for Omnic 9.7.xxx only.

Note  There is no patch available for older Omnic versions.
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• The result(s) can be displayed in two different ways:
a) The complete result text of an evaluation element, as shown in the information window, can be 
displayed.
b) Any individual result value and/or the QC result, calculated by the evaluation element can be 
displayed separately.

• In order to display the complete result text of any evalution element in the message window during 
a Job run, the string R_IDx_TXT, where x stands for the ID number of the evaluation element in 
the Job, can be placed anywhere in the Message edit field in the Element editor.

• In order to display the QC result of any evalution element in the message window during a Job 
run, the string R_IDx_QC, where x stands for the ID number of the evaluation element in the 
Job, can be placed anywhere in the Message edit field in the Element editor.

• In order to display any individual result value of any evalution element in the message window 
during a Job run, the string R_IDx_Py, or R_IDx_Py_z where x stands for the ID number of the 
evaluation element in the Job and y or y and z indicate the individual result value (depending on 
the element), can be placed anywhere in the Message edit field in the Element editor.

• Note that if y < 9 it MUST be written as 01, 02, etc. that is with a leading zero.
• Example Jobs explaining this in detail (for each evaluation element) are part of the RheoWin 

installation.

Lift Element
• Ejecting the rotor as part of a Job did not work reliably. This has been solved.

All Measurement Elements
• During a Job run any measurement element could (very rarely) display a Hades Error and 

inadvertently halt the Job at the same time. This has been solved.
• The element ID and the element repetition number (when using the Goto Element) are now saved 

for every data point as part of a *.rwd file and can be displayed in a table.

Axial Ramp Element
• The idle time between two axial ramp elements has been reduced from approximately 1.5 s to 

approximately 0.6 s.

ROT Ramp Element and ROT Ramp Temperature Element
• In contrast to all other measurement elements the data acquisition in these elements was such that 

the segment time value for the first data point was always (very close to) 0.0. This has been 
modified. The first data point is now acquired at a segment time value which corresponds to the 
time difference between the subsequent data points of the element.

OSC Frequency Sweep Element, OSC Amplitude Sweep and OSC Temperature Step Element
• These elements can now communicate with the FTIR software in order to simultaneously measure 

rheological data and FTIR spectra.

All Evaluation Elements
• The manual selection of a curve is now in the format [x-quantity ▼] = f ([y-quantity ▼]), where 

[x-quantity ▼] and [y-quantity ▼] stand for quantity selection drop down boxes.

New Linear Viscoelastic Range Evaluation Element
• With the completely new Linear Viscoelastic Range (LVR) evaluation element the end of the linear 

viscoelastic range can be automatically calculated from the G', G", |?*|, ? or tan(?) of an oscillation 
stress or strain sweep measurement with a user-defined tolerance value.

Note  In the SHRP element only the R_IDx_TXT result text is available.

Note  There were also some issues regarding this in the firmware. These are solved starting from 
firmware version V3: 61.04.0006 for the MARS 60 and MARS 40.
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• Optionally the criticial stress and/or strain as well as the G', G" crossover point can be calculated. 
The format of the graphical and numerical result can be configured on the Layout page of the 
element editor.

New Advanced Curve Discussion Evaluation Element
• With the completely new Advanced Curve Discussion evaluation element the following points in 

any y=f(x) data set (curve) can be automatically calculated:
1) The point on a curve where the slope has a certain (user defined) value.
2) The point on a curve where the relative slope has a certain (user defined) value.
3) The point on a curve where the y-value reaches a certain (user defined) percentage of a reference 
value. The reference value can be the first or the last point in the curve, or the minimum or 
maximum y-value on the curve.
4) The intercept point of two tangent lines drawn through two user defined x-ranges along the 
curve.

• The format of the graphical and numerical result can be configured on the Layout page of the 
element editor.

Curve Fit Evaluation Element
• There are three new curve fit models available

        Sisko                  τ=η∞ɣ +Kɣ ⁿ
        Sisko (Visc)         η=η∞+Kɣ n-1

        Slope y=f(log(x))   y=a+b log(x)

Crossover Evaluation Element
• On special request the Crossover element now also optionally calculates a "degree of crosslinking" 

(Vernetzungsgrad) value using the equation V = a+b*G'(at f=0,5 Hz). 
• This new option can be activated in the Specials area on the Layout page of the element editor.

DataManager

All analysis routines
• The dialog of an analysis routine is now automatically put in front of the graph after executing the 

analysis routine. This was not always the case in the past.

Data selection dialog
• The manual selection of a curve is now in the format [x-quantity ▼] = f ([y-quantity ▼]), where 

[x-quantity ▼] and [y-quantity ▼] stand for quantity selection drop down boxes.

New analysis routines
• The new Linear Viscoelastic Range (LVR) and new Advanced Curve Discussion analysis routines 

(see above) are available in DataManager as well.

Analysis routine toolbar
• In all previous RheoWin version not all analysis routine icons were displayed when the vertical 

height of the computer screen was below a certain value. This has been fixed, the toolbar will now 
display the icons in two columns when needed.

Camera image display
• Saving images as a video file (in *.avi and *.wmv format) did not work correctly. This has been 

solved.
• The scale bar in the upper right corner of the image can now be enabled/disabled by using the new 

option Show scale bar from the image context menu.
• The scale bar now contains intermediate scale tic marks.

Note  In contrast to the Sisko (Visc) model, which works very good on almost any matching 
data, the Sisko model does not always work very well. This is not caused by a bug in RheoWin 
but by the data itself.
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• In previous RheoWin versions the length of an object or region, etc. in an image could be 
measured by drawing a line (using the mouse) on the image. The numerical value of the length of 
the line (in µm) was displayed. As soon as the mouse button was released the line and numerical 
value would disappear. This functionality has been modfied/extended.

• After activating the new option Length measurement > Save measurements from the image context 
menu, the operator can now draw upto 10 length measurement lines in each image. 

• These length measurement lines are stored in the *.rwd data file (when the file is saved).
• When this new option is not activated the functionality is as in previous RheoWin versions.
• By selecting the command Length measurement > Delete measurements in current image all lines 

in the current image are deleted.
• By selecting the command Length measurement > Delete measurements in all images all lines in all 

images (of the *.rwd data file) are deleted.
• This new functionality can also be controlled by the four new buttons below the image.

Graph / Table display

Saving a graph
• A graph can now be saved as a *.png, *.jpg or *.tiff file also.
• A graph can not be saved as a *.dib file anymore.
• On (very) slow computers, when saving a graph as an image, the item text of the context menu 

that was selected was part of the image. This has been solved.

Saving data as text
• The data as displayed in a table can now be saved in either ASCII text format or in Unicode text 

format by selecting the corresponding Encoding option at the bottom of the Save as dialog.

Element ID in a table
• The element ID and the element repetition number of a data point can be displayed in a table by 

selecting the quantities Elm-ID and/or Elm-Rep. for display in a table column.

Range calculator

Reference point
• By entering a value for the shear rate or the shear stress or the angular velocity or the torque the 

other the values for the other three quantities can now be calculated based on the viscosity 
reference value.

• All four values are displayed numerically and the corresponding reference point is displayed in the 
viscosity = f (shear rate) graph.

• A value is displayed in red color when it is outside the instrument range.
• This new functionality can be switched off/on in the Settings dialog.

Unit selection
• The units for torque and angular velocity can now be modified by clicking on the unit text behind 

the respective value edit field.

Version 4.70.0002
(Released 07.06.2017)

Note  Once drawn the lines can not be modified anymore, nor deleted individually.

Note  The length measurement lines are not part of the images themselves, in order to export 
the image including one or more lines a screenshot tool must be used.
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Below is a list of things that are new and/or changed in version 4.70.0002 compared with version 
4.70.0000 of RheoWin.

Installation

Installation under Windows XP
• An attempt to install RheoWin 4.70.000x under Windows XP is now actively blocked and will 

leave the system unmodified.

Installation of new LVR Element
• The new LVR evaluation element was not installed correctly, as a consequence it was not visible in 

the list of elements in the JobManager. This has been solved.

Art service software
• The ART service software has been updated.

Rheometer and auxillary drivers

MARS I, II, III, 40 and 60
• There was a problem in combination with the ART service software. This has been solved.

RV1 and RS1
• During the lift zero point determination RheoWin could not be controlled. This has been solved.

JobManager

Temperature Set Element
• Under very rare circumstances the temperature set element would cause a Job to freeze. This has 

been solved.

Set Element
• Some texts in the element editor have been corrected.

Linear Viscoelastic Range Evaluation Element
• Some improvements in the calculation method have been implemented.

Version 4.70.0003
(Released 09.06.2017)

Below is a list of things that are new and/or changed in version 4.70.0003 compared with version 
4.70.0002 of RheoWin.

Rheometer and auxillary drivers

RV1, RS1
• The serial number was not displayed correctly in the info/protocol window. This has been solved.

All devices with serial communication (RS232)
• The selected COM-Port was not stored. This has been solved.

JobManager

Message Element
• The new functionality for displaying evaluation results did not work correctly. This has been 

solved.

Version 4.70.0005
(Released 12.06.2017)
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Below is a list of things that are new and/or changed in version 4.70.0005 compared with version 
4.70.0003 of RheoWin.

Installation

VTiQ with pressure cell stand
• For the VTiQ with pressure cell stand the driver for the UTMC can now be selected during the 

installation.

General

Languages
• The following languages have been updated and completed: English, German and French.

Rheometer and other drivers

Foculus camera driver
• In certain situation (for example in the Manual Control window) there were problems with the 

communication between the Foculus camera driver and RheoWin. This has been solved.

JobManager

Report Element
• The Title for report text and the Graph title text which can be entered in the element editor were 

not used in the report printout/preview/export. This has been solved.

Version 4.70.0006
(Released 25.07.2017)

Below is a list of things that are new and/or changed in version 4.70.0006 compared with version 
4.70.0005 of RheoWin.

Rheometer drivers

RV1, RS1, RS300, RS600, RS3000, RS6000
• Under certain circumstances internal Jobs were not correctly transfered to the instrument. This has 

been solved.

DataManager

Camera image display
• The scaling factor for (RheoScope) camera images can now be manually edited for each camera 

lens separately in the new Edit scaling factor dialog.
• The Edit scaling factor dialog can be accessed via the Length measurement > Edit scaling factor 

item in the image context popup menu.
• The scaling factor is calculated by entering the Target value and the Actual value and then clicking 

the Calculate button.
• By clicking the Apply button the new value is set for use in future measurements.
• By clicking the Reset button the default value can be retrieved.

Version 4.75.0000
(Released for testing 26.09.2017)

Below is a list of things that are new and/or changed in version 4.75.0000 compared with version 
4.70.0006 of RheoWin.
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Installation

Supported circulators
• Since RheoWin version 4.70.0000 drivers for legacy (older) circulators like the F3C, 

F6/N6/F8/N8, DC5, DC30, DC50 and Phoenix circulator models are not part of the installation 
anymore. After the launch of version 4.70.0000 we had requests for some of these drivers. As an 
intermediate solution we have decided to supply these drivers on special request. Please note that 
currently only some of these drivers are available immediately, others must be created and tested 
first.

General

Performance
• The internal structure and internal "communication" of the JobController and the 

Graph/Table/Info module have been redesigned for a better overall performance of the RheoWin 
software.

Compatibility with HAAKE PolySoft software
• The data files from the PolySoft software can now be loaded in RheoWin.

Device Manager

Geometries
• The A- and M-factors of recognized Connect Assist rotors were displayed with too many 

significant numbers. This has been solved.
• The A- and M-factors of all measuring geometries are now displayed with four significant digits 

throughout RheoWin.

Rheometer drivers

RV1, RS1, RS300, RS600, RS3000, RS6000
• Under certain circumstances internal Jobs were not correctly transfered from the instrument. This 

has been solved.

JobManager

JobEditor
• The list of predefined geometries for use with a Connect Assist adapter was displayed correctly. 

This has been solved.

JobController
• The Stop Job - Last set temperature dialog will now displayed on the center of the screen.

Crossover-Element
• The QC-criteria calculation did not work correctly when two or more crossover points were found 

in one dataset. This has been solved.

Datamanager

Layout from file
• The setting of the Layout from file option was ignored. This has been solved.

Camera image display
• The camera images can now be saved as part of an image file and copied to the windows clipboard 

including the length measurement lines and the scale bar when the option Length measurement > 
Show measurements from the image context menu is activated.

• The image is always saved and copied in the same size as it displayed in RheoWin.
• The lines are not saved as part of the image file when the *.lwf image format is choosen.
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• The lines are not saved as part of the image file when the commands Save all images or Save as 
Video are used.

• The lines are not printed when the Print command is used.

RWR Viewer

Rheological data graph
• In some cases this graph did not show the desired data. This has been solved. (Please note: this bug 

fix can not and does not solve problems with existing *.rwr files.)

Version 4.75.0001
(Released for testing 16.10.2017)

Below is a list of things that are new and/or changed in version 4.75.0001 compared with version 
4.75.0000 of RheoWin.

General

Languages
• The following languages have been updated and completed: Korean.

Datamanager

Add file to page
• Under certain circumstances RheoWin would crash when adding a *.rwd data file to a page. This 

has been solved.

Load page
• After loading a *.rwp page file, evaluation results were not always correctly shown. This has been 

solved.

Graph / Table display

Significant digits in a table
• Under certain circumstances the displayed number of significant digits was not correct. This has 

been solved.

Version 4.75.0002
(Released  25.10.2017)

Below is a list of things that are new and/or changed in version 4.75.0002 compared with version 
4.75.0001 of RheoWin.

General

Language file
• The language file is now an Access database file (*.accdb) and not an Excel file (*.xls) file any more. 

Note  The reason for this change is that RheoWin will show a database related error message on 
start-up when Windows update KB4041676 (Windows 10) or Windows update KB4041686 
(Windows 7) has been installed. These Windows updates contain an error regarding the 
handling of *.xls files.
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Device Manager

Diagnosis window of thermocontroller devices
• The version of several thermocontroller (UTMC, UTC, DC30, Phoenix) was not displayed 

correctly. This has been solved.

Version 4.75.0003
(Released  10.11.2017)

Below is a list of things that are new and/or changed in version 4.75.0003 compared with version 
4.75.0002 of RheoWin.

General

Splashscreen
• On launching JobManager and DataManager the Splashscreen is now opened and closed before 

the main program window is opened.

JobManager

Example Jobs
• The graph axis settings in some of the example Jobs have been corrected.

Automatic file names
• In Jobs which were created with RheoWin 4.63.xxxx or older the settings for the automatic file 

name were not correctly loaded. This has been solved.

DataManager

OSC Multiwave Element
• OSC Multiwave data generated with RheoWin 4.63.xxxx or older was not loaded correctly. This 

has been solved.

Curve Fit Element
• Data files generated with RheoWin 4.30.0030 containing a curve fit were not loaded correctly. 

This has been solved. 

Version 4.75.0005
(Released  01.12.2017)

Below is a list of things that are new and/or changed in version 4.75.0005 compared with 
version 4.75.0003 of RheoWin.

Installation

Windows 10 version 1709 user privileges
• When Windows 10 is updated to version 1709 (2017 Falls Creator's Update) the Windows 

installation routine deletes/modifies certain existing registry user privileges that are needed by 
RheoWin. As a result RheoWin could not be started correctly anymore. This problem does not 
occur when RheoWin is installed after Windows 10 is updated. Starting from this version of 
RheoWin this problem is solved by modifications in the RheoWin installation program.

AuditTrail viewer
• The audit trail database entries were not always correctly ordered by time/date. This has been 

fixed.
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JobManager

Loading last Job on start up
• When the option Open last job in the Configuration > Preferences > General dialog is selected, the 

job that was closed last will be automatically loaded on start up.

JobEditor dialog size
• When saving a Job the current JobEditor dialog size is now saved and restored when the Job is 

loaded again.

LVR Element
• The Calculate LVR based on option is no longer locked when the Use DIN 51810-2 

recommended settings option is selected.

JobManager & DataManager
• On start up a message is displayed when the necessary Windows users privileges for RheoWin are 

not sufficient.

Version 4.8x.00xx

Version 4.80.0000
(Released 09.03.2018)

Below is a list of things that are new and/or changed in version 4.80.0000 compared with version 
4.75.0005 of RheoWin.

Installation

Supported circulators
• Drivers for the (older) circulator models F6/N6/F8/N8, DC5, DC30, DC50 and Phoenix 

circulator models are now part of the installation again.

Languages
• The english, german, french, polish, spanish, chinese, japanese and korean language tranlsations 

have been updated and completed.

DeviceManager

Measuring geometries
• The FL10, FL100 and FL1000 vane geometries + Adapter Ux are now installed for the VTiQ and 

MARS 40/60.
• The pressure cell geometries PZ32, PZ33 and PZ34 are now part of the installation.
• Some properties of the CC22 25-HS/SS, CC22 100-HS/SS and CC22 400-HS/SS were not 

correct. This has been solved.

JobManager

JobEditor
• The symbols for the physical quantities γ, γ ,  , Fn, h are now displayed in front of the set values in 

the (6th row of the) element list.
• For oscillation elements the symbols γ0 and are used, see below.
• The mode abbreviations CF and CG (see below) are displayed in the the (5th row of the) element 

list.
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RheoWizard
• Under certain circumstances the RheoWizard did not work correctly. This has been fixed.

Export element
• Under certain circumstances the column delimiter symbol for a data table, which can be selected in 

the Configuration > Preferences > General dialog was not correct. This has been solved.

FTIR-Spectrum element
• The Omnic Experiment files that can be selected in this element were incorrectly called 

Configuration files. This has been corrected.

File Load element
• When the new Select first, auto load next option is selected and the element is used together with 

the Goto element in a loop, the element will load all *.rwd data files which it finds in one (user 
defined) directory one after the other. The directory is selected by selecting one *.rwd file in the 
desired directory using the file Open dialog that will appear when running the job.

• An example Job (Read rwd data and export to ASCII.rwj) demonstrating the use of this 
functionality is available in the Job Explorer in the Jobs/# Examples/10. Evaluation directory.

All measurement element editors
• The individual editor pages are now all on one level: The Rot/Osc-parameter pages, the 

Acquisition pages and the Break criteria pages have been moved from the second level to the first 
level.

• The default order of the pages is basically the same as in the previous two level design with the 
exception that the Break criteria page (if existent) is always the last page.

• Alternative page order configurations can be selected from the Element editor pages menu in the 
JobEditor context menu (Popup menu).

• The Options, Extern and Break criteria pages can be hidden by setting the corresponding option 
on the Element editor pages menu in the JobEditor context menu (Popup menu).

• The editors have been "cleaned-up" regarding their appearence: "Controls" have been repositioned 
and resized to fit text in all languages, the positioning of "controls" has been standardized in all 
editors, all group boxes now have a title, the Take from previous checkbox is now always 
positioned above the edit field that it applies to, etc.

• Missing translations for a few text items have been added.

All OSC measurement element editors
• The Waiting time edit field is now placed above the # Repetitions edit field in order to reflect the 

actual sequence in which they are used in a measurement.
• The stress/strain edit fields are now labeled with γ0 and  instead of just γ and  to indicate that 

these values are sinewave amplitude values.
• By right clicking on the γ0 and label in front of the stress or strain edit field in the OSC Time 

Element (only in this element!) the old situation can be restored. This setting is valid for all OSC 
elements and the JobEditor element list, see below.

ROT Time element
• The minimum number of data points that can be acquired is now 1 (instead of 2).

ROT Ramp element
• Under certain circumstances this element caused a job to stop prematurely. This has been solved.

OSC Temperature Ramp element
• When Take from previous is selected for the start temperature either the Duration or the 

heating/cooling rate T/t can be selected as the fixed parameter.

Axial Elements
• The mode text controlled force mode is now abbreviated as CF.
• The mode text controlled gap mode is now abbreviated as CG.
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JobManager and DataManager

CurveFit element/evaluation
• In the Parameter list there is now a fifth column, Show, with a check box for each model 

parameter. When the check box for a certain parameter is unchecked the parameter value will not 
be displayed in the result text.

LVR element/evaluation
• The calculation of the critical stress and strain, as well as other internal functionality has been 

optimized.

SHRP element/evaluation
• Under certain circumstances the SHRP evaluation would crash. This has been solved.

Interpolation/x-th data point element/evaluation
• Under certain circumstances a x-th data point was not correctly determined. This has been solved. 

Please note that when using this element for determining a x-th data point, the (x-axis) range must 
be set to total range.

Report templates

Templates for Excel export
• The templates ExcelExport.lst, ExcelExport_TableOnly.lst and ExcelExport_GraphAndTable.lst 

for export to an Excel-file export have updated.

Template for LVR element 
• There is a new template GraphAndLVR.lst for use with the LVR (Linear Viscoelastic Range) 

evaluation element.

Graph / Table display

General perfomance
• The general performance of the graph and table functionality has been improved.

Version 4.80.0001
(Released 14.03.2018)

Below is a list of things that are new and/or changed in version 4.80.0001 compared with version 
4.80.0000 of RheoWin.

JobManager

OSC Temperature Ramp element
• Due to a bug, Jobs (created with a previous RheoWin version) containing this element could not 

be loaded in RheoWin 4.80.0000. This has been solved.

Version 4.81.0000
(Released 16.05.2018)

Below is a list of things that are new and/or changed in version 4.81.0000 compared with version 
4.80.0001 of RheoWin.

Installation

Visual C Redistributable
• Under certain circumstances the Microsoft Visual C Redistributable package (VCRedist 2015) was 

not installed correctly. This has been solved.



 2 What’s new
Version 4.8x.00xx

Thermo Scientific HAAKE RheoWin 4.95.0003 Readme 91

JobManager

JobEditor
• For the Lift and the Message element the display of a (text) message and/or an image and/or a 

video during Job run time is now indicated by means of the text [Message], [Image], [Video] in the 
element list.

Manual Control (Monitor) window
• The Normal force Start button was not always working correctly. This has been solved. 

Temperature Setting element editor
• The editor pages have been adapted to the new layout of the measurement elements.

Identification element editor
• The maximum number of saved Substance > Name entries is now 500.
• All saved Substance > Name entries can now be deleted by right clicking on the Substance > Name 

edit field and selecting Delete all items command.
• Any individual selected Substance > Name entry can now be deleted by right clicking on the 

Substance > Name edit field and selecting Delete this item command.

ROT Time element
• The option Take from previous for the Temperature value was not correctly displayed in the Job 

Info/Protocol window.

All evaluation elements
• There was a problem with very long path names for data files. This has been solved.

JobManager and DataManager

CurveFit element/evaluation
• The resulting fit parameters for the Casson (lin) model were not correctly displayed in the Job 

Info/Protocol window. This has been solved.

Area element/evaluation
• The calculated area values were not correct when the temperature was plotted on one of the axis.
• On the Layout page in the Numerical area of the element editor, the operator can now select to 

display the Area and/or the Sum area and/or the Diff. area in the Job Info/Protocoll window.
• The Diff. area value is always displayed in the Result list in the element editor.
• The Sum area value is the sum of all Area values of the selected data segments. 
• The Diff. area value is the difference of the Area values of two subsequent selected data segments.

DataManager

File menu
• With the new File > Save > Save OSC (Multiwave) Segments as OSC Time Curve Segments 

command, data from OSC and OSC MultiWave segments are splitted up into separate *.rwd files 
each containing an OSC Time Curve segment with the data for one frequency from the original 
file.
The new files are automatically saved in the same directory as the original data *.rwd or page *.rwp 
file. The names of the new *.rwd files consist of the original file name plus the appended text 
_f=x.x, were x.x stands for the actual frequency. The complete contents of the info/protocol 
window, including the element definition of the original(!) file, is stored in each new file.

• There are now so called hints for the Graph, Table, Protocol and Video buttons in the toolbar.

Version 4.82.0000
(Released 27.07.2018)
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Below is a list of things that are new and/or changed in version 4.82.0000 compared with version 
4.81.0000 of RheoWin.

Installation

Languages
• A first version of the Hebrew language translation is now included.
• The Chinese, Japanese, Korean, Portugese, French, Spanish, and Polish languages have been 

updated.

Quantities/Units

Friction normal force
• There is a new sub-quantity Fnf, that is the friction normal force, for the Ball on three plates 

measuring geometry.

Special quantities for bitumen measurements
• There are two new quantities |G*| x sin() and |G*| / sin() available.
• These quantities are sub-quantities of the quantity G.

DeviceManager

Driver for MARS II
• Under rare circumstances the Rot Ramp element would hang or crash at the beginning or the end 

of the ramp. Modifications have been made to prevent this.

Plate/Plate geometry
• The effective M-factor for a plate/plate geometry depends on the actual gap between the two 

plates. The M-factor for any plate/plate geometry as displayed and stored in the DeviceManager is 
always the M-factor for a gap of 1.0 mm. 
Until now this was not reflected in the geometry editor in the DeviceManager. 
Starting from this version the M-Factor of a a plate/plate geometry is correctly displayed as M.h 
with the unit ((1/s)/(rad/s)).mm. 

• With the new Single-point correction (ROT: γ, γ , N1) option the operator can now activate the 
calculation of representative values of the strain, shear-rate, shear-stress and first normal stress 
difference values according to Macosko (the representive value are the rim values multiplied by 
0.755). For this the A- and M-Factors are automatically modified.
When this option is not active the values at the rim of the plates are calculated (as was the case in 
the past) using the normal A- and M-factors.
The single-point correction is used for ROT measurements only. For OSC measurements the 
normal A- and M-factors are used automatically even when ROT and OSC measurement elements 
are used in one Job.
When this option is active a corresponding text it is displayed in the Info/Protocol text.
When this option is active both the normal A- and M-factors and the corrected A- and M- factors 
are displayed in the Info/Protocol text.

Tribology geometry
• A new geometry with the name TR13 45° of the type Tribology - Ball on three plates is now part 

of the installation.

Note  These quantities are disabled by default and must be enabled before they can be used.

Note  In the Info/Protocol text of measured data the effective M-factor is displayed.
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Camera settings (MARS I/II/III, MARS40/60, RheoScope 1, Simulator)
• When a specific video format is not available (anymore) the first format in the list is automatically 

selected. This in order to prevent error message to appear.

JobManager

Data export element
• In the Export ASCII area on the ASCII / Report page of the element editor there is a new option 

Encoding which allows the operator to select either the ANSI (=plain ASCII) or the Unicode 
format for the exported *.txt file.

• The results of the LVR and Advanced curve discussion element can now be selected for export also.

All measurement elements/Job controller
• Under rare circumstances certain elements would halt a Job. Modifications have been made to 

prevent this.
• The relative (procentual) option of the freely definable break criteria did not work correctly. This 

has been solved.
• When the fourth option of the freely definable break criteria is set to "%" instead of the default 

"---", the value measured at the time set in the fifth option is used as the reference value for the 
relative break criterium.

All ROT elements and Axial Time element
• These elements now calculate the friction force (Ff ), the friction normal force (Fnf ) the friction 

coefficient and the circumfential velocity vR for the Ball on three plates Tribology measuring 
geometry.

ROT Time curve, ROT Ramp and ROT Step element
• When a Tribology type geometry is selected, the editors of these element are now automatically 

switched into "tribology mode". In "Tribology mode" the set values are vR (in CR-mode) and Ff 
(in CS-mode) instead of γ  (in CR-Mode) and (in CS-Mode).

All OSC elements
• The new quantities |G*| x sin() and |G*| / sin() are now calculated and saved during every 

measurement and can also be used as Break criteria in the elements.

JobController
• The display of the job control buttons in the upper left corner of the JobController have been 

slightly cleaned up.

DataManager

File menu
• The items in the File menu have been reordered in a more logical way.
• All items that relate to a *.rwd file now have the word data in their name.
• There is a new item Save data which saves a *.rwd directly (without asking for a new file name).
• The Page submenu has been removed, the five Page menu items are now placed in the file menu 

itself. The New item has been renamed to New page and is part of the five Page items.

Toolbar
• The buttons in the toolbar have been reordered in a more logical way, in accordance with the file 

menu.
• There is a new button Save data which saves a *.rwd directly (without asking for a new file name).

The toolbar now also contains buttons for all Page related items from the file menu (apart from the 
Close page item).

Page title
• The title text (caption text) of a page now always starts with the text Page:.
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• When a *.rwp page file is loaded the page file name is now displayed with the extension (in 
previous version the extension was not shown).

• When one or more *.rwd data file(s) are loaded in a new page the name of the first *.rwd file is 
displayed in the page title which then starts with the text Page (not saved):. 

Graph and Table display

Print graph
• When printing a graph from the graph context menu using the Print command the text printed 

below the graph was not printed correctly. This has been solved.

Save graph
• Saving a graph as a file from the graph context menu did not work when the graph was displayed 

on the 2nd monitor of a PC with two monitors. This has been solved.

Version 4.82.0001
(Released 01.08.2018)

Below is a list of things that are new and/or changed in version 4.82.0001 compared with 
version 4.82.0000 of RheoWin.

Installation

Languages
• The translations of some items in the DataManager File menu were missing in certain languages. 

Those translations have been completed.

Quantities/Units

Special quantities for bitumen measurements
• The two new quantities |G*| x sin() and |G*| / sin() were not correctly installed. This has been 

solved.

Version 4.82.0002
(Released 31.08.2018)

Below is a list of things that are new and/or changed in version 4.82.0002 compared with 
version 4.82.0001 of RheoWin.

DeviceManager

SolidClamp tool
• In version 4.82.0001 both the A- and M-factor for the solid clamp tool were not calculated 

correctly. This has been solved.

JobManager and DataManager

Structure Recovery Element (Evaluation)
• This element can now also be applied to the data measured using three subsequent OSC Time 

Curve elements.

Version 4.83.0004
(Released 07.02.2019)
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Below is a list of things that are new and/or changed in version 4.83.0004 compared with 
version 4.82.0002 of RheoWin.

Installation

Languages
• A first version of the russian language translation is now included.

AuditTrail

Data files with a long file name
• Data file names with more than 29 characters caused problems in the AuditTrail. This has been 

solved.

JobRun program

Command-line parameters
• The command-line parameter option for the Jobrun.exe program (which is used for starting 

pre-defined Jobs directly, i.e. instead of using JobManager), was not working anymore in the last 
RheoWin versions. This has been solved.

• The following command-line parameters are available: 
With the command-line parameter /SUBSTANCENAME:text the sample name, is set to text, just 
as if it were entered in the Identification dialogue.
With the command-line parameter /SUBSTANCENUMBER:text the sample number, is set to 
text, just as if it were entered in the Identification dialogue.
With the command-line parameter /COMMENT:text the comment, is set to text, just as if it were 
entered in the Identification dialogue.
With the command-line parameter /DESCRIPTION:text the sample descriptionis set to text, just 
as if it were entered in the Identification dialogue.
The following is a example of how to use this:
           jobrun.exe "jobname.rwj" "/SUBSTANCENAME:sample name"   
           "/SUBSTANCENUMBER:sample number" "/DESCRIPTION:description"
Please note the use of " " around each command-line parameter to allow for a file-name or a text 
that contains spaces.

• This feature can be used to start RheoWin Job's directly from within a LIMS or ERP system.

JobManager and DataManager

Job, Data, Pages, Templates explorer
• In the Open dialog which is used for selecting the explorer-tree start directory unreadable 

characters were displayed under certain circumstances. This has been solved.

Lift Element
• The short texts displayed in the JobControl status field, which inform the operator about the lift 

status, are now slightly more detailed.

Curve Fit Element
• The calculation of the initial values for the Windhab model has been improved in order to give a 

better curve fit result.
• The parameter list in the element dialog can now display up to 5 parameters at the same time.

LVR Element
• The underlaying algorithm of the LVR calculation has been improved.
• On the Data/Method/Result page of the element editor there is a new edit field Data tolerance. All 

data point that are outside of the tolerance band defined by this value are ignored during the 
calculation.
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Advanced Curve Discussion Element
• This element can now also calculate the Inflection point of a curve.
• The element dialog has been slightly modified, the five possible calculation methods are now 

selected from a drop-down list (instead of radio buttons).

DataManager

All evaluation element dialogs
• The commands Recalculate, Calc as new, Delete and Data select are now also available (for each 

result) in a popup context menu in the result tree on the right hand side of the dialog.
• The selection of multiple results (for deleting only) in the result tree is now possible.
• Deleting a result from the result tree can now also be done using the Delete key on the keyboard.
• The tool-tips in the result tree are now multi-lined (if needed) and therefore now always directly 

display the complete result of an evaluation.

Graph and Table display

Graph layout dialog and table layout dialog
• These dialogs are now opened notably quicker.
• Clicking the Update button will now redraw/update the active graph or table with any modified 

setting, without closing the dialog first.

Graph context menu
• In the graph (right mouse key) popup context menu there is a new command Show/hide files with 

a submenu in which all files in the active graph are listed. With this command all curves belonging 
to a certain file can be removed/added from/to the graph in a more convenient and quicker way 
then via the Graph layout > Data > Curves > Hide file command.

Version 4.84.0003
(Released 08.05.2019)

Below is a list of things that are new and/or changed in version 4.84.0003 compared with version 
4.83.0004 of RheoWin.

JobManager

Manual Control
• The normal force control is now stopped when the lift stop button is clicked.
• Upon closing the manual control window the normal force control is not stopped when it was still 

active.

Message Element
• The size of the Message element run-time dialog has been increased. 
• The Ok button has been replaced with a much larger Continue button.

Export Element
• Data can now be saved in the IUPAC XML format using the Export element also.

LVR Element
• The default value for the tolerance value for the calculation of the plateau value has been changed 

to 5%.
• Some dialog texts have been modified.

Curve-Fit Element
• Under certain circumstances the element crashed when performing multiple curve-fits on one data 

curve. This has been solved.
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DataManager

Saving a file or page
• When saving a file or page in DataManager in previous versions of RheoWin, a message 

confirming the correct saving was displayed. This behaviour has been modified, such messages are 
no longer displayed.

Select file dialog
• The select file dialog which is displayed when using the File > Edit data identification command 

must now be closed using the Cancel button and will stay open after clicking the Ok button and 
editing the identification of a file.

Saving in IUPAC XML format
• Under certain circumstances saving in IUPAC XML format did not work correctly. This has been 

solved.

Graph and Table display

Graph display
• The automatic scaling for logarithmic axes has been improved.

Report

Wrong gap value in report header
• In the header part of a report an incorrect value for the geometry gap was reported. This has been 

solved. (A patch for version 4.83.0004 for this is available.)

Version 4.85.0000
(Released 03.06.2019)

Below is a list of things that are new and/or changed in version 4.85.0000 compared with version 
4.84.0003 of RheoWin.

Installation

MARS iQ and MARS iQ Air rheometers
• The installation program now allows the installation of RheoWin for the new MARS iQ and the 

new MARS iQ Air rheometers.
• The "look" of the installation dialog windows has been slightly modernized.

General

Software certificate
• RheoWin now comes with a GlobalSign code signing certificate to prove that: 

1) the HAAKE RheoWin software is legitimate, 
2) the HAAKE RheoWin software comes from a known software vendor
3) the code has not been tampered with since being published.

• The digital signature is applied to the RheoWin setup.exe file and all RheoWin executable files.
• The digital signature is issued for "Thermo Electron (Karlsruhe) GmbH" as the publisher.

DeviceManager

MARS iQ and MARS iQ Air rheometers
• There are two new drivers for the new MARS iQ and MARS iQ Air rheometers.
• There are two new drivers for the integrated temperature controllers of the new MARS iQ and 

MARS iQ Air rheometers.
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All MARS rheometers
• The single-point correction for γ, γ ,  and N1 was, incorrectly, applied to CD-OSC data when this 

option was active. This has been solved.

JobManager

Manual Control
• When the manual control window is closed, the rheometer drive motor was not always stopped 

correctly. This has been solved.
• The set value for the shear-rate is now recalculated when the gap value is changed.

Lift Element
• The Best angular position option could cause the rotor to rotate when moving to the (gap) 

trim-position. This has been solved.

CS/CR Rotation Step element
• Under certain circumstances the Break criteria did not work correctly. This has been solved.

Crossover Evaluation element
• The crossover calculation did not work correctly when the select data contained data segments 

with just one data point. This has been solved.

Curve-fit Evaluation element
• A new curve-fit model Casson (Visc)(lin) has been implemented. This two parameter Casson 

model performs a curve fit on linearized viscosity=f(shear-rate) data.

Graph and Table display

Activating/De-activating data-segments during Job run
• Activating and de-activating a data-segment during a Job run did not work anymore. This has 

been solved.

Axis title
• When two quantities were selected for the X-axis, the axis title was not displayed correctly. This has 

been solved.

Version 4.85.0001
(Released 05.07.2019)

Below is a list of things that are new and/or changed in version 4.85.0001 compared with version 
4.85.0000 of RheoWin.

Installation

Permissions for certain directories
• The installation program now automatically set the correct permissions for the following

directories which are used by RheoWin:
          C:\Users\Public\Documents\Thermo\RheoWin
and 
          C:\ProgramData\Thermo\RheoWin

Note  This can and will only work when the Windows user (for example a Windows 
Administrator) who installs RheoWin has the priviliges to modify these permissions.



 2 What’s new
Version 4.8x.00xx

Thermo Scientific HAAKE RheoWin 4.95.0003 Readme 99

JobManager & DataManager

LVR Evaluation element
• Under certain circumstances the calculation of the plateau values did not work correctly. This has 

been solved.

Version 4.85.0002
(Released 08.07.2019)

Below is a list of things that are new and/or changed in version 4.85.0002 compared with 
version 4.85.0001 of RheoWin.

JobManager

Temperature calibration module
• The user interface language setting of the JobManager was not transferred to this module, as a 

consequence this module always used the english language. This has been solved.

Version 4.86.0000
 (Released 01.08.2019)

Below is a list of things that are new and/or changed in version 4.86.0000 compared with version 
4.85.0002 of RheoWin.

JobManager

Lift element
• When the rheometer drive motor was set to rotate during the lift movement, the rotation was not 

stopped when finishing the lift movement (MARS iQ only). This has been solved.

Report element
• This element can now also be controlled from the MARS iQ touchscreen panel (Continue 

button).

Goto element
• The Goto element can now be used to change the value of the set parameter γ or γ  or  (in 

CR-Mode) and set parameters f and γ or (in OSC-Mode) of the target element by defining an 
end value for the set parameter (for the Goto loop), by defining how (linear or logarithmic) the set 
value should be changed and by defining how often the Goto element should be executed. The 
start value of the set parameter is the value defined in the target element itself.

• Goto-loops can now also be nested (one loop inside another loop).
• The element icon in the list of element in the Job-Editor now shows whether the target element of 

the Goto element is before (above) or after (below) the Goto element itself.

Show data element
• In the element editor of the Show data (or Pause) element now contains a new option Show all 

current R_IDxx_Pxx result parameters. 
• When this option is activated a list with all current result parameters and their result values will be 

displayed by this element during Job run.
• For this to work the Show data element should be placed in the Job at a position after all 

Evaluation elements.
• The list with the current result parameters is meant as a help function, that is for a better 

understanding of the naming convention of the R_IDx_Py_z result parameter names and for use 
during the "design/test" phase of a job.

• When the Job is working properly this option should be deactivated.
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• An example Job with the name Evaluation-only (12, Math element).rwj containing this feature, is 
available in the default RheoWin Jobs \# Examples\10. Evaluation directory.

Math element
• With the new Math element calculations can be made with numerical result values of any 

evaluation element.
• On the Calculation page of the element editor the operator can select and define an equation.
• On the Layout page of the element editor the operator can select how the equation is displayed in 

the Protocoll/Info window during Job run and in DataManager.
• Currently the Math element contains the following two user definable equations:

           result1 = operand1 operator operand2
           result2 = (operand1 operator1 operand2) operator3 (operand3 operator2 operand4)
For any operand a numeric value or a result parameter name (R_IDx_Py_z) can be entered. The 
operator can be selected from a drop-down list. The following (basic) operators are available +, -, x, 
/ and ^.
This enables the RheoWin operator to use equations like:
result1 = A + B, result1 = A - B, result1 = A / B, result1 = A x B, result1 = A ^ B
and
result2= (A + B) / (C - D), result2 = (A - B) / C, etc.
with for example A = R_ID8_P02_1 (a result parameter name) or A = 10,5  (a numeric value) etc.

• A practical example for the use of the new Math element is to calculate the quotient of two 
viscosity values where the two viscosity values are mean values, calculated with the 
CurveDiscussion element.

• An example Job with the name Evaluation-only (12, Math element).rwj containing this feature, is 
available in the default RheoWin Jobs \# Examples\10. Evaluation directory.

All Evaluation elements
• The user defineable text for a QC criterium was not displayed correctly when it contained 

"special" characters like ü, ö, ä, etc.

Version 4.86.0001
 (Released 12.09.2019)

Below is a list of things that are new and/or changed in version 4.86.0001 compared with version 
4.86.0000 of RheoWin.

Installation

Default Rheometer and Temperature Controller
• The settings for the default rheometer and temperature controller are now saved/restored when 

modifying an existing installation.

General

Internet Links in Help Menu
• The internet links in the Help menu have been updated.

Note  The Math element is not available in the RheoWin DataManager. The result of the Math 
element however is stored in the *.rwd data file and displayed in the DataManager 
Protocol/Info window, but the result is not updated when the evaluation result(s) it is based on 
are modified/recalculated in DataManager.
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JobManager

Save element
• When trying to overwrite a signed file a clear warning message is now displayed.

MultiStep-Element
• The ROT MultiStep-element is now also available for the MARS iQ (Air).

Version 4.86.0002
(Released 23.10.2019)

Below is a list of things that are new and/or changed in version 4.86.0002 compared with version 
4.86.0001 of RheoWin.

Installation

Access database engine installation
• The Microsoft Access database engine installation that part of previous RheoWin versions was 

corrupted by the installation of Microsoft Office 365. In order to overcome this issue RheoWin 
now installs and uses the Microsoft Access 2010 database engine.

JobManager and DataManager

Interpolation element and Curve discussion element
• The number format for result values was not correct in some result displays. This has been solved.

Version 4.87.0001
(Released 28.09.2020)

Below is a list of things that are new and/or changed in version 4.87.0001 compared with version 
4.86.0002 of RheoWin.

Installation

Languages
• A first version of the Thai language translation is now included.
• A first version of the Italian language translation is now included.

SHRP element and Asphalt/Bitumen software module
• The SHRP evaluation element is now part of the new Asphalt/Bitumen software module and not 

part of the standard installation anymore. 
Customers with a valid RheoWin installation key (issued before 01.01.2021) can request a special 
installation key (order no. 098-5567) for the SHRP evaluation element at no cost.

• The new Asphalt/Bitumen software module consists of the new MSCR, the new BYET and the 
new LAS evaluation elements as well as the existing SHRP evaluation element.
A special installation key (order no. 098-5566) is needed to install the Asphalt/Bitumen software 
module.

General

Loading older electronically signed data files
• Electronically signed RheoWin *.rwd data files from older RheoWin versions could not be opened. 

This has been solved.

Note  The MARS iQ (Air) must be equipped with firmware version V1:01.01.003 or newer.
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Readme and new file
• The readme.doc and new.doc files have been replaced by the RheoWin_Readme.pdf and 

RheoWin_New.pdf files in Adobe PDF file format.
• The corresponding items in the Help menu have been slightly changed.

Rheometer drivers

MARS iQ (Air)
• On the Additional data page of the Properties of ‘MARS iQ (Air)’ dialog a camera can be selected 

for acquiring images as part of a measurement (just as with any other MARS).

• Modifying the IP-adress of a MARS iQ (Air), using the Set IPADDR command on the General 
page of the Properties of ‘MARS iQ (Air)’ dialog did not work and resulted in an error message. 
This has been solved.

MARS I / II / III / 40 / 60
• The drivers of these rheometers are now equipped with two tables, each containing a set of 

frequency dependent waiting times and numbers of repetitions for oscillation elements. One table 
is optimized getting high-quality data, the other table is optimized for getting data more quickly. 
These tables can be selected on the Data acquisition page of all oscillation element editors.
These tables are identical for the MARS I, II, III, 40 and 60

MARS iQ (Air)
• The drivers of these rheometers are now equipped with six tables, each containing a set of 

frequency dependent waiting times and numbers of repetitions for oscillation elements. Three 
tables, one for each measurement mode, are optimized for getting high-quality data, the other set 
of three tables is optimized for getting data more quickly. These tables can be selected on the Data 
acquisition page of all oscillation element editors.
These tables are not identical for the MARS iQ and the MARS iQ Air.

Temperature control drivers

MTMC for MARS iQ (Air), MARS 40 / 60
• The temperature offset table can now contain up to 20 offset values.
• Temperature offset tables can now also be defined for all TM-xx-x that are based on liquid 

temperature control using a circulator. This applies to the TM-LI-P, TM-LI-C (old model), 
TM-LI-C32 and TM-LI-C48 modules.

• The values entered in the table are now checked more stringently. Temperatures values must be in 
the range of -100 °C to 400 °C, offset values must be in the range of -15 °C to 15 °C.

Note  The RheoScope module is not yet available for the MARS iQ (Air).

Note  MARS 40/60 Firmware P1 50.25.003, P2 50.23.000 and P3 65.00.012 or newer is 
needed for the above two points to work.

Note  MARS iQ(Air) Firmware P1 01.06.003, P2 01.06.002 and P3 65.00.012 or newer 
is needed for he above two points to work.
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JobManager

Message element
• Sending an e-mail from the Message element did not work in certain previous RheoWin versions. 

This has been solved.

Save element
• A Job specific default data directory can now be specified for the Ask for file name option by 

clicking the corresponding Settings button and selecting the file name in the Ask for file name 
dialog.

• Several new options are now available in the Automatic file name dialog for the Additional part of 
the automatic file name:
- A new combined DateTime entry with format YYYYMMDDHHMM.
- Two additional Free text entries which can be placed anywhere in the file name.
- The Separator between the entries can now be selected from a list or manually entered.
- A new option Ask for confirmation before saving allows the operator to decide whether the

measured data should be saved or not (using the automatically created file name) at job run time.

Export element
• On the ASCII / Report page of the element editor the Extension of the exported ASCII file can 

now be defined. Possible extensions are .txt, .csv, .asc and .sqm. The defined extension is used for 
any ASCII file created by the export element.

• On the new ASCII for LIMS page of the element editor the content of the exported ASCII file can 
now be freely composed by entering any Unicode text and/or inserting certain parameter names 
and text names.
- All allowed parameter names and text names are displayed in two popup menus which are

accessed from the two buttons below the edit field.
- The parameter names are also available from the right mouse key context popup menu.
- The parameter names and text names can be selected from the popup menu and inserted in the

edit field at the text cursor position.
- The parameter names are replaced by the corresponding parameter value when the ASCII file 

is exported.
- The text names are replaced by the corresponding text in the currently used language when 

the ASCII file is exported.
- Result parameters names R_IDxx_Pyy_z are replaced by the corresponding evaluation element

result value, with or without it’s unit (when available), when the ASCII file is exported.
- Tabs can be entered by using the keyboard tab key (the tabs are not visible).
- To export the contents of the edit field the option Export the following text above the edit field

must be activated.
- To export result values with their unit (when available) the option Show results with unit must

be activated.
- The content of the edit field is exported in addition to what is selected for export on the

ASCII / Report page of the element editor.

Rotation time element
• Under certain rare circumstances one data point too few (at the end of the element) was acquired. 

This has been solved.

Note  Currently the Message element can not send e-mails via a SMTP server that insists on 
using SSL authentication. Company network setting may prohibit RheoWin to send e-mails.
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All oscillation elements except the frequency sweep element
• On the Data acquisition page in the Single data point settings area of the element editor there are 

now three options for the Waiting time, # Repetititons.
These options are:

Auto: High quality acq. (f-dependent)
Auto: Fast acq. (f-dependent)
Manual (same for all f )

The Manual option corresponds with the previous RheoWin versions. The two new Auto options 
use the tables defined in the rheometer driver.

Oscillation time element
• For the MARS iQ (Air) instruments a limiting maximum torque value for the CD mode can now 

be defined (just like in the case of all other MARS instruments).

Oscillation frequency sweep element
• On the Data acquisition page in the Single data point settings area of the element editor there are 

now four options for the Waiting time, # Repetititons.
These options are:

Auto: High quality acq. (f-dependent)
Auto: Fast acq. (f-dependent)
Auto: User defined (f-dependent)
Manual (same for all f )

The Manual option corresponds with the previous RheoWin versions. The first two new Auto 
options use the tables defined in the rheometer driver. The third new Auto option uses an 
user-defined table which is accessed by clicking the Edit button behind the option selection box. 
This user defined table is saved as part of the RheoWin Job.

• By right clicking (almost) anywhere on the Data acquisition page and then selecting the 
Repetitions table command from the context menu, a table displaying every frequency with its 
waiting time and number of repetitions as well as the expected duration of the frequency sweep can 
be displayed. For the MARS I/II/III/40/60, depending on the mode (CS/CD/CD-AS) and the 
frequency range, the actual duration may differ from the calculated (expected) duration.

• On the Oscillation page in the Mode area of the element editor there is a new option CR. When 
CR-mode is selected the shear rate amplitude γ0 is the set parameter. CR-mode in oscillation is 
basically CD-mode with a non-constant frequency dependent strain amplitude γ0 according to the 
equation γ0 = γ0/

• On the page in the Mode area of the element editor there is a new option Non const. ampl. when 
CS or CD is set for the mode.
When this option is selected both a start and an end value for the stress or strain amplitude can be 
defined in the stress/strain area of the editor.

• For the MARS iQ (Air) instruments the frequency values can now be defined in the form of a 
Table of values (just like in the case of all other MARS instruments).

Note  For the Viscotester iQ (Air) only the two Auto options are available.

Note  For the Viscotester iQ (Air) only the two Auto options are available.

Note  This option is available for the MARS I/III/40/60 instruments only.

Note  This option is available for the MARS I/III/40/60 and MARS iQ (Air) instruments only.
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• The maximum number of frequency values in a table has been increased to 310.

Oscillation amplitude sweep element
• For the MARS iQ (Air) instruments the amplitude values can now be defined in the form of a 

Table of values (just like in the case of all other MARS instruments).

• The maximum number of amplitude values in a table has been increased to 310.

Oscillation temperature ramp element
• On the new Options page of the element editor there is an new option Use T instead of end T. 

When this option is selected the operator can edit T (T = End T - Start T) instead of End T on 
the Temperature page of the element editor. This useful when this element is used in a Goto 
element loop.

• The radio buttons behind Duration and T/t are now always available so that either value can be 
kept constant when editing a temperature value.

• The value of temperature gradient T/t is now always displayed as T per minute, independent of 
the unit (ms, s, min, h) selected for the time.

• For the MARS iQ (Air) instruments a limiting maximum torque value for the CD mode can now 
be defined (just like in the case of all other MARS instruments).

Oscillation temperature steps element
• For the MARS iQ (Air) instruments a limiting maximum torque value for the CD mode can now 

be defined (just like in the case of all other MARS instruments).
• This element is now also compatible with the MARS iQ (Air) instruments.

Asphalt measurement element
• A new measurement element for performing measurements according to 

- ASTM D7405-15, AASHTO T350-19, DIN EN 16659 or FGSV AL DLSR-Prüfung 
(MSCRT),
- AASHTO TP 123-16 Method A and B,
- AASHTO TP 101-12 and AASHTO TP 101-14.

• A special installation key is needed to be able to install this element.

JobManager and DataManager

MSCR evaluation element for asphalt testing
• A new evaluation element for evaluating MSCR measurement data according to ASTM 

D7405-15, AASHTO T350-19, DIN EN 16659 or FGSV AL DLSR-Prüfung (MSCRT).
• A special installation key is needed to be able to install this element.

BYET evaluation element for asphalt testing
• A new evaluation element for evaluating measurement data according AASHTO TP 123-16 

Method A and B.
• A special installation key is needed to be able to install this element.

Note  Firmware V1: 01.04.000 or newer is needed for this work.

Note  Firmware V1 01.04.000 or newer is needed for this work.

Note  Firmware V1: 01.04.000 or newer is needed for this work.



2 What’s new
Version 4.8x.00xx

106 HAAKE RheoWin 4.95.0003 Readme Thermo Scientific

LAS evaluation element for asphalt testing
• A new evaluation element for evaluating LAS measurement data according to AASHTO TP 

101-12 and AASHTO TP 101-14.
• A special installation key is needed to be able to install this element.

Curvefit element
• The calculation of the start parameter values for the Casson curve fit model has been improved.

Area evaluation element
• The editor of this element did not work properly anymore in the last RheoWin versions.

This has been solved.

Graph/Table display

Axis scaling
• For values larger than 1020 the axis scaling did not work properly. This has been solved.

Range calculator

Parallel plate geometries
• The gap value was always displayed as being 0.0 on the Numerical page. This has been corrected, 

the correct value is now displayed.
• The sample volume was not correctly displayed on the Numerical page when the gap value differed 

from the default gap value of 1.0 mm.
• The angular velocity values were not correctly exported to a *.rwd file when the gap value differed 

from the default gap value of 1.0 mm.

Version 4.87.0002
(Released 22.10.2020)

Below is a list of things that are new and/or changed in version 4.87.0002 compared with version 
4.87.0001 of RheoWin.

JobManager and DataManager

MSCR, BYET and LAS evaluation elements for asphalt testing
• Certain internal data plausibility tests were found to be too stringent and have been modified.

Version 4.87.0005
(Released 17.12.2020)

Below is a list of things that are new and/or changed in version 4.87.0005 compared with version 
4.87.0002 of RheoWin.

Installation

SHRP element and Asphalt/Bitumen software module
• The SHRP evaluation element is now part of the new Asphalt/Bitumen software module and not 

part of the standard installation anymore. 
Customers with a valid RheoWin installation key (issued before 01.01.2021) can request a special 
installation key (order no. 098-5567) for the SHRP evaluation element at no cost.
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• The new Asphalt/Bitumen software module consists of the new MSCR, the new BYET and the 
new LAS evaluation elements as well as the existing SHRP evaluation element.
A special installation key (order no. 098-5566) is needed to install the Asphalt/Bitumen software 
module.

LAS evaluation element
• The LAS element is currently not installed. It will be available again in a future RheoWin version.

Example and template files
• There are 21 new Job example job files in subdirectories of the \# Examples\06. Measurements 

according to standards directory. This includes Job for various ASTM, AASHTO, DIN and 
FGSV bitumen (asphalt) standards as well Jobs for the DIN 54458 and DIN 17408 standards.

Rheometer drivers

MARS iQ (Air)
• The rotation settings (torque or angular velocity) in the element following a rotation ramp element 

did not work correctly. This has been solved.

JobManager 

Axial Ramp element
• When the Data acquisition > Distribtuion was set to Log there was an 1 s delay for the first 

datapoint. This has been solved.

JobManager and DataManager

MSCR evaluation element
• In the Numerical group box on the new Layout page of the element editor the user can now select 

which numerical values will be included in the result information text.
• In the Numerical group box on the new Layout page of the element editor the user can now select 

whether the Parameter symbol and/or the Parameter name (as used in the corresponding standard) 
is included in the result information text.

• The intermediate result values of the MSCR calculation can now be optionally saved in a *.csv file.
To activate this option the following line(s) of text must added to the element.ini file:
[MSCR]

ExportIntermediateResults=On

BYET evaluation element
• In the Numerical group box on the new Layout page of the element editor the user can now select 

which numerical values will be included in the result information text.
• The quantity selection on the QC page of the element editor was not correct. This has been solved.

Report templates

Excel export
• In the ExcelExport_TableOnly.LST template the table header was missing. This has been 

solved.
• There is a new template ExcelExport_Table+FileName.LST which exports the currently 

defined table including the table header plus the name of the *.rwd file.
• All ExcelExport*.LST templates files now produce an Excel file in which the table values are 

formatted as (custom) numbers and not as text anymore.
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MSCR, BYET and LAS evaluation elements for asphalt testing
• There are new variables available for use in report templates for the three new elements.

Version 4.87.0006
(Released 18.01.2021)

Below is a list of things that are new and/or changed in version 4.87.0006 compared with version 
4.87.0005 of RheoWin.

Installation

Asphalt/Bitumen software module
• The Asphalt/Bitumen module is now automatically installed when using the 098-5019 general 

installation key.

Rheometer drivers

All VTiQ and MARS rheometers
• Under certain circumstances oscillation measurements did not work correctly with version 

4.87.0005 This has been solved.

JobManager 

All OSC elements
• Under certain circumstances oscillation measurements did not work correctly with version 

4.87.0005 This has been solved.

Version 4.87.0009
(Released 29.03.2021)

Below is a list of things that are new and/or changed in version 4.87.0009 compared with version 
4.87.0006 of RheoWin.

Installation

Language file
• Text entries for the new Bitumen evaluation elements were missing. This has been solved.

Example Jobs and templates
• The following new examples Jobs and template files are now part of the installation:

- 76 new Jobs according to several ASTM, AASHTO, DIN and FGSV standards.
- 13 new report templates files used by the above mentioned Jobs.
- 24 new graph and report template files used by the above mentioned Jobs.
- Several new “Media” files (images and videos) used by the above mentioned Jobs.
The Job files are stored in the RheoWin Jobs > # Examples > 06. Measurements according 
to standards > Asphalt Binder and Bitumen Tests directory which is directly accessible 
from the RheoWin Element/Job/Template explorer in RheoWin JobManager.
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General

Audit Trail
• When the HAAKE RheoWin software can not access the HAAKE RheoWin Audit Trail database 

file, for whatever reason, any information that is to be stored in the audit trail database file is stored 
in a temporary text file instead and a warning message Error write AuditTrail! Please 
call you administrator is displayed. At this point the operator should close RheoWin and 
restore the connection between HAAKE RheoWin and the HAAKE RheoWin Audit Trail data 
base file before using HAAKE RheoWin again. 
When the connection is restored and HAAKE RheoWin is started again, RheoWin will 
automatically transfer all audit trail entries that were stored in the temporary file to the audit trail 
database file and delete the temporary file.
During this transfer process certain audit trail entries were not transferred correctly, resulting in 
erroneous (incomprehensible) entries in the audit trail database. This has been solved.

Rheometer drivers

MARS iQ (Air)
• When two (or more) rheometers were connected to and controlled by one instance of RheoWin at 

the same time, starting a RheoWin Job from the touchscreen of one rheometer would 
instantaneously stop any already running RheoWin Job controlling any other rheometer. This has 
been solved.

• When the JobList Editor was opened when a Job was running (on any rheometer connected to 
RheoWin) the Job was stopped instantaneously. This has been solved.

• The text displayed in several menus, on the MARS iQ (Air) touchscreen, when a RheoWin Job is 
running, has been improved and is now more informative.

• By tapping the Continue button on the MARS iQ (Air) touschscreen it was possible to bypass 
entering sample information in a mandatory field of the identification dialog. This has been 
solved.

JobManager 

JobEditor
• When two (or more) rheometers were connected to and controlled by one instance of RheoWin at 

the same time, the Job Controller windows (in which the graph and table are displayed) of all Jobs 
were automatically placed at exactly the same position on the screen, and thus exactly on top of 
each other, making all windows but the last opened window invisible. In order to prevent this, the 
position of the Job Controller window can now be selected from the new Windows position list on 
the General page of the Display dialog. The Display dialog is opened by clicking on the Display 
button in the JobEditor.

• When two (or more) rheometers were connected to and controlled by one instance of RheoWin at 
the same time, all message and dialog windows of all Jobs, opened while the Job is running, were 
displayed with exactly the same window title bar text, making it impossible to know which 
window belongs to which Job (or rheometer). By activating the new Show rheometer in title 
option on the General page of the Display dialog, the rheometer name will be displayed in the title 
bar of all windows, thus making the windows distinguishable.

Note  These message and dialog windows are still automatically placed on top of each other, 
making some of the windows invisible at first.
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ROT Multi-Step element
• The Multi-Step element now calculates and stores the quantity J(t), that is the compliance, as part 

of the measurement data.

OSC Temperature Step element
• Under certain circumstances the data acquisition started before a stationary temperature value was 

reached. This has been solved.

JobManager and DataManager

Thixotropy evaluation element
• Under certain circumstances the Thixotropy element would crash. This has been solved.

SHRP evaluation element
• In the element editor the texts that are displayed as part of the elements evaluation results can now 

be edited.
• In the SHRP evaluation results the characters “-m” behind sin() are not displayed anymore.

Report templates

New variables
• There are four new variables which can be used in any report template:

The variable SensorDiameter which is replaced in the report by the language dependent word 
“Diameter”.
The variable VariableSensorDiameter which is replaced in the report by the numeric value of 
the diameter of the measuring geometry. The diameter value is always displayed in mm.
The variable SetTemp which is replaced in the report by the language dependent words “Set 
temperature”.
The variable SetTemp_Idx which is replaced in the report by the numeric value of the set 
temperature in the measuring element with ID x. The element ID number x can have a value 
between 2 and 50. The temperature value is displayed using the currently selected physical unit 
(that is °C or °f or K).

Version 4.87.0015
(Released 20.09.2021)

Below is a list of things that are new and/or changed in version 4.87.0015 compared with version 
4.87.0010 of RheoWin.

Rheometer drivers

MARS iQ (Air)
• The handling of torque overload and angular velocity overload messages from the instrument has 

been modified.

JobManager 

Save Element
• Under certain circumstances “strange” characters were displayed in the edit field of the (Windows) 

File save dialog. This has been solved.
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Message element - MARS iQ (Air) only
• Under certain circumstances the command triggered by tapping the Continue button on the 

MARS iQ (Air) touchscreen was not properly handled by the Message element. This has been 
solved.

OSC Frequency Sweep element
• When a torque overload message is received from the instrument, the job will now stop the 

element and continue with the next element in the Job.
• Under certain circumstances two data points at 0.1 Hz were measured and saved, instead of one. 

This has been solved.

OSC Amplitude Sweep element
• When a torque overload message is received from the instrument, the job will now stop the 

element and continue with the next element in the Job.

OSC Temperature Step element - MARS iQ (Air) only
• The data acquisition (number of waiting periods and number repetitions for each data point) was 

not correctly executed for every data point. This has been solved.

OSC Temperature Ramp element
• The set value for the ramp end temperature was not saved when switching between the various 

pages in the element editor. This has been solved.

JobManager and DataManager

Creep analysis element
• The result of the calculation of the slope d(log(γ))/d(log(t) was incorrectly reported as 

d(log(γ))/d(log(t). This has been solved.

Version 4.87.0018
(Released 18.10.2021)

Below is a list of things that are new and/or changed in version 4.87.0018 compared with version 
4.87.0015 of RheoWin.

Installation

Example Jobs and templates
• Certain Asphalt Binder and Bitumen Tests example Jobs have been updated.

Disposable plate geometries
• The D P15/Al + Adapter Px disposable plate geometry has been added to the list of geometries.
• The inertia values of all D Pxx/Al geometries has been slightly adjusted.

JobManager 

JobList for the MARS iQ (Air)
• By activating the JobList for all users option in the JobList editor dialog, all RheoWin users can 

use the same JobList on the MARS iQ (Air) touchscreen.

Snapshot
• Under certain circumstances the Report output of the Snapshot test did not work correctly or 

crashed. This has been solved.

Temperature Calibration tool
• The Temperature Calibration (software) tool has been updated, it is now possible to control the 

rheometer lift from within the tool.
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Version 4.88.0000
(Released 18.01.2022)

Below is a list of things that are new and/or changed in version 4.88.0000 compared with version 
4.87.0018 of RheoWin.

Installation

Example Jobs and templates
• Certain examples job and data files were not compatible with RheoWin versions 4.87.00xx and 

4.88.00xx and have been removed.

Rheometer drivers

MARS iQ Air
• In order to improve the data quality, the number of waiting periods and repetitions for frequencies 

in the range of 0.07 Hz < f < 5 Hz has been changed (increased). In order for this to work 
firmware V1 version 0.1.10.000 or higher is needed.

MARS iQ (Air)
• After switching the instrument off and on again, without restarting RheoWin, starting a Job from 

the MARS iQ (Air) touchscreen did not work. This has been solved.

Device Manager

Handling of Connect Assist Adapter
• When an Adapter, with a certain serial number which is already present in the list of geometries 

but with a different name, is detected, the previous instance of that adapter (with another name) in 
the list is replaced by the new one.

JobManager

MultiWave Element
• Under certain circumstances the MultiWave element did not work properly. This has been solved.

Reference element
• The Reference element has been completely rewritten. The element editor now has the same 

layout as all other evaluation elements including a QC page.
• The Reference element can placed in a job before and/or after measurement elements. When it is 

placed before the measurement elements, the element can only display the tolerance band. When it 
is placed after a measurement element it can also determine how many data points are within the 
tolerance band.

• The (upper and lower) tolerance band curves and the reference file curve can be selected to be 
displayed separately.

• The (upper and lower) tolerance band curves can now also be defined by loading two reference 
files, one for the upper band and one for the lower band.

• By activating the Check if data within band option the element will determine how many of the 
measured data points are (not) within the tolerance band (and the defined x-range).

• The numbers resulting from the Check if data within band option can be used as a QC criteria.
• The two new example job files

Evaluation-only (13, Reference, 1 ref.file+ref.band).rwj

and
Evaluation-only (14, Reference, 2 ref.files).rwj

illustrate the new functionality.
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DataManager

Reference evaluation
• The Reference element is now also available as an analysis function in DataManager.

Temperature offset calibration tool

Exported temperature offset table
• A temperature offset table (that is a .tot file) exported by the Temperature offset calibration tool 

could not be imported by the DeviceManager. This has been solved.

Version 4.88.0001
(Released 16.02.2022)

Below is a list of things that are new and/or changed in version 4.88.0001 compared with version 
4.88.0000 of RheoWin.

Installation

Template update process
• The template/example update process at the end of the installation has been modified. As a result a 

Windows system message window is now displayed.
When being asked, select to copy/overwrite all existing example files.

Measuring geometries
• The C25 1°/Ti cone/plate geometry has been added to the list of geometries.

JobManager

Monitor/Manual control
• The privilege setting for the Monitor/Manual control window (in the UserManagementSystem) 

was ignored. This has been solved.

Oscillation Elements
• Under certain (very rare) circumstances all oscillation elements produced a Domain error 

message. This has been solved.
• Under certain circumstances activating/deactivating the Take from previous options did not work 

correctly. This has been solved.

Version 4.88.0002
(Released 19.07.2022)

Below is a list of things that are new and/or changed in version 4.88.0002 compared with version 
4.88.0001 of RheoWin.

DeviceManager / Device Drivers

VT iQ (Air) Temperature controller
• The values entered in the temperature offset table are now checked more stringently. Temperatures 

values must be in the range of -100 °C to 400 °C, offset values must be in the range of -15 °C to 
15 °C.

Measuring geometries
• The BC68 5°/Ti BiCone rotor with ConnectAssist coupling for interfacial rheology was not 

correctly handled by RheoWin. That has been solved.
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JobManager

Set Element
• Under certain circumstances using the Nano offset determination option for the MARS 1, 

MARS 3, MARS 40 and MARS 60 resulted in wrong data in subsequent measurement elements. 
This has been solved.

Version 4.9x.00xx

Version 4.91.0000
(Released 25.01.2023)

Below is a list of things that are new and/or changed in version 4.91.0000 compared with version 
4.88.0002 of RheoWin.

Installation

Language file
• For the English language the texts “Substance” and “Substance name” or “Name” (for the sample 

identification) have been replaced by “Sample” and “Sample name” respectively. This is visible in 
the Identification / Notes dialog, the Identification / Notes element editor, the Automatic filename 
dialog, the Preferences dialog, etc. This change has no impact on a generated automatic file name.

Example Job files
• There are now six directories with pre-defined (measurement) Jobs for each of the current 

rheometer models (MARS 40, MARS 60, MARS iQ, MARS iQ Air, VT iQ, VT iQ Air).
Each directory contains multiple sub-directories with Jobs which are optimized for a specific 
rheometer model and are ready to be used.

• The example data evaluation Jobs are now found in the sub-directory 08. Data evaluation.
• There is new sub-group (sub-directory) 09. Data export with six new example Jobs which show 

how the ASCII for LIMS export functionality in the Export element can be used.

Quantities and Units
• The following new (sub)quanties have been added: log(aT) for WLF TTS curve-fitting, γ-eff and 
-eff (for DIN 51810 Part 4), γ-CM and -CM and -CM for the Cox-Merz transformation, -n 
for tack measurements.

• A new quantity group TTS shift has been added.
• The units gf, kgf, dyne and kN have been added to the Force quantity.

Drivers 

All MARS and Viscostester iQ
• The IP address scanning function has been improved. The scanning function now displays 

intermediate status messages and the response time of the scanning function is shorter.

MARS iQ and Viscostester iQ
• The firmware updater functionality has been improved and was adapted to the larger firmware file 

sizes.

Note  Version 4.91.0000 is the first officially released 4.9x.00xx version.
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Temperature Control simulator
• A new driver Simulator T (the driver filename is MeasSimT.dll) is now part of every RheoWin 

installation. This driver simulates a temperature control device. Basically the only thing it does is 
returning the set temperature value as the measured temperature. The noise level of the “measured” 
temperature signal can be modified using an entry in the drivers.ini file.

UserManager

Multiple logons
• Starting and logging-on into JobManager or DataManager using the Logon dialog while 

JobManager and/or DataManager was already running could cause problems with the Audit-Trail 
regarding the recording of the logged in user. This has been solved.

JobManager 

Identification / Notes dialog
• In the Identification / Notes dialog (in the JobEditor) the operator now has the option to define 

the Sample name and Sample no edit fields as Select from list only fields. When this option is 
activated the operator can not enter a new text in the edit field, but only select an existing text from 
the list.

• The following dialog texts can now be edited by the operator; Sample, Sample name, Sample no, 
Description, Company, Operator and Comment. These texts can be modified in the User defined 
language text dialog which is accessed by clicking on the dialog text itself.

Identification element
• The options in the element editor are now displayed in the same order as the pages in the 

Identification/ Notes dialog.

Lift element
• A waiting time can now be defined for the Trim position.
• In the Zero point area of the element editor there is a new option Reset normal force which can be 

used to reset the normal force signal to 0.0 N. This option can be activated when either the Move 
lift apart or the Go to standby position at option is activated.

Set element
• The different pages of the element editor have been cleaned-up.
• The CR/CD-Mode page of the element editor has been split-up into two pages, the CR mode 

page and CD mode page, with separate control loop settings for each mode. The settings on the 
two pages can not be activated at the same time, this because only one parameter-set can be sent to 
and used by the rheometer control loop at the same time.

Export element
• A separate path (directory) can now be selected for the exported file.

Note  Modifying a certain text in a certain dialog will also change that text in any other dialog 
that uses exactly the same text.

Note  The (language dependent) modified texts are stored in the file User.lng in the directory 
C:\ProgramData\Thermo\RheoWin\Language.
The contents of the file LanguageKey.ini, in the C:\Program Files 
(x86)\Thermo\RheoWin directory, defines which RheoWin dialog texts can be modified.

IMPORTANT  The CR mode settings should not be used before any oscillation element and the 
CD mode settings should not be used before any rotation element in the job sequence.
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• For export to Excel the Excel format can now be selected by selecting the corresponding file 
extension (.xls or .xlsx). The extension .xls corresponds with the format of Excel 2003 and older. 
The extension .xlsx corresponds with the format of Excel 2007 and newer.

• For any export to ASCII, the file extension .xml can now be selected, this is mainly for use with the 
ASCII for LIMS export functionality.

• The file extensions .csv, .asc, .sqm and .xml are now also available in the file select dialogs on the 
File name page of the element editor.

• In the ASCII for LIMS edit field any line starting with C_FTO will only be exported (written) when 
the export file is written for the fist time.
The example Job files in the sub-group (sub- directory) 09. Data export show how this feature 
can be used.

• The new example Job files Export results (1, ..).rwj, Export results (2, ..).rwj 
and Export results (3, ..).rwj demonstrate how to export an Excel compatible .csv file, 
which can be opened with Excel directly.
This format can be used for exporting the results of multiple Job runs (of the same Job) into one 
result file.

• The new example Job file Export results (4, Excel XML file with Append).rwj 
demonstrates how to export an Excel compatible .xml file, which can be opened with Excel 
directly.
This format offers more editing possibilities as a simple .csv file. Note that the contents of the file 
must strictly follow the Excel XML format.
See here https://en.wikipedia.org/wiki/Microsoft_Office_XML_formats for more information.
This format can also be used for exporting the results of multiple Job runs (of the same Job) into 
one result file. RheoWin will automatically maintain the correct Excel XML file format when 
appending Excel XML text.

• There are no empty lines at the end of the export file anymore.
• The Rheometer serial number is now available as a parameter name in the ASCII for LIMS edit 

field.
• The definition of the Job elements as displayed in the Job-Editor is now available as a parameter 

name in two different versions in the ASCII for LIMS edit field. There is a parameter for the 
definition of all elements in the Job and a parameter for the definition of the measurement 
elements only.

Message Element
• On the Screen message page of the element editor there is a new option Insert message text in 

report text. When this option is activated the message text is copied into the selected MessageLinex 
(with 1 ≤ x ≤ 5) report template variable. The MessageLinex variables can be used in any report 
template.
This new option enables the operator to individually compose the result text of any evaluation 
element in a report by using R_IDx_Pyy_z result parameters in the message text.

Export Element and Message Element
• In the text exported/displayed by these two elements the parameter name CU_Qxxx is replaced by 

the current unit of the selected quantity.
• In the text exported/displayed by these two elements the parameter name QN_Qxxx_y is replaced 

by the name of the selected (sub)quantity.
• In the text exported/displayed by these two elements the parameter name QS_Qxxx_y is replaced 

by the symbol of the selected (sub)quantity.

IMPORTANT  This selection does not change the file format in any way, it only changes the file 
extension.

https://en.wikipedia.org/wiki/Microsoft_Office_XML_formats
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• In the above mentioned parameter names CU_Qxxx_y, QN_Qxxx_y and QS_Qxxx_y, CU stands 
for Current Unit, QN for quantity name, QS for quantity symbol, Q für Quantity, xxx is the 
RheoWin internal number of a quantity, and y the RheoWin internal number of the sub-quantity.

The RheoWin internal quantity and sub-quantity numbers can be found in the Configuration > 
Quantities/Units > Edit > General > Quantity # edit field for any quantity and the 
Configuration > Quantities/Units > Edit > Subquantity > Edit > Subquantity # edit field for 
any sub-quantity (of a quantity).

OSC Frequency Sweep element
• In the Shear stress/Strain/Shear rate area on the Oscillation page of the element editor a 

R_IDx_Pyy_z result parameter name can now be entered in the edit fields for the Shear 
stress/Strain/Shear rate amplitude value.

• On the Temperature page of the element editor a R_IDx_Pyy_z result parameter name can now be 
entered in the edit field for the temperature value.

All OSC elements
• All OSC elements now calculate two new quantities γ-eff and -eff for each data point. 

γ-eff = 0.71 γ  and -eff = 0.71 are the effective (or root mean square) values of the amplitudes of 
γ  and as defined in DIN 51810 Part4.
In DIN 51810 Part 4 these values are used to evaluate the results of an OSC amplitude sweep 
measurement.

• In all OSC elements the shear-rate amplitude, defined as γ = γ is now calculated for each data 
point.

All Evaluation Elements with QC functionality
• Under certain circumstances evaluation elements could crash when not using the default English 

user interface language. This has been solved.

Curve Discussion, Interpolation and SHRP evaluation elements
• In the Segment area on the Select data page of the element editors there is a new option Last 

segment only. When this option is activated, only the data measured by the last measurement 
element (that is the last data segment) is used for the evaluation routine.

Math element
• There are now 4 instead of 2 equations in the Math element, that is two equations with two 

operands and two equations with four operands.
• A unary operator can now be applied to each of the operands. The following unary operators can 

be selected from drop-down lists: (none,) sqr, cube, sqrt, invers, 10^, e^, log, ln, abs, sin, cos, tan, 
arcsin, arccos, arctan, ↓decade, ↑decade, round.
(The two decade functions respectively return the lower and upper full decade relative to the 
operand value. Two examples: ↓decade(83) = 10, ↑decade(26) = 100.)

• For any binary operator the user can now select no operator. By selecting no operator for a binary 
operator, parts of the equation can be “disabled” and will then be hidden (not visible).

IMPORTANT  The quantity number must be written using three digits, that means that the 
quantity number 1 must be written as 001, the quantity number 17 must be written as 017, 
etc.. The subquantity numbers must not be written using leading 0’s.

Note  When during Job runtime the R_IDx_Pyy_z result parameter contains a value that is not 
within the allowed range for the corresponding set value, the Job is stopped.

Note  The Last segment only option is meant for use in a Goto loop only.
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• The result of one of the first three equations can now be used in one of the following equations by 
entering R1, R2 or R3 for an operand.

JobManager and DataManager

Preferences Dialog
• The Preferences dialog has been cleaned-up. On the General page the position of some items has 

been modified.

Units Dialog
• The Select unit context popup menu of the main Units dialog has been slightly modified.
• The edit dialog for a quantity and the edit dialog for a sub-quantity have been slightly modified 

and now both use the same nomenclature.

Curve-Fit element
• A curve-fit can now also be performed using an y-axis range (instead of a x-axis range).
• There is a now new curve fit model WLF TTS (lin) for fitting the WLF equation 

log(aT) = -c1(T-T0)/(c2-T-T0) to log(aT) =f (T-shift) data. 
The curve fit is performed on linearized data. The parameter T0 is not a real fit parameter and can 
not be influenced by the operator, like the parameters c1 and c2.

Advanced Curve Discussion element
• The tangent method now offers the option to calculate the tangent of a curve at a certain x-axis 

value. Previously the tangent could only be calculated over a certain x-axis range consisting of two 
x-axis values.
The x-axis value can be entered as a numeric value or as a R_IDx_Pyy_z result parameter name.
The two new example Job files
Evaluation-only (15, AdvancedCurveDiscussion with R_IDx_Py).rwj 

and
Evaluation-only (16, AdvancedCurveDiscussion with R_IDx_Py).rwj

illustrate this new functionality.
• The Percentage of reference value method now offers the following four new sub-methods for 

defining the reference value:
y Value at x= , the y-axis value at a certain x-axis value,
y Value, a certain y-axis value,
y Mean value for x < , the mean value of all y-axis values for x < a certain x-axis value,
y Mean value for x > , the mean value of all y-axis values for x > a certain x-axis value.

The x and y values can be entered as a numeric value or as a R_IDx_Pyy_z result parameter name.

LVR element
• In the editor of the LVR element the user can now select to Calculate LVR based on the quantity 

|G*|.
• On the new QC page in the element editor, the user can now define quality control (good/bad) 

criteria for the calculated values.

Area element
• In the editor of the Area element the user can now select whether the Area above the X-axis, the 

Area below the X-axis or the complete Area is to be calculated.

Note  The four equations are always calculated in the same top-down order. That means that 
the result R1 of the first equation can be used in equation 2, 3 and 4, etc., but that, for example 
the result R3 of equation 3 can not be used in equation 2 and that the result of equation 4 can 
not be used in any other equation..
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Reference element
• The reference element can now display a reference curve and a tolerance band based on a constant 

(y-axis) value. In this case the reference curve is a straight line parallel to the x-axis.

DataManager

Main program
• Under certain circumstances DataManager would repsonse very slowly or even crash when they are 

many data files in the default data directories. This has been solved.

Modify/Transform/Add data
• There is new item Modify/Transform/Add data in the File menu, with a sub-menu with four new 

commands. Using these commands data can be modified, transformed or added to the (selected) 
data file in a a page. A note about the modification is saved in the Notes text of the data file.

• The four new commands are:
• Add to OSC data: γ , γ-eff, -eff (DIN 51810-4)

Using this command the shear rate amplitude (γ = γ and two effective values 
(γ-eff = 0.71 γ  and -eff = 0.71 ) according to DIN 51810 Part 4 are calculated and added to 
any OSC data segment. The new data is automatically saved in the selected file.

• Add to OSC data: γ-CM, -CM, -CM (Cox-Merz)
Using this command a shear rate (γ-CM = ), viscosity (-CM = |*|) and shear stress 
(-CM == -CM γ-CM) value according to the Cox-Merz rule are calculated and saved for 
any OSC frequency sweep data segment. The new data is automatically saved in the selected 
file.

• Add to data: -n 
Using this command a normal stress value -n = Fn/A (Fn is normal force, A is the horizontal 
Area of the upper part of the measuring geometry) is calculated and added to any data segment 
which included normal force data. The new data is automatically saved in the selected file.

• Apply/remove parallel plate Single-point correction to ROT data: γ, γ , , N1 
Using this command the Single-point correction (according to Macosko) for ROT data 
measured with a parallel plate geometry can be applied to or removed from any ROT data 
segment. The recalculated data is automatically saved in a new file with _mod added to the 
original file name (and in the same directory). The new file is automatically loaded and added 
to the active page.

TTS evaluation
• The TTS function now automatically calculates and saves the value log(aT) in the result file.

Merge & Mean evaluation
• A completely new Merge & Mean evaluation routine is now available in DataManager. 

This evaluation routine offers two (related) functions:
1) Multiple RheoWin data files can be merged into one new data file.
2) The mean of multiple RheoWin data file can be calculated and stored in one new data file

• Both the merging and the mean value calculation are applied to all available data, that is not just to 
the displayed curve(s), using the quantity displayed on the x-axis as the reference.

• During merging all data points are copied from the selected files into the result file individually. 
Note that for data points that have exactly (!) the same x-axis value only one mean value is added to 
the result file.

• For calculating the mean value of several files the data points in those files do not need to have the 
same x-axis value. For data points within a certain x-axis value demarcation one mean data point is 
calculated, for such a resulting data point both the x-axis and the y-axis is a mean value.
For linear equidistant data points it is recommended to use an Absolute x-value demarcation, for 
logarithmic equidistant data point it is recommended to use a Relative x-value demarcation.
The Absolute / Relative option is set automatically depending on the lin/log scaling of the x-axis.
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• On the Layout/Options page the operator can select whether the resulting data file is displayed 
automatically in the current page, a new page or not displayed.

Reports templates

New variables
• There are five new variables MessageLinex (with 1 ≤ x ≤ 5) which can be used in any report 

template.
The contents of these variables are (optionally) created and saved by the Message element.

Graph / Table display

Graph symbols
• The Data > Layout > Symbol > Style property (filled, emtpy, empty+dot) was not always saved 

and restored properly. This has been solved.

Version 4.91.0011
(Released 20.04.2023)

Below is a list of things that are new and/or changed in version 4.91.0011 compared with version 
4.91.0000 of RheoWin.

Installation

Example Job files
• The example job and data files have been updated and extended.

Quantities and Units
• The following new sub-quantities have been added: f-rel-3+5 and M-rel-3+5.
• The following new quantity has been added: ∑nonlin.

Drivers

Viscostester iQ (Air), MARS iQ (Air)
• The values of two new operation-hour counters are now displayed in the Diagnosis window. One 

counter counts the hours the instrument was powered-on, the other counts the hours during 
which the instrument was running a Job (measurement).
The current operation-hour values are stored in every RheoWin *.rwd data file.

MARS iQ (Air)
• The smallest accepted angle value (for CD-OSC measurements) is now 1 rad.

JobRun

Job launch
• Under certain circumstances launching a Job, using a link to a Job file or by double clicking a Job 

file, did not work correctly. The Jobrun.exe program would crash. This has been solved.

JobManager 

Snapshot
• The Snapshot function could not be used for the MARS iQ (Air). This has been solved.

Note  For the Viscotester iQ (Air) firmware V1 01.07.000 or higher, and for the MARS iQ 
(Air) firmware V1 01.16.000 or higher, is needed for the counters to be available.
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Device Toolbar
• The set temperature value on the device toolbar is now updated (within a certain time interval) 

during a Job run.

Job/Template explorer
• The privileges (as defined in the User Management System) for deleting, renaming, moving, etc. 

Job and Template files were not respected. This has been corrected.

Geometry recognition
• The geometry recognition logic for not correctly recognized geometries has been improved.

JobController and Monitor Window
• The handling of device initialisation errors has been improved.

ROT Steps element (Stationary flow curve)
• Under certain circumstances the display of the temperature and segment time in the JobController 

windows was not correct. This has been solved.

ROT Ramp element
• The maximum shear rate (angular velocity) value was rounded in an unpractical way. This has 

been improved.

ROT Ramp element and Creep element
• In the Shear stress/Shear rate area on the Rotation page of the element editor a R_IDx_Pyy_z 

result parameter name can now be entered in the edit fields for the Shear stress/Shear rate values.
• On the Temperature page of the element editor a R_IDx_Pyy_z result parameter name can now be 

entered in the edit field for the temperature value.

OSC Frequency Sweep element
• The option Non-const. ampl. is now disabled when the Table option is activated for the Frequency 

values.
• The Table option for the Frequency values did not work for the MARS iQ (Air). This has been 

solved.

All OSC elements
• All OSC elements now calculate and save the (sub)quantities -rel-3+5, M-rel-3+5 and ∑nonlin 

which are defined as follows: 
-rel-3+5 = -rel-3 + -rel-5 , 
M-rel-3+5 = M-rel-3 + M-rel-5 , 
∑nonlin = -rel-3+5 + M-rel-3+5 , 
These values quantify the non-linearity of the OSC angle and torque sine-wave signals and can be 
used as a break-criteria during a measurement.

SER Time Test element
• The Density value that can be entered on the Temperature page of the element editor was not 

handled and saved correctly. This has been solved.

Multiwave element
• Under certain circumstances the Multiwave element used the wrong set value for the stress 

amplitude. This has been solved.

Note  When during Job runtime the R_IDx_Pyy_z result parameter contains a value that is not 
within the allowed range for the corresponding set value, the Job is stopped.

Note  These quantities are only available for the MARS 40 and MARS 60 and only after 
RheoWin has communicated at least once with the rheometer.
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Curve Discussion element
• Instead of (useless) numerical values in the Result table on the Data/Method/Result page of the 

element editor, the R_IDx_Pyy_z result parameter names for each of the defined results are now 
displayed.

Advanced Curve Discussion and LVR evaluation elements
• While hovering the mouse pointer over the check-box items in the Numerical/Text area of the 

Layout page, a tool tip will now display the R_IDx_Pyy_z result parameter name for the result 
value.

Math element
• Under certain circumstances the handling of the input and output result values was not correct. 

The values were not read/saved using the correct unit. This has been solved.

JobManager and DataManager

Protocol/Info
• The values of the two new operation-hour counters are displayed in the Job information area (at 

right hand side of the graph/table).

Curve Fit element
• In the Graphical area on the Layout page of the element editor there is a new option Show in 

legend. When this option is deactivated the curve fit line and model name will not be displayed in 
the graph legend.

• Under certain circumstances the Range min and max values were rounded in an unpractical way. 
This has been improved.

Curve Discussion element
• When a Method is selected/deselected (in the Method list), the method is now automatically 

displayed in, respectively removed, from the Result list.

Creep analysis element
• The element editor would crash when changing a Symbol size on the Layout Page. This has been 

solved.

Advanced Curve Discussion element
• The Tangent intercept method now offers the option to calculate the y- or x-value of a point on 

the tangent line for any x-axis resp. y-axis value.
The x-axis and y-axis values can be entered as a numeric value or as a R_IDx_Pyy_z result 
parameter name in the Numerical area on the Layout page of the element editor.

Reference element
• The reference element can now optionally calculate the X- and/or Y-values of the first and the last 

data point which is within the tolerance band. These options can be activated in the 
Numerical/Text area on the Layout page of the element editor.

• Under certain circumstances the display and handling of result values was not correct. The values 
were not displayed using the correct unit. This has been solved.

• Under certain circumstances the Reference curve was not displayed correctly in the graph. This has 
been solved.

SHRP, BYET, MSCR and LAS elements
• These elements could be used even when they were not installed. This has been changed.

DataManager

Structure Recovery element
• Selecting data for this element was not possible. This has been solved.
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Merge & Mean evaluation
• Applying other data analysis routines to the data file saved by the Merge & Mean analysis routine 

was not possible. This has been solved.

Range calculator

Numerical range page
• The length value of the rotor of a concentric cylinder geometry was not displayed correctly.

This has been solved.

Temperature Calibration program

New functionality
• A fixed duration for the temperature steps can now be defined. The time measurement for this 

duration is started when the measured TM-xx-x temperature is within an user definable range 
around the set temperature value.

• The measured data can now be saved in a RheoWin.rwd data file for further analysis.
• At the end of the calibration the graph will now display the data measured for all temperatures.

Version 4.91.0021
(Released 17.08.2023)

Below is a list of things that are new and/or changed in version 4.91.0021 compared with version 
4.91.0011 of RheoWin.

Installation

New option Tribology
• In order to be able to use the new measuring geometries for Tribology and the corresponding 

RheoWin features the new Tribology option (order no. 098-5082) must be installed.
• This option is automatically installed when using the installation key 098-5019 for all instruments 

(this key is for Thermo internal use only).

Example Job files
• The example job and data files have been updated and extended.

Quantities and Units
• The following new sub-quantities have been added: The sliding distance Sd, a quantity used in 

Tribology.
• The following new quantity has been added: The Hershey number He, a dimensionless quantity 

used in Tribology.

DeviceManager / Device drivers

VT iQ and VT iQ Air (redesigned versions)
• Reading temperature Offset tables from the instrument did not work correctly, this has been 

solved.

Measuring Geometries
• RheoWin is now compatible with the 5 new Tribology geometry types:

- TR 13 B3P, ball on 3 plates,
- TR 13 B3D, ball on 3 discs,
- TR 13 B3B, ball on 3 balls,
- TR 12 3BP, 3 balls on plate,
- TR xx RP, ring on plate, xx stands for various different ring diameter.
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• RheoWin ist now compatible with the new Solid Clamps Cylindrical SCU1-7 C-O/SS geometry 
type.

JobManager 

Monitor/Manual control window
• Under certain rare circumstances the Monitor/Manual control window would freeze. This has 

been solved.

JobEditor
• The 5 new Tribology rotor types are based on the new Tribology Connect Assist adapter. This 

adapter and thus the Tribology rotors are handled in the JobEditor like all other ConnectAssist 
adapters.

• When a Tribology rotor is detected the operator can enter a viscosity value which is needed for the 
calculation of the Hershey number.

• When the Solid Clamps Cylindrical rotor SCU1-7 C-O/SS is detected the operator can enter the 
diameter value of the sample.

Tribology in measurement elements
• The calculation of tribological relevant measurement data is currently implemented in the 

following ROT measurement elements:
- Rotation Time curve
- Rotation Ramp
- Rotation Stepped-Ramp
- Rotation Temperature Ramp
- Rotation Temperature Stepped-Ramp

• When a Tribology type geometry is selected, the editors of these element automatically switch into 
"tribology mode". In "Tribology mode" the set values are the circumfential velocity vR (in 
CR-mode) and the friction force Ff (in CS-mode) instead of γ  (in CR-Mode) and (in CS-Mode).

Set element
• For the MARS 40 and MARS 60 the CR mode control settings and the CD mode control settings 

are now send to the instrument separately as two sets of parameters and can thus both be used in 
one Job.

ROT Time, OSC Time, OSC Temperature Ramp, OSC Temperature Steps elements
• In the editors of these elements the Extern page containing the Trigger functionality is now also 

available for the MARS iQ and MARS iQ Air.

OSC Frequency Sweep element
• In the VT iQ (Air) the OSC Frequency sweep with a linear frequency distribution did not work. 

This has been solved.

OSC elements
• For the MARS iQ and MARS iQ Air the start of the OSC elements was optimized.

MultiWave element
• Under certain circumstances the Multiwave element did not work correctly, this has been solved.

Curve fit element
• The min and max values for the x range, in the Range area of the Select data page, can now be 

entered as R_IDx_Pyy_z result parameter names.
• While hovering the mouse pointer over the Name and Value list items in the Parameter area of the 

Layout page, a tool tip will now display the R_IDx_Pyy_z result parameter name for the result 
value.

Note  Firmware version P2 (Box DSP) 50.24.000 or higher, is needed for this to work.
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• The the X at Y=0 value and the three Y at X= values are now also available as R_IDx_Pyy_z result 
parameter.

• While hovering the mouse pointer over the X at Y=0 and the three Y at X= items in the Numerical 
area of the Layout page, a tool tip will now display the R_IDx_Pyy_z result parameter name for 
those result values.

Interpolation element
• The min and max values for the x range, in the Range area of the Select data page of the element 

editor, can now be entered as R_IDx_Pyy_z result parameter names.
• The values in the first column of the Quantities + Result table on the Data/Method/Result page 

can now be entered as R_IDx_Pyy_z result parameter names.
• Instead of (useless) numerical values in the Quantities + Result table on the Data/Method/Result 

page of the element editor, the R_IDx_Pyy_z result parameter names for each of the defined 
results are now displayed.

Curve Discussion element
• The R_IDx_Py_z parameter names for the Mean value calculation were not correct and have been 

modified. Under circumstances it may be necessary to adapt existing Jobs accordingly.

Advanced Curve Discussion element
• For the Tangent intercept method the Range min and max values for the two Tangents can now be 

entered as a numeric value or as a R_IDx_Pyy_z result parameter name.

Crossover element
• While hovering the mouse pointer over the check-box items in the Numerical area and the Specials 

area of the Layout page, a tool tip will now display the R_IDx_Pyy_z result parameter name for 
the result value.

Math element
• While hovering the mouse pointer over the Result name edit fields on the Calculation page of the 

element editor, a tool tip will now display the R_IDx_Pyy_z result parameter name for the result 
value.

• The R_IDx_Py result parameter names of the Math element itself can now also be used in the 
Operand edit fields (as far as the internal element logic allows).

DataManager

Modify/Transform/Add data
• There is new function Add to ROTdata: Hershey number (Triboloy)

Using this command the Hershey number He can be calculated for existing Tribology 
measurement data. The operator is asked for the viscosity value which is needed for the 
calculation. The new data is automatically saved in the selected file.

Mean&Merge evaluation
• The button for loading a graph template on the Layout/Options page was not functional. 

This has been solved.

Spectra calculation
• The settings used for the Spectra calculation are now displayed in the Protocoll/Info window.

MWD calculation
• The displayed result values of Me and Mc were wrong by a factor of 1000. This has been corrected.
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Reports templates

MessageLine variables
• The MessageLinex (with 1 ≤ x ≤ 5) variables for report templates did not work in an 

evaluation-only Job where data is loaded into the Job by the File load element. 
This has been solved.

Temperature Calibration program

New version
• Some bugs were fix in the new version 2.1.0.22 which is part of this RheoWin version.

Version 4.92.0007
(Released 27.11.2023)

Below is a list of things that are new and/or changed in version 4.92.0007 compared with version 
4.91.0021 of RheoWin.

General

Compatible Windows Versions
• Starting from this version (4.92.0007) RheoWin is not compatible with Windows 7 anymore.

Incompatible Job, Data and Page files
• When trying to open a file that is not compatible with the RheoWin version being used, because 

that file was last saved using a newer RheoWin version, an error message explaining the situation 
will now be displayed.

• The RheoWin license text has been updated/modified by the Thermo legal department.

DeviceManager / Device Drivers

MARS 40/ MARS 60
• On the Options page of the Properties of MARS 60 (and 40) dialog there is a new option 

G’ limiter, when this option is active the plausibility of the measured G’ values is checked, and 
corrected if considered useful. This option and the resulting corrections apply to measurement at 
the limits of the measurement range only.

MARS iQ / MARS iQ Air
• Under certain (rare) circumstances the rheometer drive motor would continue to rotate at the end 

of a Job. This has been solved.
• The torque mapping routine for the drive motor can now also be started from the DeviceManager 

by clicking the TMC button at the right side of the list of devices.
• The selected Camera was not always correctly detected. This has been solved.

Geometries
• When trying to delete a geometry from the list of geometries while that geometry is in use (for 

example in a Job) a message will now be displayed that deleting is not possible.

Camera (for RheoScope, TM-CR-O etc.)
• The magnification can now also be set to 1x (for setups where the camera is not used with the 

RheoScope module).
• The list of selectable image resolutions of the 3iCube camera was not correct/complete. 

This has been solved.

Note  MARS 40/60 Firmware P1 50.26.008, P2 50.24.006 and P3 65.00.041 or newer is 
needed for the above option points to be available.
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• The automatic exposure time setting has been improved.
• Individual video images were not correctly saved when the jpeg, tiff or png file format was selected. 

This has been solved.

JobManager 

JobEditor
• Using the degree symbol ° in a ConnectAssist adapter name and saving the name in the 

ConnectAssist adapter tag resulted in strange characters in the adapter name. This has been solved.

Camera control window
• The Camera model name is now displayed in this window.
• The Video format image resolution can now be selected in this window.
• The selected Magnification and Image type are now displayed in this window.
• The Contrast, Brightness and Gamma values can now also be modified by entering numerical 

values.

OSC-Time element
• Data acquisition did not work correctly when images from a camera where acquired also. 

This has been solved.

OSC-Time and OSC-Temperature Ramp elements
• In the editors of these elements the operator can now define a torque value below which the CD 

control loop will switch to CS-mode using the defined torque value.

Interpolation element
• Under certain circumstances the interpolation results were not correctly displayed in the 

protocoll/information area (aside from the graph) and in a report. This has been solved.

CurveDiscussion element
• The option to modify the number of significant digits for result values did not work in the 

previous version. This has been solved.

DataManager

Mean&Merge evaluation
• Under certain (rare) circumstances selecting a directory for the result file did not work. 

This has been solved.

Version 4.93.0003
(Released 22.04.2024)

Below is a list of things that are new and/or changed in version 4.93.0003 compared with version 
4.92.0007 of RheoWin.

General

Compatible Windows Versions
• Starting from version 4.92.0007 RheoWin is not compatible with Windows 7 and Windows 8(.1) 

anymore.

Quantities and Units
• Units that contain a multiplication of other units are now displayed correctly using a dot as the 

multiplication sign. 
Example: The unit for the quantity viscosity is now displayed as Pa·s and not as Pas or Pa s.
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Installation

Entering the installation key
• Entering the installation key using the numeric keypad of the keyboard was troublesome. This has 

been improved.

Displaying the what’s new file
• The RheoWin_New.pdf file is now optionally displayed at the end of the installation (instead of 

the same file in Word format).

Installation of examples files
• The operator is not asked anymore whether existing example files should be overwritten.
• The example library contains a few new job and data files, several existing job have been 

improved/corrected.

DeviceManager / Device Drivers

VT iQ (Air) redesign
• For a quicker identification, the name of the redesigned VT iQ (Air) version is now displayed as 

HAAKE Viscotester iQ-R respectively HAAKE Viscotester iQ Air-R in the Info/Protocol window, 
where the R stands for redesigned.

MARS iQ (Air)
• The Inertia determination routine now also works for the MARS iQ (Air).
• The TMC determination routine can now be started from the DeviceManager.

MARS 40/60 and MARS iQ (Air)
• When starting the MSC or TMC or Inertia determination routine RheoWin now automatically 

checks which rotor is attached to the rheometer and saves the measured value(s) for the correct 
rotor, or for the rheometer itself when no rotor is attached.

VT iQ (Air) and MARS iQ (Air)
• When initializing the communication between RheoWin and a VT iQ (Air) or a MARS iQ (Air) 

the status of the UDP protocol is now checked. When the UDP protocol is blocked by a Firewall a 
message will be displayed. 
Note that the UDP protocol is needed for launching a Job from the MARS iQ (Air) touchscreen, 
for ConnectAssist messages, and for firmware updates.

Geometries
• In the names of a few predefined cone rotors the cone angle was written as 1.0°, 2.0°, 4.0° etc., this 

has been changed to 1°, 2°, 4° etc. as with all other cone rotors.
• Three new geometries, two ball rotors and one disc rotor, according to ISO 2884 have been added 

to the list of rotors. These new rotors are B19 ISO2884/SS, B32 ISO2884/SS and D58 
ISO2884/SS. The geometry factors of these rotors are calibrated such that they give the same 
viscosity result as when used in a Rotothinner viscometer.

Diagnosis window
• The name of the TM-PE-P was incorrectly displayed as TM-EL-P when it was used in 

combination with a TM-EL-H.
• When the TM-EL-H was installed without a lower TM-xx-x module the text box for the lower 

module was not empty. This has been solved.
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JobManager 

Main toolbar
• Since RheoWin 4.91.0000 certain toolbar buttons for file functions (Open, Save, etc.) were not 

disabled (not greyed out) when the corresponding privileges in the UserManager were disabled. 
This has been solved.

Device toolbar
• The display (positioning, greyed out version) of certain buttons in the device toolbar was not 

correct. This has been solved.

RheoWizard
• Sarting from RheoWin version 4.91.0021 the RheoWizard did not work anymore. This has been 

solved.

JobEditor
• The default setting (for a new Job) of the Display > General > Graph > Mode option is now set to 

Auto (instead of Default). This ensures that the (internal) Graph settings defined in a measuring 
element are automatically used.

• When starting a Job for which the selected Rheometer was not setup correctly (for example a 
wrong IP address) an error message about a problem with the Temperature controller (instead of 
the Rheometer) was displayed. This has been changed.

• Under certain circumstances, when editing a Job for a MARS 40/60, a ConnectAssist message 
with no geometry name popped-up for no good reason. This has been solved.

Monitor/Manual control window
• On slower computers when using a MARS iQ (Air) the Monitor window would freeze after being 

opened. This has been solved.

Lift element
• The option When gap <= now also applies to the Use Autotension option.

Goto element
• The Goto element would crash when the start or end value of the set value, that was selected to be 

changed during a Job run, was zero. This has been solved. Now an error message is displayed and 
the Job is canceled.

• Under certain circumstances a Job which uses a Goto element with a high number of repetitions (> 
60) would crash. This has been solved.

OSC time element
• When the Take from previous option was selected for the Stress/Strain value it was still possible to 

manually enter a value. This has been solved.

OSC frequency sweep element
• When selecting Mode > CD and Distribution > Table but leaving the frequency table empty 

RheoWin would crash. This has been solved.

OSC amplitude sweep element
• For a MARS iQ (Air) using the options Mode > CD and Distribution > Table at the same time 

did not work. This has been solved.

Multiwave element
• This element did not work correctly when it was not the first measuring element in a Job. 

This has been solved.

SER element
• This element can now capture and save images from a camera. This meanly meant for use with 

TM-CR-O450 oven.
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Advanced Curve Discussion element
• Under certain circumstances the calculated value for the Inflection point was slightly wrong. 

Instead of the correct value, the value of the previous or next data point was returned. This has 
been solved.

LVR element
• The option Calculate LVR based on was moved to the Settings box.
• The option Manual limiting values in the Calculation mode box now work as intended. It 

possible to enter a start or end limiting value only.

Math element
• There is now a 5th equation which allows to calculate the Min (minimum), Max (maximum), Sum 

(sum), Mean (mean), SD2 (variance), SD (standard deviation), RSD (relative standard deviation) 
and the %RSD (percentual relative standard deviation) of up to 10 values which must be entered 
in one edit field as R_IDx_Py_z parameters separated by one or more spaces.
See the example file Evaluation-only (18, Math, Statistics).rwj.

DataManager

Data select dialog
• In a data select dialog the ID of the measurement element with which a data segment was 

measured is now displayed in front of the element name. The data segment is now listed as ID2: 
Rot Time, instead of just Rot Time.

Modify/Transform/Add data
• There is a new function Add to data: m (= Fn/9.81)

Using this command a mass value m = Fn/9.81 is calculated and added to any data segment which 
includes normal force data. The new data is automatically saved in the selected file.

• There is a new function Add to Axial data: -n, d-sample (Squeeze)
Using this command a (theoretical) sample diameter is calculated from the initial sample diameter 
(entered by the operator) as a function of the (measured) sample height and by assuming that the 
sample is incompressible.
From the (theoretical) sample diameter and the measured normal force Fn a normal stress value 
-n = Fn/(0.24  d-sample2) is calculated.
Both -n and d-sample values are added to any data segment which includes normal force data.
The operator is asked for the initial sample diameter value which is needed for the calculation. 
The new data is automatically saved in the selected file.

• There is a new function Normalize data
Using this command the value of any (selected) measured quantity Q can be normalized using four 
(six) different methods:
- The data is normalized to the minimum, maximum or mean value of all the data of the quantity.
- The data is normalized to a value entered by the operator in a dialog.
- The data is normalized to the value at a certain value of another quantity.
The other quantity and its value can be selected resp. edited by the operator in a dialog.

- The data is normalized to the mean value in a certain range of another quantity.
The other quantity and its range can be selected resp. edited by the operator in a dialog.

The new data is automatically saved in the selected file using a selectable new subquantity 
Normalized-x (where x is 1...5). 
The names of the five Normalized-x subquantities can be edited in the Quantity/Units dialog.
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• There is a new function Modify data
Using this command the value of any (selected) measured quantity Q can be modified using the 
equation Q_new = Q · a + b. The modified data is automatically saved in a new file with _mod 
added to the original file name (and in the same directory). The new file is automatically loaded 
and added to the active page.
The quantity Q can be selected, and the values of a and b can be edited in a dialog by the operator.

Temperature offset calibration tool

Several improvements
• There is a new option Fixed waiting time. When this option is active each calibration point is 

measured x minutes after the difference between the set temperature and the measured 
temperature is less then y °C. The values for x and y can be edited by the operator.

• The data measured during the calibration is now automatically saved in a RheoWin data file. The 
directory where the data is to be saved can be selected in the Options > Save options dialog.

• Several bugs were fixed.

Version 4.94.0000
(Released 05.12.2024)

Below is a list of things that are new and/or changed in version 4.94.0000 compared with version 
4.93.0003 of RheoWin.

General

Compatible Windows Versions
• Starting from version 4.92.0007 RheoWin is not compatible with Windows 7 and Windows 8(.1) 

anymore.

Quantities and Units
• The units kPa·s and MPa·s for the quantity Viscosity have been added.
• The units mJ and kJ for the quantity Energy have been added.
• The units g/ml, lb/ft³, lb/cu³ and slug/ft³ for the quantity Density have been added.
• The units lb and oz for the quantity Mass have been added.
• The quantity Volume with units m³, ml, cm³, ft³, in³ has been added.
• The new sub-quantity #_Flowcycle has been added.
• The new sub-quantity E-flow (Total flow energy) has been added.

Installation

Installation of examples files
• The example library contains a few new job and data files, several existing job have been 

improved/corrected.

Modifying a RheoWin installation
• In the previous RheoWin version after modifying the installation (for example when adding 

another key) the RheoWin desktop icons were deleted. This has been solved.

DeviceManager / Device Drivers

MARS iQ (Air)
• In the Properties of ‘MARS iQ’ and Properties of ‘MARS iQ Air’ dialog there is a new page 

ProtectAssist. On this page, the following settings for the use of the optional ProtectAssist door can 
be made:
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• Activate ProtectAssist door
When this option is active a ProtectAssist door status icon will be displayed on the instruments 
touchscreen status bar as well as in the RheoWin JobManager device toolbar. 
Activating this option also enables access to the following options.

• Move lift downward
When this option is active, the lift can not be moved downward when the door is open and 
will stop moving downward as soon as the door is opened.

• Move lift upward
When this option is active, the lift can not be moved upward when the door is open and will 
stop moving upward as soon as the door is opened.

• Control drive motor
When this option is active, the drive motor can not be controlled (in ROT or OSC mode) and 
any drive motor control will stop as soon as the door is opened.

• Set temperature range
When this option is active, temperature control outside of the defined temperature range is 
not possible when the door is open and such temperature control will be stopped as soon as 
the door is opened.

• Control external device
When this option is active controlling an external device (through RheoWin) is not possible 
when the door is open and any such control will be stopped as soon as the door is opened.

• RheoWin Job execution
When this option is active it is not possible to start a RheoWin Job when the door is open and 
a running RheoWin Job will be stopped as soon as the door is opened. 
When the Allow open door for sample handling is active the door can be opened (without 
stopping the Job) during the time the RheoWin lift element is displaying a message.

The optional ProtectAssist door is mounted to the MARS iQ instrument frame and, when closed, 
physically prohibits the operator to access the (sample) area below the instrument head and above 
the TM-xx-x module. This can be used to protect the operator from touching the rotating and/or 
vertically moving rotor during a measurement, from touching very hot/cold parts of the 
instrument, from unwanted contact with sample material, from controlling an external device, etc.

MARS 40/60 and MARS iQ (Air) and VT iQ (Air)
• Some minor bugs regarding the usability in the Inertia determination dialog have been fixed.

MARS 40/60
• The values of the operating hour counters are now stored in each data file and reported in the 

Protocol/Info field. The latest firmware is needed for the operating hour counters to be available.
• The TM-PE-P Air module was not correctly reported in the Protocol/Info field. This has been 

solved.

Rheonaut module
• In certain previous RheoWin versions the software controlled radial positioning of the upper part 

of the Rheonaut module did not work correctly. This has been solved.

TM-PE-C48 module
• RheoWin is now compatible with the new TM-PE-C48 (Temperature Module-PEltier-Cylinder 

with 48 mm diameter) when the latest VT iQ (Air) or MARS (40, 60, iQ, iQ Air) firmware is 
installed.

TM-PE-C32 module
• The TM-PE-C has been renamed to TM-PE-C32 (because of the new TM-PE-C48).
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CM-OP-P module
• RheoWin is now compatible with the new CM-OP-P (Combined Module-OPtical-Plate) when 

the latest MARS (40, 60, iQ, iQ Air) firmware is installed.

UserManager 

Password rules
• On the Password page of the HAAKE User Management System dialog there are three new 

additional password character rules: 
At least one lowercase character, 
At least one uppercase character, 
At least one special character.

Enter password edit field
• To make entering a password easier, there is now a new “Eye icon button” behind every password 

edit field. By clicking on that button the actual password text characters are displayed (instead of a 
* for each character).

Switching between RheoWin users (in JobManager and DataManager)
• There is a new Configuration > User management > Switch User command which allow to switch 

(change) from one (RheoWin) user to another (RheoWin) user without needing to close and 
restart RheoWin. Of course all user specific RheoWin settings are immediately applied when 
switching to another user.

JobManager 

Element/Job/Template explorer
• The three areas from which the Job elements can be selected for drag&drop into a JobEditor now 

have a vertical scrollbar when the element icons do not fit in the space available.

JobEditor
• In all previous RheoWin versions a Job which did not contain any Job elements could be executed. 

Under certain circumstances this would cause unwanted behaviour of the rheometer. This has been 
solved, an empty Job can not be started anymore.

• For certain languages (for example French) certain ConnectAssist messages were not displayed 
correctly making them hard to understand. This has been solved.

• For the VT iQ as well as for all current MARS rheometers the correct Temperature controller is 
now automatically selected and displayed in the JobEditor dialog.

Monitor/Manual control window
• When opening the Monitor/Manual control window the geometry name displayed on the MARS 

iQ touchscreen was always changed to “---”. This has been solved.
• Data measured and saved using the manual control window now include all relevant device 

information.
• Data measured and saved using the manual control window now include the graph and table 

settings. These settings are automatically used when loading such data in DataManager.

Lift element
• Very rarely RheoWin would freeze during searching for the lift zero position. This has been solved.

Data export element
• The option Use filename (*.rwd) now also works without explicitly putting a Save element in the 

Job before the Data export element.
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Creep/Recovery element 
• Under certain circumstances the deformation measured during the recovery phase was not correct 

(the deformation signal became negative). This has been solved.
• For the MARS 40/60 the Low Torque option is now available in this element.
• When a Break criteria is fulfilled during the creep phase of the element, the element (job) will now 

continue with the recovery phase (instead of continuing with the next element).
• The d log(J)/d log(t) quantity was not calculated correctly. This has been solved.
• The Reset time option in the Set element did not work correctly for the Creep/Recovery element. 

This has been solved.

MultiStep element
• The Reset time option in the Set element did not work correctly for the MultiStep element. This 

has been solved.

OSC Temperature Steps element
• In certain recent RheoWin versions this element was not executed at run-time. This has been 

solved.

Axial ramp element
• The element editor now checks whether the entered lift speed value, or the lift speed value 

resulting from the ramp duration, is within the allowed range.

Axial time curve element
• This element now also calculates and stores the relative gap change value Δ%h.
• The lowest accepted value for #Data on the Data acquisition page of the element editor is now 1 

(instead of 2 before). When the number of data points is 1, that single data point is acquired at the 
end of the element duration.

LVR element
• In the previous RheoWin version this element the calculated LVR values were not correct. This has 

been solved.

DataManager

Data file with corrupted time stamp
• Data files with a corrupted time stamp are now loaded instead of producing an error message. In 

this case the time stamp is set to 00:00:00.

Graph/Table display

Zooming a graph
• Under certain circumstances the vertical axis of a graph was inverted when the graph was zoomed. 

This has been solved.

Line markers
• The horizontal or vertical lines that are created by certain evaluation routines to mark calculated 

result ignored the line style setting (solid line, dotted line, etc.). This has been solved.

Audit Trail Viewer

Display and Export functionality
• Clicking with the right mouse key on any table column header will open the new Hide/Show 

Columns dialog in which any column can be removed from or added to the AuditTrail as displayed 
in the AuditTrail Viewer main window.

• Using the new File > Export to .CSV file command the AuditTrail as displayed in the AuditTrail 
Viewer main window can be exported to an Excel compatible CSV file.
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• Using the new File > Export to .PDF file command the AuditTrail as displayed in the AuditTrail 
Viewer main window can be exported to a file in PDF format.
After selecting this command the Export To PDF dialog will be opened first to allow the operator 
to make some formatting settings for the PDF file.

Version 4.95.0000
(Released 15.07.2025)

Below is a list of things that are new and/or changed in version 4.95.0000 compared with version 
4.94.0000 of RheoWin.

Installation

Installation of examples Job and Data files
• The example library now contains seven new Jobs for Powder Rheology.

- One Job for powder conditioning (only)
- One Job for powder flow measurement.
- Four Jobs, each with a different normal stress value, for powder shear measurements according

to the ASTM D7891 standard.
- One Job for powder compression measurements.

• Several existing Jobs have been improved/corrected.
• Most of the example data files are now also available as example page files. In contrast to data files, 

pages are displayed with proper axes, scaling, etc. Certain pages also contain additional evaluations.

General

Compatible Windows Versions
• Starting from version 4.92.0007 RheoWin is only compatible with Windows 10 and Windows 11 

(that is not compatible with Windows 7 and Windows 8(.1) anymore).

Quantities and Units
• A new quantity group Powder rheology has been added.

UserManager
• The privileges for JobManager > Element/Job/Template explorer > Change job/template root 

directory and JobManager > Job Editor > Manual control did not work correctly. This has been 
solved.

• The privileges for the Analysis functions in the DataManager > Analysis menu and Analysis 
toolbar did not work correctly. This has been solved.

• With the new privilege JobManager > JobController > Allow overwriting data file it can now be 
prevented that existing .rwd data files are overwritten as part of a Job run.

• In some of the last versions the Last login date information was missing for all Users but the 
Admin. This has been solved.

• The date and time at which a new user was added to the list of users in the UserManager is now 
saved and displayed in the Edit user dialog for each user.

• The login name of the currently logged-in RheoWin user is now automatically saved in every 
RheoWin .rwd data file and displayed in the (job) information area.

Note  Powder rheology measurements are rather complex and require many steps, the example 
Jobs include all necessary steps and can be readily used without the need for editing and 
modifications.
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AuditTrail
• In some of the last versions a user login was not recorded correctly in the AuditTrail. 

This has been solved.
• In some of the last versions changes made in the UserManager were not displayed in the AuditTrail 

when the UserManager was started from the Desktop (instead of from the Configuration menu in 
JobManager or DataManager). This has been solved.

• Changes made in the DeviceManager were not correctly displayed in the AuditTrail (certain items 
were not recorded in the correct column). This has been solved.

• In some of the last versions the AuditTrail rescue functionality did not work anymore. 
This has been solved.

• In some of the last versions setting a Password for the AuditTrail did not have any impact.
This has been solved.

• After entering the password for the AuditTrail database file, in the HAAKE AuditTrail Databse 
Configuration dialog, that password is now automatically set in the database file.

• In the (first) line of the AuditTrail in which the installation of RheoWin is recorded the name and 
company name entered during the installation are now included.

AuditTrail Viewer
• Using the File > Open command the AuditTrail can now open any RheoWin .accdb AuditTrail 

database file when the active AuditTrail is a RheoWin .mdb database file and vice versa.

DeviceManager / Device Drivers

MARS I, II, III and RheoStress 1, 300, 600, 3000, 6000
• The inertia calibration for a rotor did not work anymore (in RheoWin 4.94.0000). This has been 

solved.

Viscotester iQ (Air)
• Under certain circumstances there is a communication problem (with the error message 10035 

WSAEWOULDBLOCK: The socket ...) between RheoWin 4.94.0000 and older VT iQ (Air) 
firmware. This has been solved for both the redesigned VT iQ (Air) and the first VT iQ (Air) 
version.

MARS iQ (Air)
• The MARS iQ Air can now perform measurements in CD-Rotation mode, this can be used for 

strain relaxation measurements.

• The MARS iQ and MARS iQ Air are now compatible with the new Powder Rheology tools.

• Under certain circumstances pressing the Continue button on the MARS iQ touchscreen did not 
work reliably. This has been solved.

MARS 40/60
• Under certain circumstances the automatic temperature calibration tool would not work correctly 

for a MARS 40/60 in combination with a TM-EL-P or Rheoscope module. This has been solved.

Note  New firmware is needed for this to work. All firmware versions must be 01.20.000 or 
higher.

Note  New firmware is needed for the Powder Rheology tools to work. All firmware versions 
must be 01.20.000 or higher.
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Measuring Geometries
• When RheoWin is installed with the new Powder rheology tools option, three new measuring 

geometries (rotors) are available (in the names PD stands for Powder):
- FL27 2B/-PD/SS, a two blade vane for powder conditioning and powder flow measurements,
- P28 PO-PD/SS, a vented (porous) plate for powder shear measurements,
- P28 ST-PD/SS, a serrated plate for powder shear measurements.

RheoScope module
• The radial position and the focus position of the RheoScope camera objective during a 

measurement (Job) are now saved in the resulting .rwd data file.
• Under certain circumstances the value for the scale bar displayed in RheoScope images was wrong. 

This has been solved.
• The scaling of RheoScope images can now be adjusted automatically by placing a Ronchi ruler on 

the RheoScope and clicking a button.
• The magnification of the camera objective can now be selected in the camera dialog.

Image acquisition (with RheoScope and TM-CR-O camera)
• Under certain circumstances the number of images acquired during a measurement did correspond 

to the number of data points. This has been corrected.
• The 1600x1200 image resolution did not work. This has been solved.
• Under certain circumstances the automatic exposure time option did not work correctly. This has 

been solved.
• The image type can now be selected in the camera dialog.

JobManager 

JobEditor
• When a .rwd data file is loaded in a JobEditor dialog (instead of a .rwj Job file) the measuring 

geometry used in the Job with which the data was created was not displayed in the JobEditor. 
This has been modified, the measuring geometry is now displayed/selected in the JobEditor.

Display element and Display button in JobEditor
• The text, font, colour etc. of the title for the graph displayed during Job run can now be defined 

from the Graph layout dialog.

Print element
• In the previous version the Print element would not print a graph anymore although that option 

was selected. This has been solved.
• In the previous version when copying/moving the Print element in a Job, the element would 

‘forget’ its settings. This has been solved.

Asphalt element
• The Asphalt measurement element (in the Special application category) has been removed. The 

functionality provided by this element was and is available in the form of several predefined Jobs 
that are part of the example library.

Change rotor element
• This new element allows for exchanging one rotor for another rotor during a Job run. Currently 

this element is designed for use in a powder shear measurement (Job) only.

Powder mass element
• This new element is used for entering the mass of the powder sample during a Job run and for 

documenting the mass and calculating the CBD (Conditioned Bulk Density CBD) of the powder 
sample in the resulting data file.
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Powder conditioning and powder flow element
• Because both powder conditioning and the different types of powder flow measurement basically 

consist of multiple pairs of axial (down/up) ramps with simultaneous rotational motion of the 
powder vane rotor, this new element can be configured for use as:
- Powder conditioning,
- Powder flow test (single) measurement,
- Powder flow stability measurement,
- Powder flow rate measurement.

Powder shear element
• This new element is used to perform a powder shear measurement according to ASTM D7891.

Powder flow evaluation element
• This new element is used to evaluate data from a powder flow measurement. The element first 

calculates the energy needed to perform the combined axial and rotational motion of the powder 
vane rotor through the sample during the various parts of the measurements. From the energy 
values four material properties SI (Stability Index), SE (Specific Energy), BFE (Basic Flowability 
Energy) and FRI (Flow Rate Index) are calculated.

Powder shear evaluation element
• This new element is used to evaluate data from a powder shear measurement according to ASTM 

D7891. The element first draws two Mohr stress circles through calculated data points in a shear 
stress vs. normal stress graph and then calculates the test results Unconfined Yield Strength, Angle 
of Internal Friction, Effective Angle of Friction, Cohesion and Wall Friction Angle, as well as the 
Major Principle Stress, Pre-Shear point, and Yield Locus.

Curve-Fit element
• The parameter a of the Power law (lin) model was not calculated correctly. This has been solved.

Creep-Recovery element
• Clicking the Next button in the upper right corner of the JobContoller dialog during the Creep 

part of the element will now make RheoWin continue with the Recovery part of the 
Creep-Recovery element. 
When the Next button is clicked during the Recovery part RheoWin will continue with the next 
element in the Job.

• The number of data points acquired using the logarithmic data acquisition distribution was not 
correct. This has been solved.

MultiStep element
• Clicking the Next button in the upper right corner of the JobContoller dialog during any step, 

apart from the last step, will now make RheoWin continue with the next step of the MultiStep 
element.
When the Next button is clicked during the last step RheoWin will continue with the next 
element in the Job.

Structure Recovery element
• Under certain circumstances this element did not work correctly. This has been solved.

Interpolation element
• Under certain circumstance the vertical scrolling in the Quantities + Result list on the 

Data/Method/Result page of the element editor did not work correctly. This has been solved.

Math element
• The Math element produced unexpected results when an Operand edit field after an unused 

binary Operator did not contain a valid R_IDx_Py_z parameter. This has been solved, the 
content of an edit field after an unused binary Operator is now ignored.
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JobManager and DataManager

Inactivity timeout
• In the Configuration > Preferences dialog the Security options page is now always available. 

(Previously this page was only available as part of the 21 CFR part 11 tools). On this page the 
Inactivity timeout can be activated. When this option is activated RheoWin will be locked after a 
certain, user definable, time of inactivity.

DataManager 

Modify/Transform/Add data
• The functions Normalize data and Modify data in the File > Modify/Transform/Add data menu 

did not work for certain sub-quantities (with extended properties) like TxMT01. 
This has been solved.

Thixotropy evaluation
• In the previous version the calculated values in the Result table in the Editor window of the 

Thixotropy evaluation function were not automatically updated anymore. This has been solved.

Powder flow evaluation
• This new evaulation routine can be used to evaluate data from a powder flow measurement. The 

functionality is identical to that of the Powder flow evaluation element, see above.

Powder shear evaluation 
• This new evaulation routine can be used to evaluate data from a powder shear measurement 

according to ASTM D7891. The functionality is identical to that of the Powder shear evaluation 
element, see above.

RWR Viewer

Save sine wave data
• When selecting the File > Save (Stress + strain sinewave data) command a dialog is now opened. 

The options in the dialog enable to operator to omit/include certain lines of data and to select 
different time values for the individual sinewave data points.

Version 4.95.0003
(Released 22.07.2025)

Below is a list of things that are new and/or changed in version 4.95.0003 compared with version 
4.95.0000 of RheoWin.

Installation

Installation of iQUpdate.exe
• In RheoWin 4.95.0000 the iQUpdate.exe program which is needed to update the VT iQ (Air) and 

MARS iQ (Air) firmware was missing. This has been solved.

Measuring geometries
• Certain measuring pressure cell measuring geometries an the adapters PC1 and PC2 were not 

installed correctly. This has been solved.

Note  The option Activate default account and disable login on the Administration page of 
the HAAKE User Management System page must be disabled for this to have effect.



2 What’s new
Version 4.9x.00xx

140 HAAKE RheoWin 4.95.0003 Readme Thermo Scientific

DeviceManager / Device Drivers

Measuring Geometries
• The following pressure cell geometries are now part of the installation CC20-PC/SS, 

CC25-PC/Ti/SE, CC31,9-PC/Ti and CC38 DG-PC/Ha.
• All already available pressure cell geometries are now also listed with their new names which use 

the format CCxx-PC/Ti, CCxx-PC/Ha, CCxx DG-PC/Ha, FLxx yy-PC/Ti etc, where xx stands 
for the rotor diameter and yy for the vane blade height. The letters PC in the new names stands for 
Pressure Cell.

JobManager 

All OSC Elements
• In RheoWin 4.95.0000 in all OSC elements the setting Auto: High quality acq. (f-dependent) 

for the Waiting time, #Repetitions on the Data acquisition page of the element editor, did not 
work correctly with the MARS 40/60 (and older MARS I/II/III). This has been solved.
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